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Interaction Client Web Edition
Interaction Client® Web Edition Help

Important: Customer Interaction Center (CIC) supports several interaction management client applications. This
documentation uses the term "CIC client" to refer to these applications, which include Interaction Connect, Interaction
Desktop, and Interaction Client Web Edition. CIC client also refers to the Interactive Intelligence Oracle Service Cloud
Integration. The full product name appears at the top of each help topic. The full product name may also be used in a
help topic when necessary to distinguish between CIC clients.

For more information about some most frequently used CIC client features, see:

Set Your Status

Answer an Incoming Interaction

Place a call to a number inside or outside your organization
Forward calls to remote telephone numbers

Transfer a call

Transfer a call to your voice mail

Make conference calls

Need Help?

Select Show Help from the Help menu. A separate browser window displays the help topics along with Contents,
Index, Search and other navigation controls.

Using the Search Feature

You can search for specific terms in both the HTML and the Web Help versions of the help. There is a basic search and
an advanced search available from the Search tab.

A basic search is simple: just type whatever single word or phrase you want to search, press [enter] or click the List
Topics button (HTML version only), and a list of topics containing that word or phrase is displayed. When searching
for a phrase, use quotation marks to enclose the phrase. For example, use “directory toolbar” to return only topics
that contain that exact phrase.

Some basic facts
All the words you enter in the search box are used in the query.
The search is always case-insensitive. A search for [dtmf] is the same as a search for [DTMF].
Generally, punctuation is ignored, including @#$%"&()=+[]\ and other special characters.

An advanced search involves wildcard (HTML version only) and Boolean expressions. Wildcard expressions allow you
to search for one or more characters using an asterisk or question mark. Wildcard search examples:

init* initial, initiate, etc.
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Boolean searches involve the use of “OR”, “AND”, and “NOT”. Boolean search examples:

Feedback and Access Support

Options on the Help menu enable you to learn more about Interactive Intelligence’s products, promote and share
ideas about Interactive Intelligence’s software, access technical support, and submit feedback about bugs and
enhancement requests.

To visit the Interactive Intelligence home page, do one of the following:

Go to http://www.inin.com.
From the Help menu, select Interactive Intelligence and then click Home.

To access the Interactive Intelligence technical support website, do one of the following:

Go to https://my.inin.com/products/Pages/default.aspx.
From the Help menu, select Interactive Intelligence and then click Support.

Interactive Community is a free and public service provided by Interactive Intelligence to promote an online
community devoted to the sharing of ideas and information regarding Interactive Intelligence software. To
visit the Interactive Intelligence Interactive Community, do one of the following:

Go to http:// community.inin.com.
From the Help menu, select Interactive Intelligence and then click Community.

Use our new social media/crowdsourcing site to submit ideas for enhancing Interactive Intelligence products.
Vote on which ideas submitted by others best describe the enhancements you want. Do one of the
following:

Go to http://ideas.inin.com.
From the Help menu, select Interactive Intelligence and then click Feedback.

To submit documentation feedback, send an email message to documentation@inin.com.

CIC 2016 R4 revised 04/21/2016

Features

Here are some of the most important features included in Interaction Client Web Edition.
Configuration

Customize Columns
Ease of Use

Auto Reconnect



Access Control Rights

Dial Pad

Status Bar
Information Organization

Call History

Directories

Directory Entries

My Interactions

Speed Dial Views
Interaction Management

Call Parking

Call Transfer

Camping

Conferencing

Fax

Interaction Notes

Queue Control

Voicemail

Voicemail Viewer
Status Management

Status Notes

Access Control Rights

Access Control rights allow or restrict access to certain objects within the CIC client and determine whether you can
view or modify those objects. Your CIC administrator assigns your Access Control rights. Contact your CIC
administrator if you have questions about your Access Control rights.

Account Codes

This Access Control right determines whether you can assign account codes to incoming or outgoing interactions. For
more information, see Understanding Account Codes; Assign Codes to an Interaction; Assign Codes to an Incoming
Interaction; and Assign Codes to an Outgoing Interaction.

Attendant Profiles
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These Access Control rights determine which Interaction Attendant profiles are available as transfer targets in the
Transfer dialog box. This controls whether you can transfer an interaction to a specific Interaction Attendant Profile.
For more information, see Transfer a Call to an Attendant Profile.

Directory Status

This right controls which status columns you can choose to display in a Directory view. For more information, see
View Another User’s Status and Add or Remove View Columns.

General Directories

This right controls which General Directories you can choose to display.

Interaction

These rights control whether you can use specific types of pre-defined responses from a system-wide Response
Management library named "Interactions.” This library exists only in systems upgraded from previous releases where
the administrator decided to retain the library. For more information, see Working with Response Management for
details.

Phone Number



Access Control Rights

These rights control which types of phone numbers you can call, use as follow-me numbers, use as a forwarding
number, or employ in the Telephone User Interface (TUI). Your CIC administrator classifies phone numbers into types
such as Blocked, Emergency, Local, and Long Distance.

Response Management

This right determines which system-wide Response Libraries you can see and use in the CIC client. For more
information, see Working with Response Management.

Station Queues

This right controls whether you can transfer an interaction to a specific Station Queue.

ol
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Stations

Typically, you always log on to one, specific CIC station that belongs to you. However, if there is a need, you can be
assigned the right to log on to other CIC stations.

Status Messages

To use a specific status, you need the appropriate View Status Message right. The CIC administrator can assign this
right to all members of a specific workgroup, all users in a certain role, or selected users. These rights determine the
status settings available when you Set Your Status or Set Another User’s Status.)

User Queues

These rights control which User Queues you can display and work with in the CIC client.

Users

This right controls whether you can Set Another User’s Status.

Workgroup Queues

These rights control which Workgroup Queues you can display and work with in the CIC client.




Security Rights

Workgroups

These rights control which workgroup directory views you can add to the CIC client and which workgroups can appear
in the Workgroup Queue view.

Related Topics

Security Rights

Security Rights

Security rights control your access to certain CIC client features and determine the actions you can perform. Your CIC
administrator assigns your Security rights. Contact your CIC administrator if you have questions about your Security
rights.

Client Rights

These rights determine which actions you can perform in the CIC client.
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Interaction Command Rights

These rights determine which buttons appear on the My Interactions Queue Control Toolbar.




Security Rights

My Interaction Rights

These rights determine the actions you can perform in My Interactions.

Related Topics
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Access Control Rights

What’s New in CIC client 4.0

The following changes and enhancements were introduced in version 4.0:

Account Codes: You can use account codes to organize interactions by customer if they are configured for
use on your system and you have the appropriate user rights. For more information, see Understanding
Account Codes.

Advanced Dialing Options: If your CIC administrator enables Advanced Dialing Options and you are a
member of at least one workgroup or have at least one account code to select, the Advanced Dialing
Options dialog box appears every time you place a call and prompts you to assign the appropriate Account
Code and/or designate a Workgroup. For more information, see Advanced Dialing Options.

Call Transfer: Advanced Transfer capabilities are available in the Transfer Dialog Box. This includes the ability
to search for transfer recipients by name, number, workgroup or other criteria. You can see the status of a
selected CIC client user before you transfer a call. You can also easily park a call, transfer a call to voice mail
or perform a consult transfer from the Transfer dialog box.

Directories: The features and appearance of the Company Directory, Workgroup and Profiles views, and
Workgroup views have been greatly enhanced.

Logged In tooltip: The tooltip for the Logged In column displays the name of the station or IC
server where another user is logged in.

Persisted Settings: All directory setting such as the selected tab, sort order, selected columns,
column widths and order, and filter settings are preserved when you log on again to the same IC
server from the same web browser.

Resize Columns and Scroll Horizontally: Each column in a directory has an independent width.
This enables you to resize one column without affecting the width of adjacent columns. A
horizontal scroll bar appears if the total width of the columns exceeds the space available in the
browser window. For more information, see Customize Columns.

Reorder Columns: You can drag and drop a selected column to change the order in which
columns appear in a directory grid. For more information, see Customize Columns.

Select New Directory Columns: You can add or remove columns from any directory view or queue
view. Also, a full range of new columns are available for your selection: including email addresses,
phone numbers, contact addresses, and status details such as status notes and forwarding number.
For more information, see Add or Remove View Columns.

Single Column and Multi-Column Sorting: You can sort a directory by clicking on the column
heading. You can sort by more than one column by holding down the Shift key while clicking on
selected column headings. For more information, see Sort a Directory.

Wildcards in Directory Searches: Use the asterisk (*) and question mark (?) in directory searches.
For more information, see Search a Directory.

Interaction Properties: Use the new Interaction Properties Dialog Box to add notes to an interaction or view
the interaction log.

10



What's New in CIC client 4.0 Service Updates

Recently Dialed Numbers: Select from a drop-down list of your most recently dialed phone numbers to
place a call. For more information, see Make a Call Using the Number Field.

Report a Problem: You can create an email message and automatically include all of an interaction’s critical
information when reporting a problem with the CIC client to your support representative. For more
information, see Report a Problem.

Screen Pops: Screen pops can open your browser to a specific URL when a specific event occurs. For
example, an incoming ACD interaction can cause your browser to open to a specific webpage. For more
information, see Site-Specific Screen Pops.

Set another User’s Status: If your CIC administrator has granted you the right, you can set another user’s
status in the Company Directory or other directory view. A Change User’s Status button now appears in the
Directory toolbar. For more information, see Set Another User’s Status.

Workgroup Activation Status: If your CIC administrator has granted you the right, you can set your own
Workgroup Activation Status. For more information, see Change Your Workgroup Activation Status.

Wrap-Up Codes: If Wrap-Up codes are configured for your workgroup, you can assign a Wrap-Up code to
an interaction. For more information, see Understanding Wrap-Up Codes.

Documentation Library

The latest version of the Interaction Center Documentation Library is
http://help.inin.com/cic/desktop/Welcome_Page.html.

Related Topics

What's New in CIC client 4.0 Service Updates

What’s New in CIC client 4.0 Service Updates

The following changes and enhancements were introduced in the CIC client 4.0 Service Updates:

40SU 1
Drag and Drop Conferencing
Creating a conference call is as easy as making or receiving several individual calls, then dragging and
dropping each call to connect the participants.

Report a Problem

You can create an email message and automatically include all of an interaction’s critical information when
reporting a problem with the CIC client to your support representative. For more information, see Report a
Problem.

Unsupported Browser Warning

A new warning appears if you try to log on using an unsupported or out-of-date browser. For more
information, see Logging On.

408U 2
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Advanced Dialing Options

Advanced Dialing enables you to assign an Account Code and designate a workgroup for outgoing calls. For
more information, see Advanced Dialing Options.

Assistance Request
You can chat with your supervisor when you request assistance with an interaction. For more information, see
Request Assistance from Your Supervisor.
Change Station
You can change your CIC client station without having to log off and then log back in. See Changing Station.
Fax Viewer
You can use the new Fax Viewer to view a list of your received faxes and view or download the fax document.
For more information, see Use the Fax Viewer.

Most Recently Used Status list

An MRU section has been added to the Status drop down list. It now displays up to 10 of your most recently
used statuses at the top of the list. Your status appears first. The next most recently used statuses appear in
order. For more information, see Set Your Status.

Speed Dial Views

You can create and use Speed Dial views. These views can be private or you can share them with other
Interaction users. For more information, see Working with Speed Dial Views and Working with Speed Dial
Entries.

Supervisor Client Memos

CIC administrators can easily communicate with selected users, workgroups or roles by means of brief
messages. The administrator creates these Client Memos in Interaction Supervisor. Client Memos appear as
notifications in the CIC client. For more information, see Supervisor Client Memos.

Workgroup Statistics View

You can check basic statistics for workgroup queues. You can compare your Shift and Period Statistics with the
statistics for the entire workgroup. See Workgroup Statistics View. You can also change your workgroup
activation status based on these statistics.

408U 3
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Chats

You can conduct online, real-type typed conversations with other CIC client users or with a chat participant
who initiates a chat from your company’s website. See Working with Chat Sessions.

Directory Entries or Contacts
If you have the appropriate rights, as in the IC Private Contacts directory, you can insert, edit, and delete

directory entries. See Insert and Delete Directory Entries and View and Edit Directory Entries.

Email messages



What's New in CIC client 4.0 Service Updates

You can use the CIC client to read and respond to ACD-routed email messages or to send email messages on
behalf of a workgroup. You can also use a directory entry to address an email message and then send it using
your own email program. See Working with Email Messages.

You can attach a file to your email message or reply or view or download email file attachments. See Email
Window for Incoming Messages and Email Window for Outgoing Messages.

Park Email Messages
You can park an ACD-routed e-mail message on the queue for another user or workgroup. See Park an Email
Message on Another Person’s Queue.

Response Management

Response Management enables you to use pre-defined items such as messages and stored files to handle
interactions more quickly. Your CIC administrator can create system-wide response items and organize them
into categories. Your CIC administrator can then grant the necessary rights for all or selected users to use a
particular library of response items. You can also create your own personal responses for information you type
over and over again in interactions with customers or for files you often send to customers.

Text Filtering

If your CIC administrator enables text filtering, certain sensitive information such as credit card numbers or
Social Security numbers is blocked from view. You see only some replacement text such as #####H##H#H#H
instead of the numbers. See Chat Window and Email Window for Incoming Messages.

Wrap-Up Codes and Account Codes

This new Email and Chat window include support for interaction features such as Add Notes and Assign
Codes.

40SU4
Follow-Me phone numbers

You can set up the phone numbers used for Follow-me routing in the CIC client. These are the phone numbers
used when you set your status to Available, Follow-Me. The CIC client searches for you at different telephone
numbers by dialing phone numbers in a sequence you specify. You can set a timeout value for each phone
number or require anyone who answers the forwarded call to enter your CIC client password to accept the
call. For more information, see Set Up Follow-me Routing.

40SU5
Auto-Answer on SIP stations

A new Interaction Administrator configuration option can enable or disable Auto-Answer for incoming calls on
a SIP station. For more information, see Answer an Incoming Interaction.

Callback Retry

Callback interactions enable visitors to your company’s website to leave a request for an agent to call them
back. These callback requests are routed to the appropriate workgroup queue and then to an available agent.

Agents can put Callback requests into a "Snoozed" state if one or more attempts to reach the callback
requestor are not successful. A "Snoozed" callback interaction is removed from the agent’s queue and is
routed back to the appropriate workgroup queue. After an interval configured by your CIC administrator,

13
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normal ACD processing of the callback request resumes. ACD processing routes this callback request to the
first available agent in the workgroup.

The CIC administrator controls whether the "Retry later” feature is available. The CIC administrator configures
how many retry attempts can be made and how long a "Snoozed" callback request remains on the workgroup
queue before it is routed back to the agent. For more information, see Working with Callback Requests.

Chat

You can now chat with other CIC client users or remote chat participants who are browsing your company’s
website. Chats are online, real-time, typed conversations. You can initiate, pickup, conference, record, transfer
or disconnect Chat interactions. For more information, see Working with Chat Sessions.

Follow Me Phone Numbers

You can now configure follow me routing when you set your status to Available, Follow Me. To handle calls
when you are away from the office, the CIC client can search for you at different telephone numbers. The
client consecutively calls the telephone numbers in a follow-me routing list. After locating you, the client can
transfer the call to you at that location.

A Validate button now appears in the Set Status dialog box. When you set up Follow-me routing, use this
button to check your phone number entry against the requirements of the dial plan for your organization or
region. For more information, see Set Up Follow-me Routing.

Generic Object Routing

Customer Interaction Center supports the ACD routing of tasks specific to your organization. You can use
Interaction Web Client to handle CRM tickets or others tasks, if your CIC administrator enables this feature. For
more information, see Understanding Generic Object Routing.

Time in Status

If you have the appropriate Queue Columns Access Control right, you can display a Time in Status column in
any Workgroup, Station, or User queue view. For more information, see Access Control Rights or Add or
Remove View Columns.

408U 6

Transfer Options

The CIC client saves the search criteria selected in the Transfer Dialog Box between sessions.

Related Topics

What's New in CIC client 4.0

What's New in CIC client 2015-2016 Releases

14



Starting and Exiting

The following changes and enhancements were introduced in CIC client 2015 Releases:
2015 R2
Directory Settings

Interaction Client Web Edition preserves all your directory settings when you log on again to the same IC
server. You can use different workstations or different browsers.

Response Management

Response Management includes the new Inherited font feature. When you use a stored response created
with the Inherited font, it adopts the font and font characteristics (size, color, and so on) of the text
immediately preceding it in your email message. However, when you insert a response that has a selected font
and other font characteristics, then the stored response appears as originally formatted.

Related Topics

Create Personal Responses

My Responses Window

Use Response Management in an Email Message
What's New in CIC client 4.0 Service Updates

Starting and Exiting

Starting and Exiting

This section provides links to information on how to log on, log off, and exit the CIC client. It also contains links to
details about running the CIC client remotely.

Auto Reconnect

Exiting

Language Setting

Logging On

Logging On Remotely

Logging Off

Private Mode

Remote Station Types

Running the CIC client from a Remote Location
Single Sign On

Status Bar

Auto Reconnect

If the CIC client loses the connection to the web server, it automatically attempts to re-establish the connection. If
Auto Reconnect is not successful, contact your CIC administrator.

Related Topics

15
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Switchover

Change Your Password

If your Customer Interaction Center password has expired, you see an "Expired Password" warning when you start the
CIC client. Change your password immediately to log on and continue loading the CIC client. Failure to change your
password after an "Expired Password" warning causes the CIC client to exit.

Password Policies

Your CIC administrator creates Password Policies in Interaction Administrator. The password policy that is assigned to
you controls how often you must change your CIC password. It also determines minimum password length, how
many unique characters are required, whether sequential digits are allowed, how often you can reuse a password and
other password restrictions.

If your password is going to expire soon, a prompt appears periodically (usually once per day or on the next logon)
asking if you want to change your password now. If you select Yes, then the Change Password dialog box appears.

Tip: You do not need to wait until you are prompted to change your password. You can change your password at any
time. Also, if you previously selected, Automatically log me in next time, in the Web Server Log on page, your new
password is used for automatic logon.

To change your password at any time:

1.  From the Options menu, select Change Password.

Result: The Change Password dialog box appears.

Change Password

Please enter the following information to change your
Interaction Center password.

Old Password |---- |
Mew Password | 111} |
Confirm Mew Password |-------- |

[ Change Password ] [ Cancel ]

In Old Password, enter your current CIC password.
In New Password, enter your new CIC password.

In Confirm New Password, type your new CIC password again.

a b~ w D

Click the Change Password button.

Changing Station



Exiting

You can change your CIC client station without having to log off and then log back on. You could change station
between your desktop workstation and a configured remote station. If you are away from your desk, roaming the
office or moving from one remote location to another, using a remote station enables you to route calls to another
phone.

To change station:
1. Do one of the following:
Click the name of your current station in the Status Bar.
From the Options menu, select Change Station.

Result: The Change Station dialog box appears.

Change Station

@3 StetonTyse | Waorststor [=]]
Woristston | Apolo |
Remwote Number | |

|:] Persiztent
| Change Station [ Cancel ]

2. Complete the required fields. For more information, see Logging On.
3. Click the Change Station button.
Related Topics

Status Bar

Exiting
To exit the CIC client:

Click the X in the upper-right corner of the browser window or on the browser tab.
Related Topics

Logging Off

Language Setting

If the wanted language is available for the particular version of Interaction Client Web Edition that you are using, you
can select a language other than English for the CIC client interface and help.

To select a language:
1. Log off Interaction Client Web Edition, but keep the browser window open.

2. In the browser you are using for Interaction Client Web Edition, change your language preference to the
appropriate language.

Tip: Consult your browser’s help for information on selecting a preferred language.

17
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3. Restart the browser and log back on to Interaction Client Web Edition.
Related Topics

Configuration Options

Logging On

Requirements: You need the Logon Stations right to a specific station to be able to log on to it. To log on
automatically or use profiles to log on, your CIC administrator must allow the use of cached credentials. Some
Interaction Centers prevent automatic log on for security reasons.

You can run multiple instances of Interaction Client Web Edition on the same machine using different user
credentials and the same station. You can run multiple instances only in independently started browser
windows. You cannot run multiple instances of Interaction Client Web Edition in different tabs of the same
browser window or in a new browser window created from an existing browser window.

To log on:

1. Point your browser to the log on page.

Tip: Tip: Your CIC administrator can supply the URL for the logon page. Use the Help hyperlink if you have
questions about any of the required entries.

Result: The Log on page appears.

Host | |

serID | |

Password | |

Station Type | Workstation ¥

|
Workstation | |
|

Rerote Murmber |

Persistent

INTERACTIVE
INTELLIGENCE®
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Logging On

2. Do one of the following:

In IC User ID and Password, enter your CIC user account name and password as configured in
Interaction Administrator.

Tip: To verify your user account name or password, contact your CIC administrator.

In Domain\user name and Password, enter your Windows domain\username and password.

In User ID and Password, enter either your CIC client or Windows user name and password.

4. In Host, enter or select the host name.

4. In Station Type, select the type of station you are using to run the CIC client.

If you are running from a remote station or a remote number, see also Remote Station Types and Running the
CIC client from a Remote Location.

Select Workstation if you use a computer and telephone connected via telecom outlet (SIP or
analog phone) to the IC server.

Select Remote Workstation if you work from a "known" single remote location using a single
phone number for all calls to the agent’s extension. For more information, see Configured Remote
Stations.

Select Remote Number if you work from an Ad hoc remote location using a single phone number
for all calls to the agent’s extension. For more information, see Dynamic Remote Client Connections.

5. Do one of the following:

If your station type is Workstation or Remote Workstation, enter the name of the workstation in
the Workstation field.

If your station type is Remote Number, then enter the telephone number for CIC to call you in the
Remote Number field. (Remote Number is for remote access only.)

6. If your station type is Remote Number, do one of the following:

To keep the connection to the IC server active from the first time you require a voice connection to
the IC server until you log off, select Persistent.

To end the connection to the IC server when either side disconnects for any reason, clear the
Persistent check box.

Requirements: You need the Persistent Connections Security Right to select a persistent
connection when you are using a Dynamic Remote Client Connection.

If you are using a Configured Remote Station, the Interaction Station Connections are Persistent
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setting in Interaction Administrator Station Configuration controls whether you have a persistent
connection.

Note: If you do not have the appropriate persistent connection Security Right, you are still able to
logon. However, a License Error appears after you logon. It warns you that your request to establish
a persistent connection was ignored.

Example: The first time a remote agent receives a call or requires a voice connection to the IC server,
CIC calls the agent at the phone number entered in Remote Number. From that point on, you can
keep the telephone’s handset off-hook and use the CIC client to pick up, disconnect, or listen to calls.
If you hang up between calls, CIC must redial the Remote Number and wait for you to answer before
completing the operation.

Explanation: When you select Persistent, the call to your remote phone stays connected (an open
line to the IC server). If you leave the remote phone off-hook, and disconnect via the CIC client, the IC
server does not have to create a new call and dial your remote phone again. It just connects the
audio path to the new caller.

7. Optionally, select the Remember me check box. The next time you log on, all the fields on the Web Server
Log on page are completed for you, except for Password.

8. Optionally, select the Automatically log me in next time check box. The next time you log on, you go
directly to the main Web Client page and do not need to enter any settings at all.

9. Click Log on.

Result: In a secure system, a User Agreement similar to this one appears.

User Agreement

By using this Interaction Client system you agree to the following conditions:
1} You will consider the employee code of conduct during all interactions.
2} You will not use this system for any non-business related interactions.

3} You permit the company to record any and all interactions for quality and training purposes,

l OK J l Cancel

10. Click OK.

Related Topics

Auto Reconnect
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Logging On Remotely

Exiting

Logging Off

Remote Station Types

Running the CIC client from a Remote Location
Status Bar

Logging On Remotely

The procedure for logging on remotely is the same as logging on to the CIC client from an office workstation. See the
instructions in Logging On, paying particular attention to Station Type, Remote Number, and Persistent settings.

Related Topics

Remote Station Types
Running the CIC client from a Remote Location

Logging Off

You can log off by clicking Log off in the CIC client menu bar. This returns you to the Logon page and does not close
the browser window.

Related Topics

Exiting
Logging On

Remote Station Types

Customer Interaction Center supports two types of remote stations: dynamic and configured (static). Each type of
remote station connection serves a slightly different purpose, depending on the needs of the call center and of the
remote agent. Both provide the same full functionality of the CIC client.

Dynamic Remote Client Connections (Remote Number)

Requirements: In order to use a dynamic station, you need the appropriate rights. The Persistent Connections
Security Right enables you to select a persistent connection when you are using a Dynamic Remote Client
Connection. The User-defined Telephone Number on Remote Logon Security right enables you to enter a new
Remote Number when logging on.

Dynamic remote stations enable traveling agents to connect to the IC server and place or receive calls from any
remote location. This provides maximum flexibility for agents who may need to work from Ad hoc locations and
phone numbers. When such a remote agent starts the CIC client and logs in to the IC server, the agent may enter a
phone number (e.g., desk phone or cell phone) to which the IC server routes calls for that agent.

Dynamic remote stations do not have predefined station names configured in Interaction Administrator — the
telephone number given when the agent starts the CIC client and logs in to the IC server is the remote station. The IC
server detects that user is logged on and routes calls for that user’s extension to the remote phone number.

Configured Remote Stations (Remote Workstation)
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Requirements: You need the User-defined Telephone Number on Remote Logon Security right to use a configured
remote station and specify a different remote phone number when logging on to the CIC client.

This option is usually selected by default for all users. If this option is not selected, the configured remote station
user’s remote phone number is fixed in the Remote Station Configuration dialog in Interaction Administrator.

Configured remote stations are defined in Interaction Administrator as a “Remote Station” type of workstation with a
single remote phone number for all calls to the remote agent’s extension. Configured remote stations ensure that the
remote agent always connects to the IC server using the same remote phone number, unless the CIC administrator
changes it, or unless that user has been granted the right to change the number dynamically. Some call centers may
prefer this approach, to ensure remote agents are working from the prescribed location, and with the option of
granting flexibility to those who need it.

The remote station name can be the same as the remote agent’s computer name, or it can be another name. The CIC
administrator is responsible for creating these Remote Station workstations and or educating the remote agent on
how to use the CIC client (remote) Logon dialog to enter the station name.

SIP Stations are not Remote

Remote agents who use a SIP-enabled device or IP phone to receive calls from the IC server are not classified as
either dynamic or configured “remote stations.” This is because SIP devices/phones connect directly to the IC server
via an IP-based network connection. Distance or location with a SIP device/phone has nothing to do with its
classification as a “remote” station.

Each SIP device/phone is configured as a “local” Workstation type of station in Interaction Administrator, with the
Connection Type of “SIP” (instead of a Connection Type of “Line” for analog phone Workstations). The configuration
specifies the SIP address of the computer, which must be on the same domain or trusted domain as the IC server.
Some “remote” agents with SIP devices/phones may use a Virtual Private Network (VPN) connection over the internet
to connect to the domain and to run the CIC client and log on to the IC server. In any case, these stations are treated
as local workstations by the IC server.

Remote Station Licenses

Even though dynamic remote stations are not configured in Interaction Administrator, each dynamic station
connection is counted toward the total number of station licenses "in use" on your IC server. The number of current
dynamic station connections is added to the number of configured stations (i.e., Remote Stations, Workstations,
Stand-alone phones) that are Active to calculate the total number of active stations. If a remote agent attempts to
start the CIC client and log on to the IC server when the total number of station licenses are in use, that agent is not
able to connect, and he or she sees an error message indicating that no stations are available. An error message is
logged on the Event Log on the IC server as well.

Related Topics

Running the CIC client from a Remote Location
Logging On

Running the CIC client from a Remote Location

You can run the CIC client from a remote location. This means that users at home or on the road can receive regular
and ACD-routed incoming interactions, and use all the other CIC client features.

Answer and Make Calls
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Running the CIC client from a Remote Location

The IC server automatically alerts the remote workstation and rings the remote telephone, assuming the station is
configured in Interaction Administrator always to ring the telephone. To answer a call, the remote agent can simply
pick up the handset to connect to the call. Once the phone is off hook and connected to the IC server with a
persistent connection, the remote agent can dial directly from the phone keypad or from the CIC client.

Answer Calls

Once the CIC client starts and the agent’s status is available, incoming calls alert only on the workstation. The agent’s
telephone does not ring at the same time the call alerts the CIC client. The first time CIC sends a call to an available
remote agent may be different from subsequent calls, depending on how the agent ends the first call.

To answer the first call from CIC after logging on:
1. Do one of the following:
Select the alerting call and click the Pickup button.
Double-click the alerting call
2. When the telephone rings, pick up the handset to speak; CIC immediately connects the call.
3. When the call is over, do one of the following:

Click the Disconnect button and keep the handset off-hook. CIC automatically keeps a persistent
connection to remote agents, which means as soon as you click the Pickup button on subsequent
calls, the call is connected immediately without waiting for the phone to ring.

When the call is over, hang up the handset. In this case, CIC must re-dial the remote number to
complete subsequent calls.

Remote agents who are taking campaign calls from Interaction Dialer must not hang up the handset between calls to
avoid delays talking to the called party. Remote ACD agents should also keep the handset off-hook after the first call
from CIC, especially if the agent is configured to automatically connect to incoming calls (the calls are connected to
available agents without the agent clicking the Pickup button).

Make Calls

Once the CIC client starts, remote agents can place any call they are authorized to dial. The IC server dials the agent’s
number and then dials the destination number. As soon as the dialed number starts alerting, it simultaneously places
a call to the agent’s telephone.

To make a call:
1. Enter or select a phone number in the CIC client and click the Make Call button.

Result: CIC dials the agent then the number, and if it completes the call, it immediately connects it to the
remote agent’s telephone number.

2. Do one of the following:

If the handset is on-hook, when the telephone rings, pick up the handset to speak; CIC immediately
connects the call.

If the handset is off-hook, listen for the called party to answer.

3. When the call is over, do one of the following:
Click the Disconnect button and keep the handset off-hook. CIC automatically keeps a persistent
connection (based on this logon setting) to remote agents which means the agent can make

multiple calls without hanging up the handset, and the calls are connected immediately without
waiting for the phone to ring.
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When the call is over, hang up the handset. In this case, CIC must re-dial the remote number to
complete subsequent calls.

Keep a Persistent Connection to the IC Server

CIC detects when it needs to call a remote agent’s telephone vs. when it already has a (persistent) voice connection to
a remote agent. If you selected Persistent when you logged on, or if the Remote Station configuration requires it, CIC
keeps the connection open once you establish it.

For example, the first time a remote agent receives a call or performs any operation that requires a voice connection
to the IC server, CIC calls the agent at the phone number given on the agent’s Logon dialog box. From that point on,
the agent can keep the telephone’s handset off-hook and use the CIC client interface to pick up, disconnect, and
listen to calls or to record prompts. With the voice connection already established, these operations are
instantaneous. If the agent hangs up between calls, CIC must re-dial the agent’s telephone and wait for the agent to
answer before completing the operation.

Related Topics

Logging On
Remote Station Types
Switchover

Status Bar

The status bar has sections that display your current IC server name, user name, station name, and notifications:

Dial Email Transfer Vaicemail Parl Camp Status Properties

Kronos | ® lJimSmith | ¢" JIMSPC | Readthe ekase notes,

S5 6 & @

1 | IC Server The name of the IC server (Host) to which you are connected. For more information,
see Logging On.

2 | User Your User ID which is the user account name you used when you logged onto the
CIC client.
3 | Station The name of your currently active workstation. Click this section to change stations.

4 | Notification Area | This scrolling list displays your current notifications. For more information, see
Supervisor Client Memos.

Tip: Point to this area to display the full text of the current notification. An
underlined message indicates a hyperlink.

5 | Message Viewer Click this icon to display the Message Viewer and read all your current notifications.

Related Topics

Switchover

Using Views and Dialog Boxes
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Using Views and Dialog Boxes

Using Views and Dialog Boxes
This section provides links to information on dialog boxes, views, toolbars, and shortcut keys in the CIC client.
Call History
Camp Desktop Alert
Dial Pad
Directories
Directory Properties Dialog Box
Fax Viewer
Interaction Properties Dialog Box
My Interactions
Set Status Dialog Box
Shortcut Keys

Supervisor Client Memos

Call History

The Call History dialog box displays information about your recent incoming and outgoing calls, including the name
and phone number of the other party, the day and time of the call, and its duration.

logoff MNewvy Viewy | Optionsvy Helpry

a -‘ r-‘| '| Make Ca

Call History b

Lynch, Tom Today, 1:42 PM
batatatal 0:00:17

—_—

L3

—5555[ Outgeing call to System at 5555 }

( 3) System Today, 1:41 PM
0:00:07
| Bishop, Leo Today, 1:40 PM |5
@_) ! 17 5 0:0032 | «1—{ 6
NormanTeak Today, 1:153 PM
(317 555-0994 0:00:26 |
®7 System Fri, 11:26 AM
1313 0:00:48
<> Bishoo. Leo Wed, 110 PM T E

L =
®—>snuw: | ANl Calls [=] | Properties |< ={)

1 | Select the Call History button to display your call history.
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2 | You can also select Call History from the View menu to display your call history.

3 | Aselected call appears shaded.

4 | Each item in the Call History list contains information about the call including starting date and
time, duration, and the name of the other party (if available). A call icon indicates whether the call
was answered, missed or outbound.

5 | Point to the call icon to display a tooltip which describes the type of call and displays the name of
the other party and their phone number.

6 | Use the scroll bar to view other calls in your call history.

7 | Click the phone number hyperlink to dial the number.

g | Use the Show drop-down list to select the type of calls displayed in your Call History. You can
choose to display all calls, or just your missed, outgoing, answered or forwarded calls.

9 | Click the Properties button to view extended information for an interaction or to make notes for a
currently active interaction. For more information, see View and Edit Interaction Properties.

Displaying the Call History Dialog Box
To display the Call History dialog box, do one of the following:
Select the Call History button.
Select Call History from the View Menu.
Using Call History to Make Calls
Click a phone number hyperlink in the Call History dialog box to dial the number associated with the call.

Call History Retention

History is tracked for calls that appeared in My Interactions. These are calls that were inbound to you, calls placed by
you, calls transferred to you, and calls used to retrieve voice mail messages.

Call history is maintained by Client Services on the IC server. By default, call history information is retained for three
(3) days or 300 calls, whichever comes first, per user. The amount of call history data stored per user depends on the
version of Client Services running on the server and how it is configured by the CIC administrator.

Tip: Call History items are added to your Call History dialog box when a call leaves your queue. When a call
disconnects, it stays in the queue for a couple of minutes before it is automatically removed.

Related Topics

Customizing the Interface
Dial a recently dialed number
Use the Voicemail Viewer

Camp Desktop Alert

The Camp desktop alert lets you know when another user whose status you are monitoring, changes his status.
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Using the Dial Pad

I o

= Camp Alert: - Windows Internet Expl... | = | = |[Q]
87 Mike Hill

S Available
Time in status: 2155:36

W' Logged on MIKEHPC

[ Call Mow ] [ Stop Camp

Related Topics

Camp on an Internal Extension

Using the Dial Pad

The Dial Pad enables you to a dial phone number to place a call, send DTMF tones to a connected call or the currently
selected call, or make selections from an automated telephone menu system. The Dial Pad can also send DTMF tones
through a connected SIP Soft Phone.

The Dial Pad is just one of several ways of initiating phone calls. For more information, see Making Calls.
To display the Dial Pad:
From the View menu, click Dial Pad.
To use the Dial Pad:
1. Display the Dial Pad.
2. Click the appropriate buttons on the Dial Pad to dial a phone number.

Result: The selected numbers appear in the Number field.

Tip: Use the CLR button on the Dial Pad to clear an incorrect number, one digit at a time.

3.  On the Dial Pad, click the Call button.

Result: The number is dialed.

4. Optionally, click buttons on the Dial Pad to make selections from an automated telephone menu system. It's
just like using a touch tone phone Dial Pad.

5. Click the End button on the Dial Pad to disconnect the call.
Related Topics

Disconnect button
Making Calls

Directory Properties Dialog Box

When you select a directory entry, the Properties dialog box enables you to view directory entry information.
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Properties For Took, Noreen b4

General | Business || hore Business || Home || Motes |

First Mame: |Nureen |
Last Mame: |Tcu::uh: |
Display Mame: |Tcu::uh:, Mareen |
Company: |Ir1tera ctive Intelligence, Inc. |
HomePhone:  |317)5550300 | pt: | | [ ] Auto Dial Extension
Business Phone:  |317)5558726 | Ext: | | [] Auto Dial Extension
Mobile: |317)555-0994 | Ext: | | [ ] Auto Dial Extension

Close

Related Topics

Interaction Properties Dialog Box
Properties Button on the Directory Toolbar
View and Edit Directory Entries

Working with Directories

Interaction

In the CIC client, an interaction is a communication between two parties. An example would be a telephone call. Each
interaction is represented by a queue item in My Interactions.

Interaction Properties Dialog Box

Use the Interaction Properties dialog box to add notes to an interaction or view the interaction log. You can also use
the Interaction Properties dialog box to assign account codes and Wrap-Up codes to interactions. For more
information, see Working with Account and Wrap-Up Codes.

Toolbar

Use the Interaction Dialog box toolbar to manage any selected and connected interaction.

Tip: Your CIC administrator can configure the CIC client to display the Interaction Properties dialog box every time
you receive a call. See Calls Configuration.

Access from My Interactions

You can access the Interaction Properties dialog box during or just after an interaction; that is before it is removed
from My Interactions. You can add notes or view the log for the interaction. Also, if your company uses these codes
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My Interactions

and you have permission to use these features, you can assign Account Codes or Wrap-Up Codes. For more

information, see Working with Account and Wrap-Up Codes.

To access the Interaction Properties dialog box from My Interactions:

While the interaction is ongoing or still appears in My Interactions, select an interaction and click the

Properties button on the Queue Control toolbar.

Result: The Interaction Properties dialog box appears.

Interaction Properties: Joe Smith

Motes | Log

09:54:31

09:54:31

09:54:32

09:54:31:
09:54:31:
09:54:31:

Initializing
Offering
ANL 3176960994

: DNIS: 3177158076
09:54:31:

Offering

: 5ent to user Noreen.Tinker
09:54:32:

User Alert: Moreen.Tinker

: Alerting
09:54:32:
09:54:35:
09:56:46:

Sent to station MoreenTinkersIP
Connected
Disconnected [Remote Disconnect]

Account Code | [12] ABC Corp.

Piclkup

f Joe Smith | 317) 6960994 | & 1066971619  Disconnected [Remote Disconnect]

[=]

a A2 (b

Halel fute Vaicemail

Ul

Pause

@

Private

Access from Call History

When you access the Interaction Properties dialog box from Call History, you can view Notes taken during the
interaction or select the Log tab to view interaction connection information. You cannot make additional notes or
assign Account or Wrap-Up codes to an interaction that is no longer in My Interactions or other user queue.

To access the Interaction Properties dialog box from Call History:

Select an interaction and click the Properties button in the Call History dialog box.

Related Topics

Assign Codes to an Incoming Interaction
Assign Codes to an Outgoing Interaction
View and Edit Interaction Properties
Working with Account and Wrap-Up Codes

My Interactions

The current interactions (calls) in your user queue appear in My Interactions. These are the interactions you currently
manage. If you are a member of one or more ACD workgroups, interactions assigned to you from those workgroups

29



Interaction Client Web Edition Printable Help 2016 R4

appear in My Interactions. The name of the ACD workgroup from which those interactions came appears above the
interaction ID.

My Interactions contains the following controls and displays information about each interaction.

P 990000

» = & ¥

N

(w4]

}

My Interactions

.

From N Tasker at (317) 611-0000 Marketing
3 0:01:31 - ACD - Assigned: userl 3ﬂ889§103ﬂ

® ® ®

l B !
2|2 ||| || ® @ e 1 B3| O

F|-:}.'l.||3 Hold Mute Transfer |  Woicemail Disconnect Listen Record Pause Private Properties

1 Name The name of the person who is calling or whom you have called. For more
information about how Interaction Center identifies a caller, see Caller Name.

2 Number The telephone number of the person with whom you are speaking.

3 Voice mail Click this button to display the Voicemail Viewer.

4 Faxes Click this button to display a Fax Viewer.

5 Call History Click this button to display the Call History list. From here you can click to dial the
number of a recent call or display the properties of a call. For more information, see
Call History.

6 Speed Dial Click this button to display the Speed Dial List. For more information, see Display a
Speed Dial View.

7 Dial Pad Click this button to display the Dial Pad. Use the Dial Pad to place a call, send DTMF
tones to a connected call or the currently selected call, make selections from an
automated telephone menu system, or end a connected call. For more information,
see Dial Pad.

8 Number Fields This field and associated button enable you to place outgoing calls from the CIC
and Make Call client. For more information, see Make a Call Using the Number Field and Make a
Button Call Using the Make Call Button.

9 Duration How long (hh:mm:ss) an interaction has been active.

10 | State The current condition of an interaction. For more information, see Understanding

an Interaction’s State.

11 | Queue If this is an ACD-routed interaction, the name of the ACD workgroup from which
the call came appears above the interaction ID.

12 | Interaction ID This is an interaction’s identification number. Numbers are assigned sequentially.

13 | Queue Control The Queue Control toolbar helps you manage your interactions. The actions
Toolbar available on the Queue Control toolbar are determined by the state of the currently

selected interaction. For more information, see Using the Queue Control Toolbar.

Interaction Notification

30



Phone Number Controls

A notification appears in the bottom right corner of My Interactions when an interaction is alerting in the queue but is

not visible due to the scroll position of the list. This alerts you that an interaction needs attention but is not visible.
This notification disappears when there are no alerting interactions out of view anymore or when you select the

alerting interaction.

Log off MNeww

Viewy Optionsvy Helpr

1001990211

groupb
1001990212

¥ Mew Interaction admin at 5000 dj

2| o

rivate Properties

Tip: Click the Interaction Notification to select the out of view and alerting interaction.

Phone Number Controls

The CIC client verifies phone numbers that you enter against the dial plan for your organization or region. Verification
ensures that the phone numbers you enter for directory entries and configuration options are correctly formatted and

can be dialed.

Home Phone @ |[31?j. 553-2134 | Ext {23 Dial |:|

Business Phone

[] Auto Dial Extension

@ 5553456 |ext|123¢4 ||| [v‘]@

Auto Dial Extension @

1 | Validated phone
number

A validated phone number is formatted according to the rules of the dial
plan for your organization or region. A validated phone number becomes
the display number in the CIC client.

2 Dial button

Click the Dial button next to a validated phone number to dial that number.

3 | Unvalidated phone
number

A phone number appears exactly as you enter it until you validate it.

4 | Validate button

Click the Validate button to check your phone number entry against the
requirements of the dial plan for your organization or region.

5 | Auto Dial

Select this check box to automatically dial the extension number after your
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Extension call is connected.

Related Topics

Follow-me Routing Options
Insert and Delete Directory Entries
View and Edit Directory Entries

Set Status Dialog Box

Requirements: You need the Change Status Users Access Control right to a specific user to be able to change that
user’s status.

The Set Status dialog box enables you to set your status.

Set Status: Jason Smith x

Status
@ At a Training Session A |

Status Motes

Until Date

Until Time

| -]

Lok J[ Ganeat |

Related Topics

Set Status Details
Set Another User’s Status

Shortcut Keys

Interaction Client Web Edition does not currently support keyboard shortcuts for buttons and fields.

Supervisor Client Memos

CIC administrators can easily communicate with selected users, workgroups or roles by means of brief messages. The
administrator creates these Client Memos in Interaction Supervisor. Client Memos appear as notifications in the CIC
client.
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Transfer Dialog Box

Notification Area

Notifications appear in the Status Bar. The client notification area presents the text of the client memo in a stock
ticker-like format. If you receive multiple client memos, then the memos scroll. Current memos move into the
notification area by rotating in from the bottom while any other memo rotates out the top. There is a pause of several
seconds between the time the memo is fully rotated in and the time it begins cycling to the next memo to allow you
some time to read the memo.

Click the Message Viewer icon in the Status Bar to display all the current notifications on your system. You can click a
notification that contains a URL link, launching your browser and displaying the appropriate page.

Messages

"‘1 File the status report on youwr department’s Sharepoint site.
Resd the relesse notes.

n The middle elevator is out of order. Maintenance has been called. Pleaze
use the other elevators wuntil further notice.

F 20 calls in workgroup gueus.

Related Topics

Status Bar

Transfer Dialog Box

Requirements: Access Control Rights determine which Attendant Profiles, Workgroup Queues and Station Queues
are available as transfer targets. By default, the Transfer dialog box searches the Company Directory, and the
appropriate Attendant Profiles, Workgroup Queues, and Station Queues for matching names and numbers. Your
system administrator can use Interaction Administrator to create or change the server parameter,
TransferDialogDirectories, to include additional directories in the search.

The Transfer dialog box enables you to locate and select the recipient of a transferred interaction, using the search
criteria you prefer. Then you can easily start the transfer by clicking a button.
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Transfer: From Bishop, Leo at 8888

Transfer to: fla| | Options v
Dial 'fla’ as digits
Flavio Bali [7777)
Flavio Moss [5555)
Jan Flamel [9999)
Stuart Flatt (2222)

2 & h o

Transter Parl Yaicemail Consult

Using the Transfer dialog box

Warning: Perform a consult transfer only when you need to speak with both parties before completing the transfer. If
this is not necessary, perform a blind transfer. Using a consult transfer to transfer a call to an attendant profile or to
an agent's voice mail is not a supported feature. This may result in the original caller being sent to the default
attendant profile. For more information about blind transfers, see Transfer a Call Without Consulting the Recipient.

As you type the recipient’s name or number in the Transfer To text box, a drop-down list of choices appears.
Selecting “Dial 'your entry' as Digits” converts a text entry into numbers that the CIC client dials.

Selecting a contact name from the drop-down list causes the CIC client to dial the associated extension or
phone number.

You control the types of information used to find a match.
Use the Options drop-down list to filter the contact search. You can choose to search any combination of

Users, Workgroups, Standalone Phones, Station Queues, Station Groups, or Attendant Profiles.

Requirements: Search Station Queues and Search Workgroup Queues Access Control rights determine
which station and workgroup queues are available as transfer targets.

As you type in the Transfer to text box, the selections you made in the Options drop-down list determine
which information is used to find a match.

Status Information for Transfer recipient

After you select the transfer recipient, the Transfer dialog box displays the user status information if he or she is a CIC
client user. This includes current user status, whether the user is logged on or on the phone. This can help you decide
what kind of call transfer to use.
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Using the Toolbars

lransfer: From Bishop, Leo at 8888

Transfer to: | Stuart Flatt (2222) | Options ¥

(]
@ Stuart Flatt

Status a Available, Mo ACD
o Logged in

Extension 2222

Department Development

P/ || ™ | 08

Transter Park Yoicemail Cansult

Related Topics

Park a Call on Another Person’s Extension
Transfer a Call After Consulting the Recipient
Transfer a Call to Another Person’s Voicemail
Transfer a Call Using a Transfer Button

Transfer a Call Without Consulting the Recipient

Using the Toolbars
Using the Toolbars
The CIC client includes two toolbars:
The Queue Control toolbar helps you manage telephone calls. It appears in the My Interactions section.

The Directory toolbar simplifies working with contacts listed in user directories. It appears on each directory
view.

Related Topics

Using the Queue Control Toolbar
Using the Directory Toolbar

Using the Queue Control Toolbar
Using the Queue Control Toolbar

Requirements: Interaction Command Rights determine which buttons appear on the My Interactions Queue Control
toolbar. My Interaction Rights determine the actions you can perform.

The Queue Control toolbar helps you manage your interactions. The actions available on the Queue Control toolbar
are determined by the state of the currently selected interaction and your rights.

Related Topics

Queue Control Toolbar Buttons

35



Interaction Client Web Edition Printable Help 2016 R4

Queue Control Toolbar Buttons

Queue Control Toolbar Buttons

Your CIC administrator controls which buttons appear on the Queue Control toolbar in My Interactions.

Requirements: You need the appropriate My Interaction Right to use a button when it appears in the My
Interactions toolbar.

Click a button name for a description of its function.

% Assistance
5) Disconnect
g Hold

@)) Listen
d Mute

" Pause
{_) Pickup
o Properties
ﬁ\ Private
. Record
? Transfer

l!. Voicemail

Related Topics

Using the Queue Control Toolbar

Assistance Button
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Disconnect Button

Requirements: The "Assistance" Interaction Command Right determines whether the Assistance button can appear
on a toolbar. The Request Assistance from Supervisors Security right enables you to request assistance from your
supervisor.

Icon %

Location Queue Control toolbar

Chat window

E-mail Window for Incoming Messages
E-mail Window for Outgoing Messages

Description Sometimes you encounter an interaction for which you need assistance. For example, a
caller asks a question that you cannot answer. Or you are in the middle of a web chat
when you need help from your supervisor.

If you need help with an interaction, click the Assistance button to request assistance from
your Supervisor.

Related Topics

Assistance Process
Request Assistance From Your Supervisor
Using the Queue Control Toolbar

Disconnect Button

Requirements: The "Disconnect” Interaction Command Right determines if the Disconnect button can appear on a
toolbar. The Disconnect Interactions Security right enables you to disconnect an interaction appearing in My
Interactions.

v
Icon \5)

Location Queue Control toolbar
Interaction Properties Dialog Box

Description Click Disconnect to disconnect the current interaction.
When you click Disconnect, the icon for that interaction changes to a Disconnect icon.

&

Related Topics

Disconnect a Call
Using the Queue Control Toolbar

Hold Button
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Requirements: The "Hold" Interaction Command Right determines if the Hold button can appear on a toolbar. The
Put Interactions on Hold Security right enables you to hold an interaction appearing in My Interactions.

Icon Z
=
Location Queue Control toolbar

Interaction Properties Dialog Box

Description Click Hold to place the selected interaction on hold.

To take the interaction off hold, click Hold again, or click Pickup.

When you click this button, the icon for the selected interaction changes to a Hold icon

Tip: Your CIC administrator can configure a maximum hold time for interactions. By default, interactions on hold for
longer than fifteen minutes are disconnected. Your administrator can change the amount of time an interaction can
remain on hold and the behavior that occurs once the hold time is exceeded. For example, your administrator may

choose to transfer interactions on hold longer than twenty minutes to another queue. For more information, see your
CIC administrator.

Related Topics

Place a Call on Hold
Using the Queue Control Toolbar

Listen Button

Requirements: The "Listen" Interaction Command Right determines if the Listen button can appear on a toolbar.
The Listen in on Interactions Security right enables you to listen to an interaction appearing in My Interactions.

)

Location Queue Control toolbar

Description Click the Listen button to listen in on a call. You can listen to a caller leaving a voice mail
message, to a call on hold, or to a conference call.

The parties being listened to may not be aware that someone is listening to the call. For
more information, see Determine if Someone is Listening to or Recording Your
Interactions.

Tip: Click the Private button while you are connected to an interaction if you do not want
anyone to be able to listen to the conversation.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Related Topics
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Mute Button

Determine if Someone is Listening to or Recording Your Interactions
Listen to a Call

Listen to Someone Leave a Voicemail Message

Using the Queue Control Toolbar

Mute Button

Requirements: The "Mute" Interaction Command Right determines if the Mute button can appear on a toolbar. The
Mute Interactions Security right allows you to disable the microphone on your telephone while working with an
interaction appearing in My Interactions.

Icon a

Location Queue Control toolbar

Description Click Mute to disable the microphone on your telephone so that the other party or parties
cannot hear what you are saying.

Click Mute again to reactivate the microphone.

If you are in a conference call hosted by a different IC server and you put the call on hold,
you should first click Mute to avoid playing on-hold music to the other parties in a
conference call.

Also, if you are currently being assisted by a supervisor, the customer no longer hears you,
but the supervisor can continue to converse with you. For more information, see Coach
Button.

Related Topics

Using the Queue Control Toolbar

Pause Button

Requirements: The "Pause" Interaction Command Right determines if the Pause button can appear on a toolbar.
The Pause Interactions Security right also enables you to pause while recording an interaction appearing in My
Interactions.

Icon "

Location Queue Control toolbar
Interaction Properties Dialog Box

Description Use this button to control a recording session.

Click this button to pause the recording session. Click it again to resume the recording
session.
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Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record. Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Related Topics

Record a Call

Record Button

Secure Record Pause Button
Using the Queue Control Toolbar

Pickup Button

Requirements: The "Pickup" Interaction Command Right determines if the Pickup button can appear on a toolbar.
The Pickup Interactions Security right enables you to pick up an interaction appearing in My Interactions.

Icon '_)

Location Queue Control toolbar

Description Click this button to pick up the current interaction, or to take the current interaction off
hold. When you click this button, the icon for a call changes to a Connected icon.

Related Topics

Pick Up a Call From Voicemail
Using the Queue Control Toolbar

Private Button

Requirements: The "Private" Interaction Command Right determines if the Private button can appear on a toolbar.
The Private Interactions Security right enables you to mark an interaction appearing in My Interactions as private.

B

Icon ﬁ

Location Queue Control toolbar

Chat Window

Email Window for Outgoing Messages
Interaction Properties Dialog Box

Description Click this button to prevent other Customer Interaction Center users from recording or
listening to your conversation.

Warning: Use of the Private feature may be subject to your company’s policies and should
only be used in accordance with those policies. CIC handler customization can be used to
track the use of the Private feature to ensure compliance with such policies.

Related Topics

Using the Queue Control Toolbar
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Properties Button on the Queue Control Toolbar

Properties Button on the Queue Control Toolbar

Icon o

Location Queue Control toolbar

Description The Properties button enables you to view and edit detailed information on the selected
interaction. For more information, see View and Edit Interaction Properties.

Related Topics

Properties Button on the Directory Toolbar
Using the Queue Control Toolbar
View and Edit Interaction Properties

Record Button

The Record button enables you to make recordings of all or selected parts of an interaction. These Ad hoc recordings
are stored as WAV or XML files.

Requirements: The "Record" Interaction Command Right determines if the Record button can appear on a toolbar.
The Record Interactions Security right enables you to record an interaction appearing in My Interactions.

Icon .

Location Queue Control toolbar
Chat Window
Interaction Properties Dialog Box

Description Click Record to record the currently selected call or chat. A call recording is saved as a. wav
file. A chat recording is saved as a .txt file.

Clicking Record the first time starts the recording session for a call. Clicking Record again
stops the recording session for a call.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Related Topics

Record a Call
Using the Queue Control Toolbar

Secure Pause Button
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Requirements: The "Secure Recording Pause" Interaction Command Right determines if the Secure Pause button
can appear on a toolbar. It also controls whether the Secure Pause command appears on a shortcut menu or is
available via a keyboard shortcut. The Secure Recording Pause Interactions Security right enables you to secure
pause a recording of an interaction appearing in My Interactions.

Icon :\aﬁ

Location Queue Control toolbar

Keyboard shortcut | Ctrl+Shift+E

Tip: Keyboard shortcuts work only if you select an interaction in My Interactions or other
queue to ensure that it has focus before you press the keys.

Description Click Secure Pause to avoid recording sensitive information, such as a Social Security
number or credit card number, when you are connected to a call interaction.

During a secure recording pause, your recording of the interaction (and all recordings by
any other monitors of this interaction) are paused for a configured period of time. The
Secure Pause button displays a countdown timer of how long all recordings will continue
to be paused. The Secure Pause does not end until the timer reaches zero.

You can press Secure Pause again during a pause to reset the countdown timer to the
maximum duration of a pause. The maximum duration of a Secure Pause is configured in
Interaction Administrator. Contact your CIC administrator if you have questions about the
length of a Secure Pause.

Tip: Pressing Secure Pause multiple times during a pause does not increase the duration
beyond the maximum time limit.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Related Topics

Record a Call
Secure Pause a Recording
Using the Queue Control Toolbar

Transfer Button

Requirements: The "Transfer" Interaction Command Right determines if the Transfer button can appear on a
toolbar. The Transfer Interactions Security right enables you to transfer an interaction appearing in My Interactions.

Icon r:?)
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Voicemail Button

Location Queue Control toolbar

Description Click this button to open the Transfer dialog box where you can enter the telephone
number of the transfer recipient in the Transfer to: text box, then click OK to complete
the transfer.

Related Topics

Transfer a Call After Consulting the Recipient
Transfer a Call to Another Person’s Voicemail
Transfer a Call Using a Transfer Button

Transfer a Call Without Consulting the Recipient
Using the Queue Control Toolbar

Voicemail Button

Requirements: The "Voicemail" Interaction Command Right determines if the Voicemail button can appear on a
toolbar. The Transfer Interactions to Voice Mail Security right enables you to transfer an interaction appearing in My
Interactions to your voice mail.

Icon m

Location Queue Control toolbar
Interaction Properties Dialog Box

Description Click this button to transfer a selected call to your voice mail account.

Use this button if you want to send an incoming call to your voice mail instead of speaking
with the caller.

Related Topics

Send to Voicemail Button

Transfer a Call to Another Person’s Voicemail
Transfer a Call to Your Voicemail

Using the Queue Control Toolbar

Using the Directory Toolbar

Using the Directory Toolbar

Use the Directory toolbar to simplify working with contacts and managing the flow of incoming interactions. The
Directory toolbar provides actions involving directory entries and active interactions. The Directory toolbar is located
at the bottom of each directory tab.

Some buttons may not be available in all situations. If a button appears shaded, or grayed-out, you may not be able
to use it on the currently selected interaction or contact.

Related Topics
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Directory Toolbar Buttons

Using the Toolbars

Directory Toolbar Buttons

Directory Toolbar Buttons

The following list contains the buttons available for the Directory toolbar. Customizing Toolbars

Toolbar Label Function
Button
a 7 Camp Camp
55}
ﬁ Chat Initiate new Chat
@ Dial Dial default phone number
=2 Email Send an email message to the business address for the
selected directory entry.
ﬂ Park Park on Queue
B Properties Properties
@ Status Change user’s status
* Transfer Blind transfer to default number
%I Voicemail Send to Voicemail

Related Topics

Using the Directory Toolbar

Camp Button

Icon B 2
Location Directory Toolbar
Description Click this button to camp on the internal extension of a selected directory entry.

Use this button to watch another user’s status. You are alerted when the other user’s
status changes to an available type.

Related Topics

Camp Desktop Alert
Camp on an Internal Extension

Change User’s Status Button
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Requirements: You need the Change Status Users right for the selected user to set another user’s status.

Dial Button

Icon m
Location Directory Toolbar
Description You can set another user’s status in the Company Directory or other directory view.

Related Topics

Set Another User’s Status

Dial Button

Icon @

Location Directory Toolbar

Description Use this button to dial a specific number associated with a selected directory entry by

doing one of the following:

the default number.

§  Select an entry in the Company Directory and then click the Dial button to dial

§  Select an entry in the Company Directory and then click the arrow on the Dial
button. Click one of the displayed "Dial" entries to dial the associated number.

W  Robert
W Mick

& Extension
& Business Phone
3 Mobile Phone

& Fax

-

Dial

Related Topics

Make a Call Using the Dial Button
View and Edit Directory Entries

Send Email Message Button
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Use the Send Email message button to send an email message to the business email address associated with a
selected directory entry.

lcon %

Location Directory Toolbar

Description Select a Company Directory entry and click the Email button to use your email program to
send an email message to the business address for the selected directory entry.

Related Topics

Send an Email Message

Park on Queue Button

o

Location Directory Toolbar

Description You can place any connected call or connected ACD-routed email interaction in your
queue in a selected user’s queue or workgroup queue.

Select a directory entry and then click this button. This removes the interaction from your
queue (My Interactions). It appears in the selected person’s queue.

Properties Button on the Directory Toolbar

Icon o

Location Directory Toolbar

Description The Properties button on your Directory toolbar enables you to view and edit detailed
information for the selected directory entry. For more information, see View and Edit
Directory Entries.

Related Topics

Properties Button on the Queue Control Toolbar
View and Edit Directory Entries

Send to Voicemail Button

Icon ﬁ

Location Directory Toolbar

Description Use this button to transfer a call to a selected CIC user’s voice mail account.

Select a directory entry and click this button. The currently selected call is transferred to
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Transfer Button

the designated user’s voice mail.

Related Topics

Transfer a Call to Another Person’s Voicemail
Transfer a Call to Your Voicemail

Using the Queue Control Toolbar

Voicemail Button

Transfer Button

Requirements: The "Transfer" Interaction Command Right determines if the Transfer button can appear on a

toolbar. The Transfer Interactions Security right enables you to transfer an interaction appearing in My Interactions.

Icon *

Location Directory Toolbar

Description Use this button to transfer a call to a specific number associated with a selected directory
entry by doing one of the following:

Select an entry in the Company Directory and then click the Transfer button to
transfer the call to the default number.

Select an entry in the Company Directory and then click the arrow on the Transfer
button. Click one of the displayed "Transfer" entries to transfer the call to the
associated number.

E?' Extension

S}y Business Phone
=t Mabile Phone

':P' Fax
D .|| Ta
Transfer Voicemail

Related Topics

View and Edit Directory Entries

Configuration Options

Configuration Options

The CIC administrator sets your CIC client configuration options in Interaction Administrator. Contact your CIC
administrator if you have questions about your settings.

Alerting Options

Alerting Options
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Requirements: The Multiple Calls Security right controls whether you are alerted to the arrival of a new call when
you are already on a call. This type of alert is in addition to the alerting options you can figure yourself.

The CIC administrator configures how the CIC client notifies you of new incoming calls, faxes or voice mail, among
other options. For more information about alerting options, see:

General Alerting Options

Voice Mail / Fax Paging

Firefox Ring Sounds

If you use the Mozilla Firefox browser with Interaction Client Web Edition, you need to install the Adobe Flash add-on
for Firefox, version 9 or later, in order to hear a ringing sound when a new call alerts in My Interactions.

Consult the Mozilla Firefox website for instructions on downloading and installing Firefox add-ons.

General Alerting Options

Your CIC administrator can configure how the CIC client works. Contact your CIC administrator if you have questions
on how any of these options are set on your system.

Among the general alerting options that can be set by your CIC administrator are:
If your telephone rings when new calls appear in My Interactions.
If new interactions ring through your computer’s speakers.
If new interactions ring on the computer if you are already on the phone.

If an incoming interaction causes the CIC client to appear on top of any other application you are running.
This is also called "popping the client.”

How long an incoming non-ACD call rings before timing out.

Voice Mail / Fax Paging

Your CIC administrator can use Interaction Administrator to configure how Interaction Client Web Edition works.
Contact your CIC administrator if you have questions on how any of these options are set on your system.

Your CIC administrator can set voice mail alerting options. These options control whether you receive alerts:
&  When you have voice mail.

At a designated telephone number.

For new voice mail messages.

Every time you receive a voice mail message.

Only for voice mail messages marked urgent.

w W W W W

Any time of the day or only during specific hours (office hours, for example).
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Call Options

The CIC administrator configures how the CIC client manages incoming interactions. For more information, see:

Call Options

Call Options
Calls
Follow Me

Call Coverage

Personal Prompts

Calls Configuration

Your CIC administrator uses Interaction Administrator to configure how Interaction Client Web Edition works. Contact
your CIC administrator if you have questions on how any of these options are set on your system.

Your CIC administrator can set the following calls options:

Calls Options

Timeout for external calls
(in seconds):

This option determines the number of seconds your outgoing calls ring before
they are disconnected.

Use advanced dialing
options (account code,
workgroup)

If enabled, the Advanced Dialing Options dialog box appears when you call.
You can then assign an Account Code to the call and associate the call with a
Workgroup. For more information, see Advanced Dialing Options.

Analyze outgoing external
calls

If enabled, Telephony Services (TS) monitors whether the outgoing interaction
connects to a person or an answering machine.

An interaction is listed in the Dialing state after dialing a number from the
Number field. After the remote party picks up the interaction, the state changes
to Connected. If an interaction does not connect, then TS tries to diagnose why
the attempt to connect failed. TS displays the reason: the other party did not
answer or the line is busy.

Show alert dialog when
call becomes unsecure

If enabled, a Security Alert dialog box appears when a call is downgraded from
secure to non-secure.

Enable call waiting

If enabled, you are notified when another call is coming in while you are on the
phone.

Mute calls when
transferring

If enabled, transferred calls are muted so the caller cannot hear what you are
saying. (However, the transfer recipient can hear you.) Once you have either
transferred the call or closed the Transfer dialog box, the call is no longer muted.

Open new window for

If enabled, the Interaction Properties dialog box appears every time you receive a
call. You can enter notes on the current call in this dialog box. For more
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incoming calls information, see Interaction Properties Dialog Box.

Operator target number: This option determines the telephone number or extension to which callers who
choose O (zero) to exit out of your voice mail are sent.

Set Up Follow-me Routing

Requirements: You need the Follow Me Security right to use Follow-me routing in the CIC client. Your Phone
Number Classifications-Follow Me Access Control rights determine which phone numbers you can use as Follow-me
numbers.

To handle calls when you are away from the office, the CIC client can search for you at different telephone numbers.
The client consecutively calls the telephone numbers in a follow-me routing list. After locating you, the client can
transfer the call to you at that location.

You can set up follow-me routing in the CIC client. You can also use the Telephone User Interface to turn Follow-me
on or off and configure Follow-me phone numbers. For information about setting up Follow-me numbers via the TUI,
see the Telephone User Interface User’s Guide or Quick Reference Card in the CIC Documentation Library.

To add a follow-me phone number:

1. Setyour status to Available, Follow-Me.
2. Click the Set status details link next to the My Status drop-down list.

3. Inthe Set Status dialog box, complete the fields as described below:

Status Notes Enter any additional information on your current status.

As a convenience, the notes from the last time you selected this status
appear in Status Notes. You can make any necessary changes to these
notes.

Requirements: You need the Status Notes right in order to create or
modify Status Notes.

Until Date Do any of the following:
Until Time - Select the Until Date or Until Time check box to use the default date
and time.

Result: The current date appears in the Until Date field. The CIC
client automatically rounds the current time to the next half hour, and
sets that time in the Until Time field.

To change the Until Date, select the check box and click in the text
box. Select a date from the displayed calendar.

To change the Until Time, select the check box, and click the drop-
down list arrow to select a different time.

4. Click Configure Follow Me Numbers.

5. To prompt callers for their name, select the Screen Calls check box.

50



Call Coverage Options

6. In the Follow Me Numbers dialog box, click the Add button (plus sign).

7. Complete the fields as described below.

Number

Enter a telephone number you want the CIC client to call if you are not available.
Click the Validate button to check your phone number entry against the
requirements of the dial plan for your organization or region.

Dialing Pause

You can use both commas (,) and slashes (/) with the number. A comma causes a
two-second delay and numbers typed after the slash are dialed only after a
connection is made. For example, if you typed the number "555-1212 / 101, 2222",
the first seven digits are dialed. After a connection is made, the digits 101 are
dialed, and after two seconds, the digits 2222 are dialed.

Extension

Enter an extension number. This number is dialed after a connection is made.

Timeout

Specify the number of seconds the CIC client rings an external number. It defaults
to 15 seconds.

Use Pin

Select this check box to require that anyone who answers a follow-me router call to
enter your CIC client password to accept the call.

8. To add another number, repeat steps 4 and 5.

9. Click OK to save your settings and close the Follow Me Numbers dialog box.

To change your follow me settings:

1. Perform any of the following actions to update your follow me settings:

To change the order of your follow-me numbers, select a number and click up or down arrows
above the number list.

To delete a number, select a number and click the Remove button (red X).

2. Click the OK button to save your settings and close the Follow Me Numbers dialog box.

Related Topics

Understanding Follow-me Routing
Start Follow-Me Routing

Call Coverage Options

To change the settings for a number, double-click the number and type new values in the Number,
Extension, and Timeout text boxes and select or clear the Use Pin check box.
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Your CIC administrator can use Interaction Administrator to configure how the CIC client works. Contact your CIC
administrator if you have questions on how any of these options are set on your system.

Among the call coverage options that can be set by your CIC administrator are:
The internal number or CIC extension designated as your call coverage number.

Whether forwarded callers leave voice mail in the mailbox for the designated call coverage number or your
regular voice mailbox.

The types of calls that are forwarded to a designated call coverage number.
o All Calls.
0 Internal Calls. This includes calls from internal numbers or extensions on the CIC system.

0 External Calls. This includes calls from outside the CIC system (calls from public service telephone
networks).

0 Unknown Calls. This includes calls from outside the CIC system that do not have caller ID.

Whether calls are forwarded to a call coverage number when your status is Do Not Disturb (DND), including
not being logged onto the CIC client.

Whether calls are forwarded to a call coverage number when you are on the phone.

Whether calls are forwarded to a call coverage number when you do not answer.

About Personal Prompts

Personal prompts are messages you record which are played to people who call you. The specific prompt played
depends on your status. The default statuses are divided into two categories; DND (Do Not Disturb) and a form of
Available. Your CIC system administrator assigns these attributes to statuses in Interaction Administrator.

For example, if your status is DND (for example, At Lunch or Gone Home), then calls are automatically directed to
your voice mail. The call does not ring to your station. If you have recorded and activated an "Out of Office Message,"
then your "Out of Office Message" immediately plays to the caller. If you have not recorded an "Out of Office
Message," then the appropriate status message plays to the caller. The status message also plays if you have recorded
the "Out of Office Message" but have not activated it. If a status message is not recorded, the generic message is,
"<Your name> is not available. Please leave a message after the tone."

If your status is a form of Available (for example, Available, Forward), then interactions alert your queue. If you
recorded a "No Answer Message" and you do not answer an incoming call (the alert times-out), then your "No
Answer Message" plays to the caller. If you have not recorded this personal prompt, then the above-mentioned
generic message plays to the caller.

Click here for possible status values.

Related Topics

Set your status



Miscellaneous Configuration Options

Email Configuration

Email Configuration

Requirements: You need the Customize Client Security right to configure email pickup or reply options. Client

templates can contain configuration settings that determine your Emails configuration and control whether you can

alter configuration settings.

You can configure the default behavior of email messages in the Email Window for Incoming Messages and Email

Window for Outgoing Messages when you pick up or reply to an ACD-routed email message.

1. In the Email Window for Incoming Messages and Email Window for Outgoing Messages, click the Options

link.

Result: An Options popover appears in the email window.

Close original message window when replying or forwarding
Close compose window after message is sent

Show Cc field when composing a new message

Show Bec field when compeosing a new message

Wam when disconnecting an unsent email message

1 ,,?,‘.E Opfions -

2. Select any or all of the following options:

Close original message
window when replying or
forwarding

Select this option to close the Email Window for Incoming
Messages automatically when you select Reply or Forward to
open the Email Window for Outgoing Messages. This does not
disconnect or put on hold the original email message. The
original email message remains in My Interactions.

Clear this option to leave the Email Window for Incoming
Messages open while composing your reply or forwarded email
message. You must close this window manually when you finish
work with the interaction.

Close compose window after
message is sent

Select this option to close the Email Window for Outgoing
Messages when you send an email message or replay or
forward an email message.

Clear this option to enable you to close the Email Window for
Outgoing Messages manually.

Show Cc field when
composing a new message

Select this option to display the Cc (Carbon copy) field
automatically in the Email Window for Outgoing Messages.
Clear this option to hide the Cc field. You can display this field
as needed by selecting the Add Cc control in the Email Window
for Outgoing Messages.
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Show Bcc field when - Select this option to display the Bcc (Blind carbon copy) field
composing a new message automatically in the Email Window for Outgoing Messages.
Clear this option to hide the Bcc field. You can display this field

as needed by selecting the Add Bcc control in the Email Window
for Outgoing Messages.

Warn when disconnecting an - Select this option to receive a warning that an email message
unsent email message cannot be sent after it is disconnected.

Clear this option to avoid the warning message. However, if you
accidentally disconnect an email message, the message is not
saved in draft form and cannot be continued later. It is removed
from the queue.

3. To apply the changes and close the Options popover, click anywhere in the email window outside the popup
area.

Related Topics

Pick Up or Reopen an Email Message
Reply to an Email Message
Working with Email Messages

Views
Customizing the Interface
You can customize queue or directory views.
Add or Remove View Columns
Add or Close Views
Change View Order
Customize Columns
Display the Workgroup and Profile View

Move Views

Add or Remove View Columns

Requirements: The View Directory Status Columns Access Control right determines which Status columns you can
add to a directory view.

You can add or remove columns from any directory view.
To add or remove a column:
1. Click the Choose Columns control on the directory view.

Result: The Directory Columns dialog box appears.
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Add or Close Views

Choose Columns... x

Available Items Selected Items g

Standard . Logged On
Mame Last Mame
Company First Name
Business Phone Extension
Home Phone Departrent

Status Status
Status Motes
Until
Forward Mumber
On Phone
Time In Status
Status Summary

Other
Alias
Assistant o

o ) [cams

2. Do one of the following:

B

E

To add a column, select a column name in the Available Columns, then click > to move it to the
Selected Columns list.

To remove a column, click the name of a column in the Selected Columns list, then click < to move
it to the Available Columns list.

Click Reset to Defaults to restore the initial column settings for the currently selected directory
view.

3. Click OK.
Related Topics

Customize Columns
Working with the Company Directory
Working with Other Directories

Add or Close Views

Requirements: The View General Directories Access Control right determines which General Directories you can
display. If you have the Directory Administrator Security right, you can edit other user’s public directories. Certain
rights control which directory views you can display. For more information, see the View General Directories right
and the View Workgroups right.

You can configure which available directory views appear in the CIC client interface by adding or removing views. You
also control the order in which the views appear.

Tip: To display directories in a specific order, see Move Views.
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To add a directory view:
1. Click the New Tab button.
Result: A drop-down list of types of directories appears.
2. Click the appropriate directory type.
Result: The drop-down list expands to show the names of each directory in this type.
3. Click the name of the directory you want to display.
Result: The directory view appears in a new tab in the CIC client.
To close a directory view:
Click the Close button on a directory tab.
Related Topics

Customizing the Interface
Working with the Company Directory
Working with Other Directories

Customize Columns
Requirements: The Customize Client Security Right enables you to customize columns.

Any changes you make to the order and size of columns are persisted between logons to the same CIC server from
the same web browser. A horizontal scroll bar appears as needed if the total width of the columns exceeds the space
available in the browser window.

To reorder columns:
1. Click and hold on a column heading.
2. Drag it over the desired location.
3. Release the column heading.
To resize columns:
Drag the boundary on the right side of the column heading until the column is the width you want.
To sort a view:
Click on a column heading to sort the contents of a view.
Click on the same column heading to sort the contents in reverse order.
Related Topics

Add or Remove View Columns
Working with the Company Directory
Working with Other Directories

Move Views

You can rearrange the order of directory views with drag and drop.
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Working with Account and Wrap-Up Codes

To move directory views:
1. Click and hold the directory tab for the view you want to move.
Result: The tab moves where you point.

2. Without letting go of the mouse button, point to the directory tab occupying the position where you want to
move the view.

Result: A copy of the tab appears in the position to which the view will move.
3. Release the button to drop the view in its new location.
Result: The view moves to the selected tab position.
Related Topics

Add or Close Views

Working with Account and Wrap-Up Codes

Working with Account and Wrap-Up Codes
Requirements:
To display Account Code fields, you need the View Account Codes Access Control right.
To assign an Account Code to an interaction, you need the Account Code Verification Security right.

To see the Advanced Dialing Options dialog box, select Use Advanced Dialing on the Options
menu.

To display the Account code column in My Interactions or other queue view, you need the View Queue
Columns Access Control right.

To assign a Wrap-Up code, you must be a member of a workgroup for which Wrap-Up codes are
configured and active.
This section provides background information on account codes and Wrap-Up codes and how they are used in this
CIC client.
Related Topics

Advanced Dialing Options

Assign Codes to an Interaction

Assign Codes to an Incoming Interaction
Assign Codes to an Outgoing Interaction
Numerically Sort Account Codes
Understanding Account Codes
Understanding Wrap-Up Codes

Advanced Dialing Options

Advanced Dialing enables you to assign an Account Code and designate a workgroup for outgoing calls.

Configuration Requirements
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Your system must be appropriately configured in order for you to use Advanced Dialing Options. Also, your CIC
administrator must configure this feature in Interaction Administrator before it is available to you.

In Interaction Administrator, your CIC administrator:

Configures and enables Account Codes.

Grants you access to all or some of the configured Account Codes.
(Optionally) Enables Advanced Dialing Options on your CIC user account.
Assigns you to at least one ACD workgroup.

In the CIC client, you:

Select Use Advanced Dialing on the Options menu.

Using the Advanced Dialing Options Dialog Box

If Advanced Dialing Options are appropriately configured, the Advanced Dialing Options dialog box appears when
you start a call.

Advanced Dialing Options 4

Number 2222227 |
Account Code | [0] Test Code E”
Workgroup | [L2] ABC Corp. E”

Make Call || Cancel |

Here are some things to note about the Advanced Options dialog box:
The Account Code and Workgroup drop-down lists default to the last values used in this dialog box.

If Account Codes are enabled in Interaction Administrator and the Advanced Dialing Options dialog box
appears, an account code is required.

Your CIC administrator controls the order of the account codes in the Advanced Dialing Options dialog
box. The CIC client can sort account codes either by code (number) or description. For more information, see
Numerically Sort Account Codes.

A workgroup code enables you to associate an outbound call with your workgroup. Primarily used for
administrative and reporting purposes, this feature enables the call to count toward an agent’s and the
workgroup’s statistics. For more information, see Dial on Behalf of Workgroup.



Assign Codes to an Incoming Interaction

The Workgroup drop-down list contains the names of the ACD workgroups in which you are currently
active. For more information about setting your status to active, see Change Your Workgroup Activation
Status.

You can set the workgroup code to <None> for calls not made on behalf of a workgroup.
You can only associate a call with a workgroup at the time the call is started.
After you dial on behalf of a workgroup, you cannot associate the call with another workgroup.

Even if Advanced Dialing Options are appropriately configured, if you don't have access to account codes
and you deactivate your workgroup status, the Advanced Dialing Options dialog box doesn't appear.

If you enable Advanced Dialing Options and the CIC administrator enables single click dialing, you don't
have to confirm you want to dial selected number. The Advanced Dialing Options dialog box takes the place
of the Confirm Dial dialog box. Clicking Make Call in the Advanced Dialing Options dialog box is the same
as clicking Yes in the confirmation dialog box.

Related Topics

Assign Codes to an Outgoing Interaction
Calls Configuration

Assign Codes to an Incoming Interaction
Requirements: See Working with Account and Wrap-Up Codes.

You can assign Account codes and Wrap-Up codes in the Interaction Properties dialog box.
To assign an account code to an incoming interaction:
1. Select the incoming interaction and click the Pickup button, or pick up your telephone handset.
2. Click the Properties button.
Result: The Interaction Properties dialog box appears.

3. Inthe Interaction Properties dialog box, click the arrow at the end of the Account Code field and select the
account code you want to assign to this interaction.

4.  Optionally, if your CIC administrator configured Wrap-Up codes, you can assign a Wrap-Up Code in a
similar fashion.

5. Click the Close button in the upper right corner of the Interaction Properties dialog box.
Related Topics

Assign Codes to an Interaction
Understanding Account Codes
Understanding Wrap-Up Codes

Assign Codes to an Outgoing Interaction

Requirements: See Working with Account and Wrap-Up Codes.
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If your company uses account codes or tracks calls by workgroup, then you can be prompted to assign an account
code or ACD workgroup every time you make a call. Your system must be appropriately configured in order for you to
be prompted. For more information, see Advanced Dialing Options.

To assign an account code or a workgroup to an outgoing interaction:
1. Do one of the following:

Enter a telephone number in the Number field.

logoff MNewv Viewwy | Optionsv Helpv

Click the down arrow to the right of the Number field and select one of your recently dialed
numbers from the drop-down list.

2. Click the Make Call button or press Enter.

Result: The Advanced Dialing Options dialog box appears.

Advanced Dialing Options x

Number 2222232 |
Account Code | [0] Test Code E“
Workgroup | [12] ABC Corp. E"

Make Call || Cancel |

3. Click the arrows at the end of the Account Code or Workgroup Code drop-down lists and select the codes
you want to assign to this interaction and click OK.

Result: The call is started.

Tip: For more information, see Advanced Dialing Options.
You can use the Properties window to set an account code for any incoming or outgoing interaction. A workgroup
code can only be assigned when you start the interaction, not after it has started.
To assign an account code to an outgoing interaction using the Interaction Properties dialog box:

1. During an outgoing interaction, right-click the interaction and choose Properties from the menu that
appears.

Result: The Interaction Properties dialog box appears.
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2. In the Interaction Properties dialog box, click the arrow at the end of the Account Code field and select the
account code you want to assign to this interaction.

3. Optionally, if your CIC administrator configured Wrap-Up codes, you can assign a Wrap-Up Code in a
similar fashion.

4. Click the Close button in the upper right corner of the Interaction Properties dialog box.
Result: The account code you assigned to the interaction appears in the Account Code column of your queue.
Related Topics

Advanced Dialing Options
Understanding Account Codes
Understanding Wrap-Up Codes

Numerically Sort Account Codes

Your CIC administrator can configure whether your list of available account codes is sorted numerically. Contact your
CIC administrator if you have questions about how this option is set.

Related Topics

Understanding Account Codes

Understanding Account Codes
Requirements: See Working with Account and Wrap-Up Codes.

In the CIC client, you can use account codes to organize interactions by customer. You may find this feature useful for
customer billing purposes, or if you process interactions through Customer Interaction Center for more than one
company. Your system administrator can generate reports to categorize call details by account codes.

You can assign account codes to incoming and outgoing interactions or from any Interaction Object (such as calls,
email messages, or chat sessions).

Account Code Restrictions

When working with account codes, it is important to note the following restrictions:
You cannot split an interaction between account codes.
You can only assign one account code per interaction.

You cannot assign, change, or delete an account code after it disappears from your queue unless you have
permission to modify the queue to which the interaction transfers.

Account codes can be sorted numerically. When you type the first few numbers of the account code, the CIC
client jumps ahead to the first match, speeding up the process of selecting the appropriate code for your
interaction.

You can use the Interaction Properties Dialog Box to set an account code for any incoming or outgoing
interaction.

61



Interaction Client Web Edition Printable Help 2016 R4

You are prompted to assign account codes to outgoing interactions in the Advanced Dialing Options dialog
box only if your company uses account codes and your system is appropriately configured. For more
information, see Advanced Dialing Options.

Advanced Dialing Options

[

Number 2222222 |
Account Code | [0] Test Code E”
Warkgroup | [L2] ABC Corp. E”

Make Call || Cancel |

Related Topics

Working with Account and Wrap-Up Codes
Assign Codes to an Incoming Interaction
Assign Codes to Outgoing Interaction

Understanding Wrap-Up Codes

Your CIC administrator can associate Wrap-Up codes with any workgroup queue. Wrap-Up codes indicate the nature
of an interaction; for example, a billing problem, a new order, or a service request. Your CIC administrator can
generate reports to categorize call details by Wrap-Up codes.

You must be a member of a workgroup for which Wrap-Up codes are configured in order to assign a Wrap-Up code.
If you have questions about your Wrap-Up code permissions, contact your CIC system administrator.

If you take part in an interaction on a queue where Wrap-Up codes are configured and activated, you can enter a
Wrap-Up code during the interaction or wait to be prompted to enter a Wrap-Up code when you complete your part
of the interaction. A phone-only agent can enter the digits for the Wrap-Up code from the phone keypad after he or
she completes their part of the interaction. Your part of an interaction is ended when you disconnect, or transfer an
internal or external interaction to another person, park the interaction, or send it to voice mail.

You can also be prompted to enter a Wrap-Up code when an external call is brought into a conference call. The agent
who first answered the call is prompted for a Wrap-Up code when the external party disconnects or the agent
disconnects from the conference.

Assigning a Wrap-Up Code
The following rules apply to Wrap-Up codes:

You can assign Wrap-Up codes to all incoming interactions and to outgoing interactions that are dialed on
behalf of a workgroup.

You can assign or change a Wrap-Up code any time during an interaction.

If a Wrap-Up code is required and you have not already assigned one, you are prompted to assign a Wrap-
Up code after your part in the interaction ends.

You cannot assign, change, or delete a Wrap-Up code after the interaction disappears from your My
Interactions queue.

Wrap-Up codes do not have a default value. If you do not select one of the pre-defined Wrap-Up codes, no
code is assigned.
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Working with Callback Requests

Wrap-Up codes can be used for inbound email messages. Wrap-Up codes are not used for email message
replies or forwarded email messages.

Wrap-Up Code Prompt

If you do not assign a Wrap-Up code during an interaction on a queue configured for Wrap-Up codes, a dialog box
may appear to prompt you to enter a Wrap-Up code. An Interaction Administrator configuration setting controls
whether dialog box appears. Your administrator can also configure the length of time the dialog remains active before
automatically closing. However, this cannot exceed the amount of time disconnected interactions remain in My
Interactions. If you have questions about this feature, see your CIC administrator.

When you type the first few characters of the Wrap-Up code or name, the CIC client jumps ahead to the first
match, allowing you to select the appropriate Wrap-Up code quickly.

You cannot sort Wrap-Up codes by code or name; they are automatically sorted alphabetically by

description.
Please Assign a Wrap-Up Code |
Mame: loe Smith
Mumber (317) 696-0994
Workgroup: Safety Wardens

Interaction ID: 1066969562

Wrap-Up Code: lsen.rice Request "]

[ == ] g [Lox

Related Topics

Working with Account and Wrap-Up Codes

Working with Callback Requests

Working with Callback Requests

Using the Callback feature, visitors to your company’s website can leave a request for an agent to call them back. A
visitor starts the Callback process by clicking the appropriate button on a web page and completing information in a
Callback dialog box. Customer Interaction Center routes the request as a callback interaction and it appears in the
appropriate queue.

Callback Interaction

63



Interaction Client Web Edition Printable Help 2016 R4

Interaction Client web edition Logoff  MNeww Viewy | Optionsy Help ¥

My Interactions ta @™ a "' ﬁ | v Make Ca
177 From John Smith Marketing
®03:07 - ACD - Assigned: pax_user 1001579703
To Indianapolis IN at (317) 555-0994 Marketing
“a 3:00:21 - Connected 1001578705

When you pick up a callback request interaction, it appears in the Callback window.

When you pick up a callback request, its state changes to ACD Assigned: (Agent name), and other agents are
not able to respond to this request. However, if the callback request is transferred to you, or if you pick it up
even though you are a not a member of the workgroup to which it was routed, its state changes to
Connected.

When you make a call in response to a callback request, the new call is associated with the Callback request
as a child item. It is indented under the original callback request.

As with all interactions, a callback request remains in the workgroup queue unless a non-member of the
workgroup picks it up. If a non-member of the workgroup picks it up, it disappears from the workgroup
queue.

Related Topics

Callback Window
Respond to a Callback Request

Callback Window

The Callback window appears when you pick up a callback request.

Tip: If you prefer not to see the sidebar view, click the splitter bar to collapse that portion of the Callback window.

Respond to a Callback Request
Requirements: See Pickup.
To respond to a Callback request:

1. Double-click the Callback interaction, or select it and click the Pickup button.

Result: The Callback window opens.

Tip: If you prefer not to see the sidebar view, click the splitter (to the left of the Notes tab) to collapse that
portion of the Callback window.

2. Click the Make Call button to return the call.

Result: This creates a call that is associated with the callback request. For more information, see Callback
Interaction.

3. If prompted, in the Advanced Dialing Options dialog box, assign an Account Code to the call and click OK.
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Add Notes to an Interaction

4.  When the call is ended, in the Callback window, do any of the following:

Click Properties and assign an Account Code and Wrap-Up code for the callback request.

Click Add Note and add a note to the callback request.

5. In the Callback window, click one of the following buttons, depending on the result of your callback session:

Callback
Complete

Click this button to indicate you reached the requester and completed the callback
interaction.

Retry Later

The Retry Later button appears only if your CIC administrator has enabled this
feature. The CIC administrator also configures the maximum number of times agents
can retry a callback request.

Click this button to remove the callback request from your queue and place it back on
the workgroup queue in a "System" state. After the Snooze Time elapses, CIC transfers
the callback request back to the workgroup queue. After this transfer, server
parameters and handler customization can affect how the snoozed callback request is
reprocessed. For more information, contact your CIC Administrator.

Attempt Failed

Click this button to indicate that you cannot complete the callback request. It could be
that the phone number is incorrect or that no one answered after the last allowed
attempt.

Tip: If your CIC system is appropriately configured, you may be able to select a Wrap-
Up code that explains the reason for this failure.

6. Close the Callback window.

Related Topics

Assign Codes to an Interaction
Callbacks and the Current Interaction View

Manage Callback Requests

Add Notes to an Interaction

Use the Notes section in the appropriate interaction window to add notes or comments about the interaction.

Tip: For information about adding notes to a Call, see View and Edit Interaction Properties.

To add notes to an interaction:

1. In the Callback window, Chat window, Email window for Incoming Messages, or E-mail Window for Outgoing
Messages, expand the Notes sidebar.

2. In the text box, type your observations or comments and click Add Note.

Result: Your notes appear in the Notes sidebar in the interaction window.
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F Properties
* Motes

Userd - 1173072012 11:23 AM
Checked customer record.

Asked forlog | =
file. Add Note

w

F Response Management

Related Topics

Respond to a Callback Request
Manage a Chat Session
Working with Chat Sessions

Assign Codes to an Interaction

Requirements: See Working with Account and Wrap-Up Codes.

You can assign an Account Code or Wrap-Up Code to an interaction. The Account Code and Wrap-Up Codes drop-
down lists contain the codes defined in Interaction Administrator.

To assign codes to an interaction, do one of the following:

For an incoming email message, select the appropriate codes in the Email Window for Incoming
Messages.

For an outgoing email message, select the appropriate Account code in the E-mail Window for Outgoing
Messages.

When responding to a callback request, select the appropriate codes in the Callback Window.

During a chat session, select the appropriate codes in the Chat window.

Related Topics

Assign Codes to an Incoming Interaction
Assign Codes to an Outgoing Interaction
Email Editor

Email Preview

Email Window for Incoming Messages
Email Window for Outgoing Messages
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Use Response Management for an Incoming Interaction

Manage a Chat Session
Understanding Account Codes
Understanding Wrap-Up Codes

Use Response Management for an Incoming Interaction
Requirements: See Using Response Management for information about required rights.

When you respond to a callback request, you can use Response Management to look up information and then relay it
verbally. When you evaluate a callback request or read an ACD-routed email message, you can incorporate stored
text in the Notes section.

To use Response Management in an incoming interaction:
1. Do one of the following:
In the E-mail Window for Incoming Messages, expand the Responses section and search for an

appropriate system-wide response.

In the My Responses Window, use the Navigation Pane or other navigation aids to locate a
personal response or system-wide response.

Tip: For more information, see Search for a Response.

2. Do one of the following:

View the information in the response and use it indirectly when researching your reply to an email
message.

Copy and paste the information from the response to the Notes section of the E-mail window for
Incoming Messages.

Related Topics

Search for a Response
Use Response Management in an Email Message

Working with Calls
Working with Calls
The CIC client provides many ways to handle or manage calls. This section describes the following call features:
Making Calls
Picking Up Calls
Transferring Calls
Forwarding Calls
Making Conference Calls

Using Other Call Features
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Call Security

Customer Interaction Center provides call security that prevents others from listening in on a call or even determining
which internal parties are involved in a conversation.

CIC administrators can configure the use of two encryption protocols to support encryption of call audio (SRTP) and
call control information (TLS). This provides confidentiality and flexibility for security-sensitive organizations. Your CIC
administrator can use Interaction Administrator to configure your station to use SRTP for all your calls. When SRTP is
not configured for a station, the calls are “non-encrypted” or not secure from network interception.

Call Security Icons and Alerts

When the CIC administrator configures your station to request that all calls are secure or if you are involved in a call
where one of the parties has requested a secure call, the CIC client monitors a call’s security level to determine if it is
secure and remains secure. A call can begin as a secure (SRTP) call and later be downgraded to a non-secure state.
This can occur if the secure call is transferred to, or made part of a conference with, a non-secure party.

Secure calls

&

A closed lock icon indicates that a call is secure within the environment controlled by CIC. It appears only if
your station is configured to have secure calls and end-to-edge security

A call can be comprised of multiple audio legs. When your station is configured to have secure calls (SRTP is
configured in Interaction Administrator), the call is encrypted/secured as far as possible (e.g., within the
environment controlled by CIC). If all the audio legs of the call are secure to the edge of network (to another
SRTP phone or to an SRTP gateway) then the closed lock icon appears, indicating a secure call. The lock does
not display on an RTP station since the RTP station always has at least one non-secure audio leg (the RTP leg
to the phone itself).

£ Interaction Client web edition Logoff MNewvy Viewy Optionsv Help¥
My Interactions tal [ a I!! ‘. | v| | Make Call |
? To Dan Mann at 3333
" 00042 - Cornected (3 1001601767

Non-secure calls

@

An open lock icon indicates that at least one leg of a call is not secure. It appears only if your station is
configured to have secure calls and end-to-edge security.

If your station is configured to have secure calls (SRTP is configured in Interaction Administrator), but the call
cannot be made completely secure from the station to the destination (e.g., only one leg of the call is secure),
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and the station security level is configured for end-to-edge security, then the open lock icon appears. This
means that security has been downgraded because some portion of the call cannot be encrypted, or secured.
The open lock does not imply someone is listening to a call, but only that part of the call cannot be secured to
prevent it from being intercepted. The open lock does not display on an RTP station, or on an SRTP station
that has its security level configured as minimal. The open lock displays only on an SRTP station that has its

security level configured as end-to-edge.

A Security Alert dialog box can also appear to alert you that the previously secure call is no longer secure.

Tip: For more information about why the call is no longer secure, click Show Details >>.

Call to Indianapolis IN is proceeding without audio security.

Don't show this dialog again Show Details » > ] [

Related Topics

Calls Configuration

Making Calls

Maki

ng Calls

There are a number of ways to make a call in the CIC client. You can enter a number in the Number field, use your

telephone, double-click a directory entry, or use the directory toolbar after selecting a directory entry.

The call appears in My Interactions, where you can watch the status of the call. For more information, see one of the
following topics:

§

w W W W W W W W

Advanced Dialing Options

Call an Operator

Click to Dial a Directory Contact

Call Back a Disconnected Call

Dial a Long-Distance Number

Dial a Number Inside the Organization
Dial a Number Outside the Organization
Dial a Number Using Speed Dial

Dial a Recently Dialed Number
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Dial on Behalf of a Workgroup
Disconnect a Call

Entering Telephone Numbers

Make a Call Using the Dial Button
Make a Call Using the Number Field

Using Call History to Make Calls

w w W W W W W

Using the Dial Pad

Call an Operator

You can use the CIC client to call an operator within your company, or to call an external telephone operator.
To call an internal operator:
Type 0 or the internal operator number in the Number text box and click Make Call.

To call an external (phone company) operator:

Type 00 or the external operator number in the Number text and click Make Call.

Related Topics

Making Calls

Call Back a Disconnected Call
The Call Back option enables you to call back to the phone number for a disconnected call in My Interactions.

To call back a disconnected call:
Double-click the disconnected call.

Result: The Call Back option dials the number of the selected call if the number is valid.
Related Topics

Dial a Recently Dialed Number
Making Calls

Click to Dial a Directory Contact

You can click any of the phone number hyperlinks in the CIC client to dial a contact. Phone number hyperlinks appear
in directory views and in the contact Properties dialog box.

If Auto Dial Extension is enabled for a contact’s phone number, the CIC client automatically dials the extension after
the call connects.



Dial a Long-Distance Number

Company Directory x | IC Private Contacts x

Last Name Al | First Mame A2 | Company | Business Phone | |
Weather 3171 222-2222@
Jones Joe (317) 555-2111@
Jones Pat (317 696-9900@
Viewing items 1 -3 of 3 | Choose Columns.. Add Entry.. M 4 Pagelofl b K
. Ay
g . €8 » - ™ B B & O
Dial Email Chat Transfer Vioicema Park Camp Status Properties

& Indyhgicl ¥ NoreenTasker

You can also dial a phone number and extension by clicking the corresponding Dial button in the Properties dialog
box.

Properties For Joe Jones X

General | Business | More Business | Home | Notes |
First Name Joe |
Last Name |Jones |
Display Name | |
Company | |
Home Phone |(317) 535-2134 | Ext| | | iat |

Auto Dial Extension

Business Phone |(317) 555-2090 | Ext| | |iai

Auto Dial Extension

Mabile | | Ext| | [ Dia

Auto Dial Extension

[ Save ] [ Cancel

Related Topics

Making Calls
View and Edit Directory Entries

Dial a Long-Distance Number
Requirements: You need the necessary call privileges to make long-distance calls. Your CIC administrator controls

whether you are able to dial long-distance numbers. Also, your CIC administrator may assign you the Require Forced
Authorization Code Security right. This right requires you to enter an authorization code before toll numbers can be
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dialed from your station. This prevents someone from using your phone to make a toll call while you are logged on,
but away from your desk.

Dial long-distance numbers just as you would dial a number outside your organization. Include the area code.

If you have problems, ask your CIC administrator if you should prefix outgoing calls with a nine or one. Also confirm
that you have the necessary call privileges.

Related Topics

Dial a Number Inside the Organization
Dial a Number Outside the Organization
Make a Call Using the Number Field

Dial a Number Inside the Organization

You can use the CIC client to dial the extension of someone within your organization. The extension for a user is listed
in the Company Directory. You can watch the status of the call in My Interactions.

To dial a number inside the organization:

1. Find the extension you want to call in the directory.

Tip: To locate an entry, start typing in the filter boxes. Enter the first few letters of an entry (if it's an
alphabetical column), or enter the first few numbers of an entry (if it's a numerical column). For more
information, see Working with the Company Directory.
2. Do one of the following:
Double-click a row in the directory list to dial the default number for that person.
Single-click any of the hyper-linked phone numbers displayed in the row.

Select a directory entry and click the Dial button to dial the default number.

Select a directory entry and click the arrow on the Dial button. Click one of the displayed "Dial"
entries.

i Robert
W Mick

& Extension
@ Business Phone
3 Mobile Phone

%. Fax 1

-

Dial

Related Topics

Dial a Long-Distance Number

Dial a Number Outside the Organization
Dial Button

Make a Call Using the Number Field
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Dial a Number Outside the Organization

Dial a Number Outside the Organization

You can watch the status of your call in My Interactions. Check with your CIC administrator to see if you have

sufficient privileges to make toll calls.

To dial a number outside the organization:

Type a number in the Number text box and click Make Call.

Tip: For more information, see Entering Telephone Numbers.

Related Topics

Dial a Long-Distance Number

Dial a Number Inside the Organization

Dial a Number Using Speed Dial

Make a Call Using the Number Field

Dial a Recently Dialed Number

To dial a recently dialed number, do one of the following:

Click the down arrow to the right of the Number field and select a recently dialed number from the drop-

down list, then click Make Call.

logoff Newvy Viewwy Optionsv

2222222 - Unknown

TIT7 - Took, Maora

4444 - Hood, Debbi

8888 - Lync, Priscilla

1(303) 555-?586@ - Lakewcod CO
1(765) 555-8284@ - Kevin Kohn

111 - System
(317 555-0100:@ - Carmel IN
(317 555-1121@ - Indianapaolis IM

-

Help »

In the Call History dialog box, click a phone number hyperlink.

Double-click a disconnected call in My Interactions.

Related Topics

Call History
Making Calls

Dial on Behalf of a Workgroup
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Designating a workgroup when you make a call enables you to associate an outbound call with your workgroup.
Primarily used for administrative and reporting purposes, this Dial on Behalf of a Workgroup feature enables the
call to count towards an agent’s and the workgroup’s statistics.

If you or your CIC administrator enables Advanced Dialing Options and you are a member of at least one workgroup
or have at least one account code to select, the Advanced Dialing Options dialog box appears every time you start a
call and prompts you to assign the appropriate Account Code and/or designate a Workgroup.

Advanced Dialing Options

Number 2222227 |
Account Code | [0] Test Code E”
Workgroup | [L2] ABC Corp. E”

Make Call || Cancel |

Related Topics

Making Calls

Disconnect a Call
Requirements: See Disconnect.
To disconnect a call, do one of the following:
Using your handset, simply hang up the telephone.
Select the call you want to disconnect and click the Disconnect button.

Related Topics

Disconnect Button

Entering Telephone Numbers

Here are some pointers on entering telephone numbers:
You do not have to type parentheses or other special characters.

You can also type letters that are translated into the corresponding numbers from a telephone keypad. For
example, Q is a seven and Z is a nine.

You can type both commas (,) and slashes (/) with the number you type. A comma causes a two-second delay.
Numbers typed after the slash are dialed only after a connection is made.

For example, if you type the number 555-1212 / 101, 2222, the first seven digits are dialed. After a
connection is made, the digits 101 are dialed, and after two seconds, the digits 2222 are dialed.



Make a Call Using the Dial Button

Related Topics

Dial a Number Outside the Organization

Make a Call Using the Dial Button
You can make a call by selecting a directory entry and clicking the Dial button.

Or, if you want to make a call without using the CIC client, simply dial the number from your telephone. The call
appears in My Interactions where you can watch the status of the call.

To make a call:
Select an entry in the Company Directory and then click the Dial button on the Directory toolbar.
Result: This dials the default number for the selected entry.

Select an entry in the Company Directory and then click the arrow on the Dial button. Click one of the
displayed "Dial" entries to dial the associated number.

w  Robert
¥ Nick

a Mo

E Extension
& Business Phone
3 Mobile Phane

& Fax

e

Dial

Related Topics

Dial Button

Make a Call Using the Number Field

You can make a call from the CIC client by typing the phone number from your computer keyboard instead of dialing
it on your telephone. If you want to make a call without using the CIC client, simply dial the number from your
telephone. The call appears in My Interactions where you can watch its status.

To make a call:
1. Do one of the following:

Enter a telephone number in the Number field.

logoff Mewv Vieww | Optionsv Help~

B [s55-1234 v|| Make ca
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Click the down arrow to the right of the Number field and select one of your recently dialed
numbers from the drop-down list.

logoff MNewv Viewy Optionsv Help

!"f ‘ | ‘l’|| Make Ca

2222222 - Unknown -
TIT7 - Took, Maora =
4444 - Hood, Debbi

8888 - Lync, Priscilla

1(303) 555-?586@ - Lakewcod CO
1 (765) 555-8284@ - Kevin Kohn
111 - System

(317) 555-010[)@ - Carmel IN

(317) 555-1121(@ - Indianapolis IN

-

2. Click the Make Call button or press Enter and one of the following happens:

If you are using Advanced Dialing Options and you need to assign an Account Code and/or a
Workgroup, the Advanced Dialing Options dialog box appears. Select the appropriate Account
Code and Workgroup name from the drop-down lists and then click Make Call to place the call.

Advanced Dialing Options x

Number 2222222 |
Account Code | [0] Test Code E”
Warkgroup | [12] ABC Corp. E”

Make Call || cCancel |

If you do not need to assign an Account Code, click Make Call or press the Enter button on your
keyboard to place the call.

Related Topics

Dial a Long-Distance Number

Dial a Number Inside the Organization
Dial a Number Outside the Organization
Dial a Number Using Speed Dial

Dial a Recently-Dialed Number

Place a Call on Hold

You can place any connected call on hold. Depending on the hold behavior your CIC administrator configures, callers
on hold hear a combination of music and messages. If on-hold music is enabled (the default behavior), you can
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eliminate on-hold music by clicking the Mute button. This is particularly important when you are a party in a
conference call hosted by someone who is not on your IC server and wish to put the call on hold without disrupting
the call with hold music. By default, Conference calls hosted on your local IC server do not play on-hold music when a
conference party clicks the Hold button.

To place a call on hold:

1. If the call is not already selected, click the call to select it.
2. Click the Hold button.
Result: The Hold button appears pressed and the call’s state changes to Held.

3. To suppress on-hold music for the other party (or parties in a remote server hosted conference), click the
Mute button before or after clicking the Hold button.

4. To take the call off hold, select the call and click Hold again.

Result: The Hold button is no longer selected and the call’s state changes to Connected.

Tip: Your CIC administrator can configure a maximum hold time for interactions. By default, interactions on hold for
longer than fifteen minutes are disconnected. Your administrator can change the amount of time an interaction can
remain on hold and the behavior that occurs once the hold time is exceeded. For example, your administrator may
choose to transfer interactions on hold longer than twenty minutes to another queue. For more information, see your
CIC administrator.

Related Topics

Hold Button

Understanding an Interaction’s State

An interaction’s state describes its current condition. The following list describes the states that appear by default. The
list includes descriptions of each state an interaction may be in during the life of the interaction.
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Picking Up Calls
Requirements: See Pickup.

There are many different ways to pick up calls in the CIC client. This section describes the following methods:
Answer an Incoming Interaction
Caller Name
Place a Call on Hold

Related Topics

Answer an Incoming Interaction

These instructions assume that you are answering an interaction in My Interactions.

The CIC client can notify you of incoming interactions by:

Ringing your telephone (if your CIC administrator has configured calls to ring on your desktop telephone).
Emitting a ring through your computer’s speakers.

Appearing on top of any applications you are working on.

Automatically selecting an interaction.

To pick up your call:

If you are not connected to another call, do one of the following:

Pick up your telephone handset and the call automatically connects, and you can begin speaking.
Click the Pickup button on the Queue Control toolbar.
Double-click the interaction in the My Interactions view.

If you are currently connected to another call, click the Pickup button.

Result: This action connects you to the call and places on hold any other calls to which you are connected.

Caller Name

Customer Interaction Center (CIC) uses several different methods to identify a caller. If CIC cannot automatically
determine the name of the caller and handlers or other applications do not identify the caller or provide something to
be displayed instead of a caller name, CIC displays a locally defined phrase such as "Unknown Caller."

CIC uses these methods in the following order to identify a caller.
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1. Caller name provided by the PSTN, SIP signaling, or Web Interaction registration information.

2. Caller name located by an RWP (Reverse White Pages) lookup using the caller’s telephone number to locate
a name in the RWP database.

Result: If no name is found and the origin of the call can be determined, the City and State of the call are used
as the caller name.

3. Caller name located by an RWP lookup in the Company Directory or a Personal Directory (such as Outlook
Private Contacts.)

4. Caller name located by a telephone number lookup in Interaction Tracker.

5. Alocally defined phrase such as "Unknown Caller."

6. A value provided by CIC handlers as part of customer customization.

For example, information gathered from an IVR menu selection such as a product catalog name could be used
as the caller name.

Pick Up a Call from Voice Mail
Requirements: See Pickup.
You can pick up a call when the caller is in the middle of leaving a voice mail message. When a call is transferred to
voice malil, its state changes to "Voice Mail."
To pick up a call from voice mail:

1. If the telephone call is not selected, select the call you want to pick up.

2. Click the Pickup button.

Result: The call’s state changes from "Voice Mail" to "Connected" and you can begin speaking with the caller.

Related Topics

Listen to someone leave a voice mail message
Listen to your voice mail
Pickup Button

Place a Call on Hold

You can place any connected call on hold. Depending on the hold behavior your CIC administrator configures, callers
on hold hear a combination of music and messages. If on-hold music is enabled (the default behavior), you can
eliminate on-hold music by clicking the Mute button. This is particularly important when you are a party in a
conference call hosted by someone who is not on your IC server and wish to put the call on hold without disrupting
the call with hold music. By default, Conference calls hosted on your local IC server do not play on-hold music when a
conference party clicks the Hold button.
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To place a call on hold:

1. If the call is not already selected, click the call to select it.
2. Click the Hold button.
Result: The Hold button appears pressed and the call’s state changes to Held.

3. To suppress on-hold music for the other party (or parties in a remote server hosted conference), click the
Mute button before or after clicking the Hold button.

4. To take the call off hold, select the call and click Hold again.

Result: The Hold button is no longer selected and the call’s state changes to Connected.

Tip: Your CIC administrator can configure a maximum hold time for interactions. By default, interactions on hold for
longer than fifteen minutes are disconnected. Your administrator can change the amount of time an interaction can
remain on hold and the behavior that occurs once the hold time is exceeded. For example, your administrator may
choose to transfer interactions on hold longer than twenty minutes to another queue. For more information, see your
CIC administrator.

Related Topics

Hold Button

Transferring Calls

Transferring Calls

There are many different ways to transfer calls in the CIC client. This section describes the following methods:
Park a Call on Another Person’s Extension
Transfer a Call After Consulting the Recipient
Transfer a Call to a Directory Entry
Transfer a Call to a Workgroup
Transfer a Call to an Attendant Profile
Transfer a Call to Another Person’s Voicemail
Transfer a Call to Your Voicemail
Transfer a Call Using a Transfer Button
Transfer a Call Using the Queue Control Toolbar
Transfer a Call Using the Directory Toolbar

Transfer a Call Without Consulting the Recipient

Park a Call on Another Person’s Extension

You can park a call directly on another CIC client user’s extension. This places the call on hold on the recipient’'s My
Interactions queue. You might want to use this feature, for example, if a caller wants to speak to another person who
is currently unable to take a call, but will probably be available in a few minutes.
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Call Parking Tips

Your CIC administrator can set up calls to automatically transfer to another extension after being parked for
a certain length of time. For more information, see your CIC administrator.

If you park a call on a phone-only station (standalone phone), the CIC user is not alerted when a call is
parked on that extension.

To park a call using the Park on Queue button:

Select the call. Select a directory entry and then, on the Directory toolbar, click the Park on Queue button.

Result: The interaction is immediately removed from My Interactions or any other queue you are monitoring
and appears in the selected user’s queue.

To park a call on another person’s extension using the Transfer dialog box:

1

2.

Select the call and inform the caller that he or she is going to be transferred and put on hold.
On the Queue Control toolbar, click the Transfer button.

Result: The Transfer dialog box appears.
In the Transfer To: field, type all or part of the recipient’s name or number.

Result: A drop-down list of choices appears.

Tip: If the drop-down list does not contain the contact you expected, check the search criteria selected in the
Options drop-down list and adjust them if necessary.
From the drop-down list, do one of the following:
Select "Dial [your entry] as Digits" to convert a text entry into numbers.
Select the appropriate contact name and associated extension or phone number.

Result: If the designated transfer recipient is a CIC user, status information appears. It shows whether the
transfer recipient is logged onto the CIC client and is able to accept the transferred call. This can help you
decide what kind of call transfer to use.

Click the Park button.

Result: The call disappears from My Interactions and is placed on hold in the recipient’'s My Interactions so
the recipient can select it later. Until the recipient picks up the call, callers hear the company’s hold message.

appears. It shows whether the transfer recipient is logged onto the CIC client and is able to accept the
transferred call. This can help you decide what kind of call transfer to use.

Related Topics

Call Coverage Options

Set Status Details

Transfer a Call to a Directory Entry

Transfer a Call to a Workgroup

Transfer a Call to Another Person’s Voicemail
Transfer Button

Transfer a Call After Consulting the Recipient
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Transferring an interaction after speaking with the intended recipient is called a consult transfer. If the intended
recipient does not answer the phone, you can resume your conversation with the caller, park the call on the intended
recipient’s extension, transfer the call to the intended recipient’s voice mail, or try transferring to another person.

Warning: Perform a consult transfer only when you need to speak with both parties before completing the transfer. If
this is not necessary, perform a blind transfer. Do not use a consult transfer or a conference call to transfer a call to
an attendant profile, workgroup queue, or to an agent's voice mail. These are not supported features and may result
in the original call being sent to the default attendant profile. For more information about blind transfers, see Transfer
a Call Without Consulting the Recipient.

To perform a consult transfer:

1.  While the call is selected in My Interactions, inform the caller that he or she is going to be transferred.
2. On the Queue Control toolbar, click the Transfer button.
Result: The Transfer dialog box appears.
3. Inthe Transfer To: field, type all or part of the recipient’s name or number.
Result: A drop-down list of choices appears.
Tip: If the drop-down list does not contain the contact you expected, check the search criteria selected in the
Options drop-down list and adjust them if necessary.
4. From the drop-down list, do one of the following:
Select "Dial [your entry] as Digits" to convert a text entry into numbers.
Select the appropriate contact name and associated extension or phone number.

Result: If the intended recipient is a CIC user, status information for the selected CIC user appears. It shows
whether the transfer recipient is logged onto a CIC Client and is able to accept the transferred call. This can
help you decide what kind of call transfer to use.

5. Click the Consult button. This enables you to speak with the transfer recipient while your original caller stays
on hold.

Result: The Consult Call dialog box appears. Notice that the name of the transfer recipient is selected. If the
status of the call is "Connected,” you can talk to that party.

Transfer: From Joe Smith at (317} 690-0000

Consult Call

Speaking with:
From Joe Smith at (317) 620-0000
T 0:00:27 - Held

To Bishop, Leo at BB88
“y 0:00:11 - Connected

Transfer H Cancel

6. Do one of the following:
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If the intended recipient answers his or her phone, and agrees to the transfer, click Transfer.
Result: The call is transferred to the intended recipient and disappears from My Interactions.

To speak to the caller without exiting the transfer operation, click the name of the caller.

If the transfer recipient does not answer the phone or does not agree to the transfer, click Cancel.

Result: The Consult Call dialog box closes and the Transfer dialog box reappears. The call is taken off
hold, and you are reconnected to it.

Tip: If for some reason you can't perform a consult transfer, you can use the Transfer dialog box to choose
another way to handle this call. You can transfer a call to another person’s voicemail, park a call on another
person’s extension, or transfer a call without consulting the recipient.

Related Topics

Call Coverage Options

Park a Call on Another Person’s Extension

Set Status Details

Transfer a Call to a Directory Entry

Transfer a Call to a Workgroup

Transfer a Call to Another Person’s Voicemail
Transfer a Call to Your Voicemail

Transfer a Call Using a Transfer Button

Transfer a Call Without Consulting the Recipient
Transfer Button

Transfer a Call to a Directory Entry

You can transfer a call to a selected directory entry.

To transfer a call:
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2
3.
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While the call is selected in My Interactions, inform the caller that he or she is going to be transferred.
Click the Hold button.
Locate and select the directory entry to which you want to transfer the call.
Do one of the following:
In the Directory toolbar, click the Transfer button.
Result: This transfers the call to the default number for the selected entry.

In the Directory toolbar, click the arrow on the Transfer button and then click one of the displayed
"Transfer" entries to dial the associated number.

Result: This transfers the call to the selected number for the selected entry.



Transfer a Call to a Workgroup

= Extension
Sy Business Phone
= Mobile Phone

* Fax
D [.[| Pn
Transfer Vaoicemail

Related Topics

Transfer a Call Using a Transfer Button
Transfer a Call Using the Directory Toolbar
Transfer Button

Transfer a Call to a Workgroup

Requirements: You need the Search Workgroup Queues Access Control right to a specific workgroup queue in
order to transfer an interaction to that workgroup queue.

You can transfer a call directly to a workgroup listed in the Workgroup and Profile directory. This type of call transfer
is similar to a blind transfer because you do not speak to the transfer recipient. My Interactionsqueue

The CIC administrator creates workgroups in Interaction Administrator. Workgroups are logical groups of users (e.g.,
departments) that can function as a group in the CIC system. Workgroups can have extensions and queues that
enable all members of a workgroup to receive calls notifying the workgroup. In addition, workgroups can receive
regular calls and ACD calls that are routed to specific workgroups and agents. Workgroups can also serve as
distribution lists (to the members) of voice mail, email messages, and faxes from within CIC.

To transfer a call to a workgroup:
1. Inform the caller that he or she is going to be transferred.
2. On the Queue Control toolbar, click the Transfer button.
Result: The Transfer dialog box appears.
3. Inthe Transfer To: text box, type all or part of the Workgroup’s name or number.

Result: A drop-down list of choices appears.

Tip: If the drop-down list does not contain the workgroup you expected, check the search criteria selected in
the Options drop-down list and make sure Workgroups is selected.

4.  From the Transfer To drop-down list, do one of the following:
Select the appropriate workgroup name and associated extension number.
Select "Dial [your entry] as Digits" to convert a text entry into numbers.

5. Click the Transfer button.
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Result: The transferred call disappears from My Interactions or other queue and is routed to the selected CIC
Workgroup.

Using the Workgroups and Profiles Directory to Transfer a Call

To transfer a call to a Workgroup in the Workgroups and Profiles directory:
1. Tell the caller that he or she is going to be transferred.
2. Select a workgroup name in the Workgroups and Profiles directory view and then click the Transfer button.

Result: The call disappears from My Interactions and is transferred to the appropriate Workgroup queue.

Tip: For information about displaying the Workgroups and Profiles view, see Add or Close Views.

Related Topics

My Interactions
Transferring Calls

Transfer a Call to an Attendant Profile

Requirements: You need the E-mail Profiles, Inbound Profiles, Operator Profiles, or Outgoing Profiles rights to
transfer a call to an Attendant Profile.

You can transfer a call directly to an Attendant profile selected in the Transfer dialog box or to an Attendant Profile
listed in the Workgroup and Profile directory. This enables you to send calls into queues using Attendant, ensuring
that both inbound callers and callers transferred into a queue have the same in-queue experience.

For example, if there are customer service menus in Interaction Attendant that a customer must navigate before a call
is sent to that workgroup’s queue, you can transfer callers to the Customer Service Profile rather than directly into the
queue. The transferred call is processed according to the profile’s settings. This way, callers hear the same prompts
and menus as other callers for that group.

Transferring a Call to an Interaction Attendant Profile

1. Inform the caller that he or she is going to be transferred.
2. On the Queue Control toolbar, click the Transfer button.
Result: The Transfer dialog box appears.
3. Inthe Transfer To: field, type all or part of the Attendant Profile’s name.

Result: A drop-down list of choices appears.

Tip: If the drop-down list does not contain the Attendant Profile you expected, check the search criteria
selected in the Options drop-down list and make sure Attendant Profiles is selected. Remember also that
you can transfer calls only to inbound call profiles that are configured in Interaction Attendant to allow calls
to be transferred to them.

4.  From the Transfer To drop-down list, select the name of the profile.
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5. Click the Transfer button.

Warning: Do not attempt a Consult Transfer. Using Consult to transfer a call to an attendant profile is not a
supported feature. This may result in the original caller being sent to the default attendant profile, the main
IVR menu, rather than the selected profile.

Result: The transferred call disappears from My Interactions or other queue and is routed to the selected
Interaction Attendant Profile where it is processed like any other call routed to that Attendant Profile.

Using the Workgroups and Profiles Directory to Transfer a Call

This type of call transfer is similar to a blind transfer because you do not speak to the transfer recipient. This
procedure assumes you are transferring calls from My Interactions, but you can transfer calls from any queue you are
monitoring.

To transfer a call to an Attendant Profile:
1. Tell the caller that he or she is going to be transferred.

2. Select an Attendant profile name in the Workgroups and Profiles directory view and then click the Transfer
button.

Result: The call disappears from My Interactions and is processed according to the settings on the Attendant
profile.

Related Topics

Introduction to Queues
My Interactions
Transferring Calls

Transfer a Call to Another Person’s Voice Mail

You can transfer a call directly to another CIC client user’s voice mail. You might want to use this feature if the caller
wants to communicate with another person who is unavailable to take the call.

To transfer a call to another person’s voice mail using a directory:

1.  While the call is selected in My Interactions, inform the caller that he or she is going to be transferred to
another person’s voice mail.

2. Locate and select the directory entry to which you want to transfer the call.
3. On the Directory toolbar, click the Voicemail button.

Result: The call is transferred to the recipient’s voice mail and its status changes to Disconnected in My
Interactions.

To transfer a call to another person’s voice mail using the Transfer dialog box:

1. Select the call and inform the caller that he or she is going to be transferred to another person’s voice mail.
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2. On the Queue Control toolbar, click the Transfer button.
Result: The Transfer dialog box appears.
3. Inthe Transfer To: field, type all or part of the recipient’s name or number.

Result: A >drop-down list of choices appears.

Tip: If the drop-down list does not contain the contact you expected, check the search criteria selected in the
Options drop-down list and adjust them if necessary.
4. From the drop-down list, do one of the following:
Select "Dial [your entry] as Digits" to convert a text entry into numbers.
Select the appropriate contact name and associated extension or phone number.

Result: If the designated transfer recipient is a CIC user, status information appears. It shows whether the
transfer recipient is logged onto a CIC client and is able to accept the transferred call. This can help you decide
what kind of call transfer to use.

5. Click the Voice Mail button.

Result: The call is transferred to the recipient’s voice mail and its status changes to Disconnected in My
Interactions.

Related Topics

Transfer a Call After Consulting the Recipient
Transfer a Call Using a Transfer Button

Transfer a Call Without Consulting the Recipient
Transfer Button

Voicemail Button

Transfer a Call to Your Voice Mail

Rather than answer an incoming (alerting) call, you can transfer it to your voice mail. You can also send a call to which
you are connected to your voice mail.

To transfer a call to your voice mail:
Select the call, if it is not already selected, then on the Queue Control toolbar, click the Voicemail button.

Result: The call is transferred to your voice mail. When a caller has finished leaving a message, the voice mail
is saved as a file, attached to an email message and sent to you. You can also listen in on the call as the caller
leaves a message, and then decide whether or not to pick up that call from voice mail.

Related Topics

Transfer a Call to Another Person’s Voice Mail
Voicemail Button

Transfer a Call Using a Transfer Button

In the CIC client, you can transfer a connected call or other interaction by using the Transfer button on the Queue
Control toolbar or the Directory toolbar.

For more information, see:

88



Transfer a Call Using the Queue Control Toolbar

Transfer a Call Using the Queue Control toolbar
Transfer a Call Using the Directory Toolbar

Transfer a Call to a Directory Entry

Related Topics

Park a Call on Another Person’s Extension
Transfer a Call After Consulting the Recipient
Transfer a Call to a Directory Entry

Transfer a Call to a Workgroup

Transfer a Call to Another Person’s Voicemail
Transfer a Call to Your Voice Mail

Transfer a Call Without Consulting the Recipient

Transfer a Call Using the Queue Control Toolbar

You can transfer the currently selected interaction by using the Transfer button on the Queue Control toolbar.

To transfer a call using the Transfer button:

1
2.

5.

Inform the caller that he or she is going to be transferred.
On the Queue Control toolbar, click the Transfer button.
Result: The Transfer dialog box appears.
In the Transfer To: text box, type all of part of the recipient’s name or number.

Result: A drop-down list of choices appears.

Tip: If the drop-down list does not contain the recipient you expected, check the search criteria selected in the
Options drop-down list and adjust them if necessary.

From the drop-down list, do one of the following:
Select "Dial [your entry] as Digits" to convert a text entry into numbers.
Select the appropriate name and associated extension number.

Result: If the intended recipient is a CIC user, status information for the selected CIC user appears. It shows
whether the transfer recipient is logged onto a CIC client and is able to accept the transferred call. This can
help you decide what kind of call transfer to use.

Do one of the following:
To transfer the call without consulting the recipient, click the Transfer button.

To speak with the transfer recipient before transferring the call, click the Consult button. For more
information, see Transfer a Call After Consulting the Recipient.

To send the call to the intended recipient’s voice mail, click the Voice Mail button. You can send a
call to another person’s voice mail only if that person is another CIC client user. For more
information, see Transfer a Call to Another Person’s Voicemail.

To park the call on the intended recipient’s extension until the recipient becomes available, click the
Park button. This places the call in the recipient’s My Interactions queue so the recipient can select
it later. You can park a call on a person’s extension only if that person is another CIC client user. For
more information, see Park a Call on Another Person’s Extension.
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Result: The transferred call disappears from My Interactions and is routed to the selected recipient.
Related Topics

Call Coverage Options

Set Status Details

Transfer a Call Using the Directory Toolbar
Transfer a Call to a Directory Entry

Transfer a Call Using the Directory Toolbar

To transfer a call using the Transfer button:
1.  While the call is selected in My Interactions, inform the caller that he or she is going to be transferred.
2. Click the Hold button.
3. Locate and select the directory entry to which you want to transfer the call.
4. Do one of two things:
In the Directory toolbar, click the Transfer button.
Result: This transfers the call to the default number for the selected entry.

In the Directory toolbar, click the arrow on the Transfer button and then click one of the displayed
"Transfer" entries to dial the associated number.

Result: This transfers the call to the selected number for the selected entry.

= Extension
=4y Business Phone
S Mobile Phone

* Fax
D .|| 7o
Transfer Vaoicemail

Related Topics

Directory Toolbar Buttons
Transfer a Call Using the Queue Control Toolbar
Using the Directory Toolbar

Transfer a Call Without Consulting the Recipient

Transferring a call without speaking to the intended recipient is called a blind transfer. Use a blind transfer if you do
not need to speak with the recipient before transferring an interaction. If the intended recipient does not answer, the
call is sent to the recipient’s voice mail.

To blind transfer from My Interactions:
1. Inform the caller that he or she is going to be transferred.

2. On the Queue Control toolbar, click the Transfer button.
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Result: The Transfer dialog box appears.
3. Inthe Transfer To: text box, type all of part of the recipient’s name or number.

Result: A drop-down list of choices appears.

Tip: If the drop-down list does not contain the recipient you expected, check the search criteria selected in the
Options drop-down list and adjust them if necessary.
4. From the drop-down list, do one of the following:
Select "Dial [your entry] as Digits" to convert a text entry into numbers.
Select the appropriate name and associated extension number.

Result: If the intended recipient is a CIC user, status information for the selected CIC user appears. It shows
whether the transfer recipient is logged onto a CIC client and is able to accept the transferred call. This can
help you decide what kind of call transfer to use.

5. Click the Transfer button.
Result: The transferred call disappears from My Interactions and is routed to the selected recipient.
Tip: Transferring a call directly to a contact’s phone number is another method of making a blind transfer. For more
information, see Transfer a Call to a Directory Entry.
Related Topics

Call Coverage Options

Set Status Details

Transfer a Call After Consulting the Recipient
Transfer a Call to a Directory Entry

Transfer a Call to Another Person’s Voicemail
Transfer a Call Using the Directory Toolbar
Transfer a Call Using a Transfer Button
Transfer Button

Forwarding Calls

Forwarding Calls

You can arrange to forward your calls to a remote number when your status is Available, Forward. Your CIC
administrator can also configure the CIC client to forward your calls if your status is Available, Forward or forward
your calls regardless of your status.

Related Topics

Call Coverage
Forward Calls to Your Remote Telephone Number
Understanding Follow-me Routing

Call Coverage Options

Your CIC administrator can use Interaction Administrator to configure how the CIC client works. Contact your CIC
administrator if you have questions on how any of these options are set on your system.

Among the call coverage options that can be set by your CIC administrator are:
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The internal number or CIC extension designated as your call coverage number.

Whether forwarded callers leave voice mail in the mailbox for the designated call coverage number or your
regular voice mailbox.

The types of calls that are forwarded to a designated call coverage number.
o All Calls.
0 Internal Calls. This includes calls from internal numbers or extensions on the CIC system.

0 External Calls. This includes calls from outside the CIC system (calls from public service telephone
networks).

0 Unknown Calls. This includes calls from outside the CIC system that do not have caller ID.

Whether calls are forwarded to a call coverage number when your status is Do Not Disturb (DND), including
not being logged onto the CIC client.

Whether calls are forwarded to a call coverage number when you are on the phone.

Whether calls are forwarded to a call coverage number when you do not answer.

Forward Calls to Your Remote Telephone Number

Requirements: Your Phone Number Classifications-Forward Access Control rights determine which phone numbers
you can use as forwarding numbers.

If you will be away from your desk but accessible at another telephone number, you can forward your calls. You can
forward calls to an internal extension, a local number, a cellular telephone, or even a long-distance number (if you
have the appropriate rights.)

When you choose to forward calls to a remote telephone number, you must set your status to Available,
Forward. The IC server redirects all calls originally targeted at your local extension to the remote number.

Or your CIC administrator can create multiple Forwarding statuses if your site requires it. For example, you
could have Available Forward, Home and Available Forward, Mobile.

If you can't normally make long-distance calls from the CIC client, you can't forward your calls to a long-
distance number. If you have questions about your call privileges, see your CIC administrator.

To forward your calls to your remote location:

1. From the My Status drop-down list, select Available, Forward.
2. Do one of the following:

If you have previously set your status to Available, Forward and entered the correct forwarding
telephone number, you are finished. All calls are now forwarded to the remote number.

If you have never before set your status to Available, Forward, you are prompted to "Please provide
a forward number." Enter your remote telephone number and click OK. You are finished.

If you have previously set your status to Available, Forward but want to change the forwarding
telephone number, click Set status details and go to the next step.

3. In Forward Number, enter the remote telephone number for forwarded calls.
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Set Status: Took, Noreen

I

Status
|,_a Available, Forward r |
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4. Click OK.
Result: Your status is set to Available. Forward and all calls are forwarded to the remote number.
Related Topics

Set Status Details

Follow-me Routing
Understanding Follow-me Routing
Requirements: You need the Security right to use Follow-me routing in the CIC client.

If someone calls you when you're away from your office, you can set up the CIC client to search for you at different
telephone numbers. After locating you, the CIC client transfers the call to you at that location.

With follow-me routing, a caller dials one number to reach you and then the CIC client consecutively calls the
telephone numbers you set up to find you and connect you to the caller.

Follow-me routing can transfer calls to several locations, including:
Your home
Your cell phone

An extension at another location

w W W W

Any long-distance or international numbers, if you have permission from your CIC administrator

Follow-me routing configuration settings also determine how many seconds the CIC client rings a telephone number
before it calls the next number on the follow-me list or transfers the call to your voice mail. These configuration
settings can also require the person who answers the call to enter your CIC password. For more information, see Set
Up Follow-me Routing.

How Follow-me Routing Works

To start follow-me routing, set your status to Available, Follow-Me. Then, when someone calls you, the caller can
choose to leave a voice mail message or have CIC find you. If the caller wants CIC to find you, CIC records his or her
name and places the caller on hold while it begins the follow-me routing process.
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If CIC cannot locate you at any of the numbers in your follow-me routing list, it transfers the caller to your voice mail.

If call screening is enabled, when you answer the call and enter your password (if the follow-me routing number
requires a password), CIC announces the caller's name and you can choose to accept the call, transfer it to another
number, or forward it to your voice mail.

Related Topics

Follow Me Routing Options
Set Up Follow-Me Routing
Start follow-me routing

Set Up Follow-me Routing

Requirements: You need the Follow Me Security right to use Follow-me routing in the CIC client. Your Phone
Number Classifications-Follow Me Access Control rights determine which phone numbers you can use as Follow-me
numbers.

To handle calls when you are away from the office, the CIC client can search for you at different telephone numbers.
The client consecutively calls the telephone numbers in a follow-me routing list. After locating you, the client can
transfer the call to you at that location.

You can set up follow-me routing in the CIC client. You can also use the Telephone User Interface to turn Follow-me
on or off and configure Follow-me phone numbers. For information about setting up Follow-me numbers via the TUI,
see the Telephone User Interface User’s Guide or Quick Reference Card in the CIC Documentation Library.

To add a follow-me phone number:

1. Setyour status to Available, Follow-Me.
2. Click the Set status details link next to the My Status drop-down list.

3. Inthe Set Status dialog box, complete the fields as described below:

Status Notes Enter any additional information on your current status.

As a convenience, the notes from the last time you selected this status
appear in Status Notes. You can make any necessary changes to these
notes.

Requirements: You need the Status Notes right in order to create or
modify Status Notes.

Until Date Do any of the following:
Until Time - Select the Until Date or Until Time check box to use the default date
and time.

Result: The current date appears in the Until Date field. The CIC
client automatically rounds the current time to the next half hour, and
sets that time in the Until Time field.

To change the Until Date, select the check box and click in the text
box. Select a date from the displayed calendar.
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Set Up Follow-me Routing

To change the Until Time, select the check box, and click the drop-
down list arrow to select a different time.

4. Click Configure Follow Me Numbers.

5. To prompt callers for their name, select the Screen Calls check box.

6. Inthe Follow Me Numbers dialog box, click the Add button (plus sign).

7. Complete the fields as described below.

Number Enter a telephone number you want the CIC client to call if you are not available.
Click the Validate button to check your phone number entry against the
requirements of the dial plan for your organization or region.

Dialing Pause

You can use both commas (,) and slashes (/) with the number. A comma causes a
two-second delay and numbers typed after the slash are dialed only after a
connection is made. For example, if you typed the number "555-1212 / 101, 2222",
the first seven digits are dialed. After a connection is made, the digits 101 are
dialed, and after two seconds, the digits 2222 are dialed.

Extension Enter an extension number. This number is dialed after a connection is made.

Timeout Specify the number of seconds the CIC client rings an external number. It defaults
to 15 seconds.

Use Pin Select this check box to require that anyone who answers a follow-me router call to
enter your CIC client password to accept the call.

8. To add another number, repeat steps 4 and 5.

9. Click OK to save your settings and close the Follow Me Numbers dialog box.
To change your follow me settings:

1. Perform any of the following actions to update your follow me settings:

To change the order of your follow-me numbers, select a number and click up or down arrows
above the number list.

To delete a number, select a number and click the Remove button (red X).
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To change the settings for a number, double-click the number and type new values in the Number,
Extension, and Timeout text boxes and select or clear the Use Pin check box.

2. Click the OK button to save your settings and close the Follow Me Numbers dialog box.
Related Topics

Understanding Follow-me Routing
Start Follow-Me Routing

Start Follow-me Routing
Requirements: You need the Follow Me Security right to use Follow-me routing in the CIC client.

After you have set up your follow-me routing numbers, you can start follow-me routing by changing your status to
Available, Follow-Me. This causes the CIC client to search for you at different telephone numbers. After locating you,
the CIC client transfers the call to you at that location.

To start follow-me routing:
Set Your Status to Available, Follow-Me.

Related Topics

Set Up Follow-Me Routing
Set Your Status
Understanding Follow-me Routing

Making Conference Calls
Making Conference Calls
Requirements: You need the Conference Calls Security right to create a conference call.

Creating a conference call is as easy as making or receiving several individual calls, then dragging and dropping each
call to connect the participants.

Warning: Do not use a consult transfer or a conference call to transfer a call to an attendant profile, workgroup
queue or an agent's voicemail. If you call into a workgroup queue and are put on hold and then conference the
original call with your workgroup call and then disconnect from the resulting conference, the original call is removed
from the workgroup queue. It is put on hold and remains on hold. Use a blind transfer to transfer a call to an
attendant profile, workgroup queue or an agent's voicemail. For more information, see Transfer a Call Without
Consulting the Recipient.

Tip: You can put a conference on Hold by selecting the conference and clicking the Hold button. You can click the
Pickup or Hold buttons to reconnect to a held conference. For more information, see Place a Call on Hold.

Related Topics

Conferencing Features
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Conferencing Features

Create a Conference Call Using Drag and Drop

Conferencing Features

Conference calls show up in My Interactions in a tree fashion. You can click the Conference link to expand or collapse
the conference display.

- Interaction Client web edition logoff MNewy Viewy | Optionsy Helpvy
My Interactions tal (5] (?; " !5 | v lake Ca
Conference
" 2:01:14 - Connected 3088731292
.ﬁ Lync, Priscilla at 5555 - Connected 3088731293 ([
ﬁ Hood, Debbi at 4444 - Connected 3088731306 || _
f To Hood, Debbi at 4444

:.:‘:-; _f:_l-_:-:--

My Status | @ Availabie, No ACD v| 12402 set status details

To create a conference, just drag and drop a call on another call .

Result: You see a new interaction with the name "Conference." The connected interactions are displayed
under this Conference interaction.

To add parties to a conference, drag a connected call and drop it on the Conference interaction.
Related Topics

Drag and Drop a Call on Another Call
Making Conference Calls

Drag and Drop a Call on Another Call
Requirements: You need the Conference Calls Security right to create a conference call.

You can create a conference call in My Interactions by dragging and dropping a call on another call in My
Interactions.

To create a conference call:

1. Dial the number of a participant in the conference call.
Result: The interaction appears in My Interactions.

2. Click the Hold button to put the call on hold.

3. Repeat steps 1 and 2 for each participant.

4. Select one of the calls you want to conference, and while holding down the mouse button, drag that call to
another call in My Interactions and release.

5. After you drag and drop a call to create a conference, a confirmation dialog box may appear asking you if
you are sure you want to join. Click OK.
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Result: The calls are now connected to each other and a conference call is created. For more information, see
Conferencing Features.

Related Topics

Conferencing Features

Using Other Call Features
Using Other Call Features
This section describes how to use other call features including:
Camp on an Internal Extension
Determine if Someone is Listening to or Recording Your Interactions
Listen to a Call
Record a Call
Request Assistance from Your Supervisor

View and Edit Interaction Properties

Camp on an Internal Extension

Camp is a function that can watch another user’s status and alert you when that status changes. When another CIC
client user in your organization is currently unable to take your call, you can camp on that person’s extension until
that person becomes available.

Tip: You must disable popup blocking for the Interaction Client Web Edition site in order for the camping alert to
"pop" when designated user’s status changes. See the help for your browser, if you do not know how to disable
popup blocking for a designated site.

To camp on an internal extension:

1. Select a directory entry and click the Camp button in the Directory toolbar.

Result: This displays the Camp desktop alert with the selected person’s current status and corresponding
status icon.

Bz Mike Hill
S Available
Time in status: 2155:36

W' Logged on MIKEHPC

[ Call Mow ] [ Stop Camp
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Determine if Someone is Listening to or Recording Your Interactions

2. When the person’s status changes to an available type, the Camp desktop alert reappears. The Call Now
button is enabled. Click it to call the user.

Camping on Multiple Extensions

You can camp on any number of CIC client user extensions individually. If you want to see all the camps you have
activated, use the Active Camps dialog box.

To manage your current camps:
1. From the View menu, select Active Camps.

Result: The Active Camps dialog box displays the names of the people on whose extensions you are camped.

Tasker. Moreen
Bishop, Lea

Stop Camp

2. Do one of the following:

Select a name and click Stop Camp to stop camping on the selected person’s extension.
Click Close to exit the Active Camps dialog box.
Double-click on an entry to re-display the Camp desktop alert.
Stopping Camping
You can terminate camping alerts in several ways.
To stop camping, do one of the following:
Log off Interaction Client Web Edition.
Select a name and click Stop Camp in the Active Camps dialog box.
Click Stop Camp in a Camp desktop alert.
Related Topics

Camp Button
Camp Desktop Alert

Determine if Someone is Listening to or Recording Your Interactions

Requirements: The Monitor Columns Security right, the Supervisor Monitoring feature, and your role as Supervisor
or Agent determine whether the Listen and Record icons are visible for some monitored interactions.
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A supervisor or other user with the appropriate rights can "listen to" (monitor) any interaction type. For example, a
supervisor may decide to listen to or record an interaction in your ACD workgroup queue. In addition, multiple
supervisors can listen or record a single interaction.

Record Icon
Listen Icon
w If someone is listening to or monitoring your interaction, the Listen icon appears at the far left

or right of the appropriate line in My Interactions.

Record Icon

When you record an interaction, two interactions appear in your queue view. The Record icon
appears at the far left or right of the appropriate line in My Interactions.

A Record icon on the right of the selected interaction indicates that someone is
recording the interaction.

A Record icon at the left side of the queue view indicates you are recording the
interaction. In this position it indicates interaction type and appears next to the
interaction that represents the recording you are making.

If someone else is recording your call:

A Record icon on the right side of the selected interaction indicates someone is
recording the interaction.

The absence of an accompanying recording object with a Record icon on the left
indicates someone else is making the recording.

You can determine how many CIC users are recording the interaction by pointing to
the Record icon on the right of the connected call line. This displays the number of
users who are recording the interaction.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Related Topics

Listen Button

Listen to a Call

Record a Call

Record Button

Settings affecting Record and Listen indicators
Working with Calls

Settings affecting Record and Listen indicators
Whether or not you can see if another user or a supervisor is monitoring an interaction is governed by several factors:

Are you a Supervisor of any workgroups to which the interaction was routed?
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Is Interaction Recorder automatically recording the interaction?

Did the CIC administrator enable Supervisory Monitoring on the IC server?

Behavior

Listen to a Call

This table summarizes the circumstances under which you can see if someone is recording or listening to an
interaction. It applies to IC 4.0 SU 6, CIC 2015 R1 P2, CIC 2015 R2 and subsequent releases.

Under these conditions You can see
You have Supervisory |[You are a Your Supervisor's | Non- Interaction
Monitor Monitoring is | Supervisor recording recording supervisor's | Recorder
Columns enabled recording system
right * recording
No (Any) (Any) Yes No No No
Yes No (Any) Yes Yes Yes Yes
Yes Yes No Yes No No No
Yes Yes Yes Yes Yes Yes No

* The Monitor Columns Security right does not apply to Interaction Client Web Edition users. The Record and Listen

icons appear when appropriate but are not displayed in columns.

Related Topics

Determine if Someone is Listening to or Recording Your Interactions

Listen to a Call

You can listen to a call on hold in My Interactions or a call that has been transferred to voice mail.

To listen to a call:

§ Select a call and then click the Listen button.
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Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Related Topics

Determine if Someone is Listening to or Recording Your Interactions
Listen Button
Listen to Someone Leave a Voicemail Message

Record a Call

Requirements: See Record.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

If you have the appropriate security rights, you can record a call. Ad hoc recordings made using the Record button
are stored in files that your CIC administrator can arrange for you to receive in your email inbox as WAV files attached
to email messages.

To record a call:

1. Select an interaction and click Record.
Result: The Record button appears pressed, and the call is recorded as a. wav file.

2. To pause the recording, click Pause.

Result: The Pause button appears pressed, and recording is suspended.

3. To stop recording, click Record again.

Result: The Record button becomes un-pressed, and the recording stops.

Related Topics

Record Button
Secure Record Pause Button

Report a Problem

You can create an email message and automatically include all of an interaction’s critical information when reporting
a problem with the CIC client to your support representative.
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Report a Problem

Tip: For more information about accessing technical support, submitting product or documentation feedback, or
request enhancements, see Feedback and Access Support.

To report a problem:

1. Inthe Interaction Properties Dialog Box, click the Interaction ID hyperlink.

Tip: This hyperlink is the number preceded by the envelope icon in the bottom border of the Interaction
Properties dialog box.

Result: A new email message window opens in your default email program.
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"-. i ¥ 0 & % |- Interaction1066973804 - Message (HTML) i =)

| Message | Insert Options Format Text Developer Adobe PDF @

=S 3-  ABG
sa | 7|V

j EE ‘ B 7 O
Address Check - Follow Spelling
™ J ||£ & & i Book MNames P up~ | &

|Clipboard ™ || Basic Text | | Mames ||Include ™= || Options ™= “ Pruuﬂng!

-

Interaction 1066973504

| » &3] |

Interaction ID: 1066973804

Mame: Joe Smith

Number: (317} 555-9944

Start: Tuesday, 14 June 2011 14:22:50
End: Tuesday, 14 June 2011 14:24:45
Duration: 0:01:55

Disposition: Answered

User: Noreen.Tinker
Station: NOREENTINKERSIP
IC Server: ICServer?
Session Manager: IC5erver2

14:22:50: Initializing

14:22:50: Offering

14:22:50: ANI: 317555959444

14:22:50: DNIS: 3175551234

14:22:50: Offering

14:22:50: Sent to user Noreen.Tinker
14:22:50: User Alert: Noreen.Tinker
14:22:50: Alerting

14:22:50: Sent to station NoreenTinkerSIP
14:22:53: Connected

14:24:45: Disconnected [Local Disconnect]

2. Supply any other useful information or comments in the email message.

3. Address the email message.

4. Send the email message to your support representative or other designated person.
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Request Assistance from Your Supervisor

Request Assistance from Your Supervisor

Requirements: For more information about the rights required to use the Assistance button, see Assistance. The
Assistance button is enabled only for ACD-routed interactions. Also, if the interaction is not in a state in which this
action can be performed, the Assistance button is dimmed.

Sometimes you encounter an interaction for which you need assistance. For example, a caller could ask a question
that you cannot answer. Or you are in the middle of a web chat when you need help from your supervisor. Or you
want to ask a question before you respond to an ACD-routed email.

You can request assistance only for ACD-routed interactions.
You can have one active assistance request for each interaction.

You can request assistance multiple times for the same interaction as long as any previous assistance
requests are completed before you make a new request.

Workgroup Supervisors

Workgroup supervisors are configured in Interaction Administrator. Also, supervisors receive assistance requests only
if they are running Interaction Supervisor or IC Business Manager. If supervisors are running only the CIC client,
they do not receive assistance requests.

Requesting Assistance

To request assistance:

1. In My Interactions, select the ACD-routed interaction for which you need help.

2. On the Queue Control toolbar, click the Assistance button.

Result: The Assistance Request dialog box appears.

Type & message to begin the assistonce request...

3. Inthe "Type a message to begin the assistance request..." text box, type a brief explanation of why you
need assistance from your supervisor.
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4. Do one of the following:

To cancel the request, close the Assistance Request dialog box.

To send the help request to your supervisor, click the Send button.

Result: The workgroup supervisor receives an assistance request in Interaction Supervisor. Also, all
supervisors on the same IC server see a pop-up toast assistance request. You can chat with your

supervisor in the Request Assistance dialog box.

Stanley Cole 404 P -
+ Ome of Ben's okd customers wants & discount.
Gary Smith 404 FM
¢ Does the customer have a valid discount code?
Stanley Cole 404 PM
+ From what | see in the history, they do.
-

5. When you no longer need assistance and have finished your conversation with your supervisor, click

Complete.

Result: This action ends and closes the assistance request.

Related Topics

Assistance Button
Assistance Process

Assistance Process
When you click the Assistance button in My Interactions, the Assistance Request dialog box appears. You enter a
problem description and click Send.
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Assistance Process

Ve o message to begin the ossistonce request..

All of the workgroup supervisors on the same IC server see this assistance request. If a supervisor responds to the
request, the toast notification closes automatically for all supervisors.

E This customer wants a...
From: Evan 4.0
%" Respond

ﬁ Ignore
IManage Assistance Requests

The supervisor responds to the notification by clicking a link:

Respond opens the Respond to Assistance Request dialog, to give immediate assistance and feedback to
the user. The supervisor can text chat with the agent, and use call action controls to listen, coach, join,
record, pause, pickup, or disconnect the interaction.
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-
¥ Agent Assistance

Evan
» This customer wants a discount. CanIapply it?

Jarrod
v Does the customer have a valid discount code?
» From what I see in the history they do.

11:22 AM

11:26 AM

Can you confirm?

Qe e il %

Listen Coach Join | Record Pause | Pickup Disconnect

Send

)+

EQ

Ignore disregards the message and dismisses the assistant request toast.

Manage Assistance Requests opens the Agent Assistance dialog box, which displays all assistance requests
from agents in workgroups for which the supervisor has responsibility. The supervisor can select a request to

answer, and assist multiple agents at the same time.

You can chat with your supervisor in the Request Assistance dialog box.

‘€ Assistance Request - 1001880644

+ Ome of Ben's okd customers wants & discount.

¢ Does the customer have a valid discount code?

+ From what | see in the history, they do.

Stanley Cole 41

(Gary Smith 44

Stanley Cole 41

Related Topics
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Secure Pause a Recording

Assistance Button
Request Assistance From Your Supervisor

Secure Pause a Recording
Requirements: See Secure Record Pause.

You can use Secure Pause to avoid recording sensitive information, such as a Social Security number or credit card
number, during a call. This procedure assumes you are currently connected to a call. You do not have to be currently
recording the call interaction.

To secure pause a recording:
Select a call interaction and click Secure Record Pause.

Result: Your recording of the interaction (and all recordings by any other monitors of this interaction) are
paused for a configured period of time. The Secure Pause button displays a countdown timer of how long all
recordings will continue to be paused. The Secure Pause does not end until the timer reaches zero.

i3

You can press Secure Pause again during a pause to reset the countdown timer to the maximum duration of
a pause.

Tip: Pressing Secure Pause multiple times during a pause does not increase the duration beyond the
maximum time limit. The maximum duration of a Secure Pause is configured in Interaction Administrator.
Contact your CIC administrator if you have questions about the length of a Secure Pause.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Related Topics

Secure Pause Button

View and Edit Interaction Properties
You can view extended information for a completed interaction or make notes during the interaction.
To view interaction details, do one of the following:

In My Interactions, select an interaction and click the Properties button.

In Call History, select an interaction and click the Properties button on the dialog box.
Result: The Interaction Properties dialog box appears.

Log
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The Log describes changes in the interaction’s state. This information goes into a log file and is used for reporting
purposes.

Interaction Properties: Joe Smith - (317) 595-9999&-

Motes Log

03:53:13: Initializing -
08:53:18: Sent to user Moreen.Tinker

0&:53:18: Qutbound Call: 6960994

08:53:19: Dialing

08:53:33: Connected

03:53:33: Call Connected

08:56:22: Disconnected [Local Disconnect]

s e

Pickup Halel Mute Vaoicemail Disconnect Recard Pause Private

fDistunneded [Local Disconnect]  0:03:03 =2 2088393908

Notes

Notes record information typed by an agent about an interaction.
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View and Edit Interaction Properties

Interaction Properties: Joe Smith - (317) 595-999913

Motes || Log |

MNoreen.Tinker - 2/13/2012 5:54 AM &
Assisted with update

2 B4l %

Pickup Mute YVaicemail

® |® | il @]
|

Disconnect Recard Pause Private

(8 Connected 0:01:37 2 2083393908

To take notes on an interaction:
1. In My Interactions, select an interaction and click the Properties button.
Result: The Interaction Properties dialog box appears.
2. Click the Notes tab.

3. Inthe text box to the left of the Add Note button, type the notes.
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Interaction Properties: Joe Smith - (317) 695-9999@;:

Motes | Log |

-

Assisted with update Add Note
|

Pickup Halel Mute Vaicemail Disconnect Record Pause Private

(& Connected 0:00:59 | =1 2083393908

4. Click the Add Note button.

Result: The text appears in the Notes tab.

Interaction Properties: Joe Smith - (317) 595-9999@

Motes || Log |

MNoreen.Tinker - 2/13/201 2 5:54 AM -
Assisted with update

i I
" |

| | [
ey |
|

i

Pickup Halcl

d

YVoicemail Disconnect

“
&

Recard Pause Private I

(8 Connected 0:01:37 2 2083393908

Related Topics
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Working with Chat Sessions

Add Notes to an Interaction

Assign Codes to an Incoming Interaction

Assign Codes to Outgoing Interaction
Properties Button on the Queue Control Toolbar
View and Edit Directory Entries

View Directory Entries

Working with Chat Sessions

Working with Chat Sessions

In the CIC client, chat sessions are online, real-time, typed conversations between CIC client users or between a CIC
client user and a remote chat participant browsing your website. If Interaction Center is configured to receive chat
sessions, then you are alerted to a chat session, just as you are alerted to other incoming interactions such as calls.

Tip: Pick up an alerting chat request in My Interactions. Or, a chat can open automatically, if your user information in
Interaction Administrator is configured to Auto-Answer non-ACD Interactions. Popup blockers can prevent auto-
answer windows from opening. If you want to use the Auto-Answer feature, you may need to configure your browser
or popup block software to allow popup windows in the CIC client.

There are two types of chat sessions:

A CIC user to CIC user chat is an Intercom chat. These internal chats can take place only between CIC users
on the same IC server. Intercom chats are not limited to two participants and can include several CIC users.
Use Intercom chats to get a quick answer to a question or to pull a team together to work together on a
problem. For more information, see Initiate a Chat Session.

Requirements: You need the Intercom Chat Security Right before you can participate in an intercom chat.
Intercom chats can take place only between users on the same IC server. You cannot start a chat session with
a User on a peer server.

An CIC user to remote participant chat is a web chat. A remote user can start the chat by clicking a link on
your company'’s website. Chat requests can be ACD-routed to your queue, much like an incoming call. You
then pick up the chat request in a similar manner to answering an incoming call.

Chat Interactions

A connected computer icon identifies a chat interaction in My Interactions. The chat interaction displays the name of
the last participant to type during this chat and part of the text typed.

c g - Interaction Client web edition logoff Newv Viewy Optionsv
My Interactions ] @ @ " ﬁ | A ake Ca
Q‘ From Jason Moore (Jason.Moore) [Jason Moore: When is the meeting?]
0:02:17 - Connected 10015584504

Related Topics

Add Notes to an Interaction

Assign Codes to an Interaction

Chat Window

Conference Two or More Chat Sessions

Copy and Paste Text during a Chat Session

Determine if Someone is Listening to or Recording Your Interactions
Disconnect a Chat Session
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Initiate a Chat Session

Manage a Chat Session

Mark a Chat Session as Private

Pick Up a Chat Request

Place a Chat Session on Hold

Record a Chat Session

Request Assistance from Your Supervisor
Send a Chat Session Request to Voicemail
Transfer a Chat Session

Chat Window

Chat Window

The Chat window provides the necessary tools for participating in a chat interaction.

@" 1_' Voicema | X Disconnect || @ Record | Pause

@ Private || 7] Assistance |

d I
& Jimu » Properties
o’ » Motes
2 Connected With: A
a Jim Smith ~ Response Management
& corom o &=
— We e Ty
=] Using the new Order Manag... OMS
Instructions for using the new .. jnsert
v = on to another age
2:33
» Hellg, how can I help you today?
- Jim Smith 2:54 PM |
@) + I.am having problems using your order tracking system.

Carolyr.Wampler is typing... & Send File

Instructions for using the new Order Management System are available by clicking =
the Help button in the upper right hand corner. (=1 Send

Problems with order tracking mest often occur when the customer number or
L, ACD - Assigned: Jim.Ullyot | 0:04:48 | 1001236324

| oren®

Toolbar The toolbar contains buttons for most of the functions for managing a chat
session. For more information, see Manage a Chat Session.

N

Chat Members This section displays the names of the chat participants. The person who
initiates the chat is listed above the separator line. The other chat participants
are listed in the Connected With section, in the order in which they entered
the chat session.

Conversation The conversation area displays the pre-configured automatic messages that
sends when the chat begins, plus all chat text from all participants.

w

D

Alert You are alerted when a chat participant is typing a response that hasn't yet
appeared in the conversation area.
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Manage a Chat Session

5 Composition Compose your reply to an ongoing chat, then click Send or press Enter.
area You can:

Type a response.

Click the Send file icon (paperclip) to locate a file on your workstation
and send it to other chat participants.

Locate and insert a Favorite Response or a system-wide response in
the composition area. For more information, see Use Response
Management During a Chat Session.

Copy and paste text to or from a Windows application.

6 Status bar The Status bar displays the state, duration and ID number of the interaction.

7 Sidebar area The appearance of the sidebar area can vary based on your user rights. It
contains controls and information that are related to the chat.

8 Properties The Properties section contains the interaction log. Optionally, the Account
Code and Wrap-Up Code drop down lists also appear in this section.

Some companies categorize interactions by customer. If you have the
appropriate rights, you can assign an Account code to an incoming email
message. If you are a member of a workgroup for which Wrap-Up codes are
configured, you can use this drop-down list to assign the code.

9 Notes Use the Notes section to add notes or comments about the ongoing chat.
Other chat participants do not see these notes.

10 | Responses Select a pre-defined response. For more information, see Use Response
Management During a Chat Session.

11 | Splitter Bar If you prefer not to see the sidebar area, click the splitter to hide that part of
the Chat window. Click the splitter again to restore the sidebar area.

Related Topics

Add Notes to an Interaction
Assign Codes to an Interaction
Manage a Chat Session
Understanding Account Codes
Understanding Wrap-Up Codes
Working with Chat Sessions

Manage a Chat Session

Manage a Chat Session

CIC client users can participate in intercom chats or web chats. Chat sessions can include two or more users. You can
use the toolbar or menus in the Chat Window to manage a chat.

Chat Window Toolbar
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The Chat Window toolbar contains buttons for most of the functions for managing a chat session.

Button

Description

Click Pickup to connect to the current chat session. For more information, see Pickup a Chat
Request.

Click Hold to place the chat session on hold and free you to work with other interactions.
When you place a chat session on hold, the CIC client can send you another phone call, email
message, or chat session. For more information, see Place a Chat Session On Hold.

Click Voice Mail to Send a Chat Session Request to Voice Mail.

Click Disconnect to disconnect the current chat session. For more information, see
Disconnect a Chat Session.

@ X va

Click Record to record the current chat session. This recording is saved and sent to you as an
email message attachment after you end the chat session. Clicking Record the first time
starts the recording session for an interaction. Clicking Record again stops the recording
session for an interaction. For more information, see Record a Chat Session.

Click Pause to pause the recording session. Click it again to resume the recording session.
This button is unavailable if the interaction is not in a state in which this action can be
performed. For more information, see Record a Chat Session.

o

Click Private to prevent other CIC client users from recording this chat session. This button is
unavailable if the interaction is not in a state in which this action can be performed. For more
information, see Mark a Chat Session as Private.

Warning: Use of the Private feature may be subject to your company’s policies and should
only be used in accordance with those policies. CIC handler customization can be used to
track the use of the Private feature to ensure compliance with such policies.

=

If you're in a workgroup and you need help with a chat session from your workgroup queue,
click Assistance to request assistance from your supervisor. For more information, see
Request Assistance from Your Supervisor.

Related Topics

Add Notes to an Interaction

Assign Codes to an Interaction

Conference Two or More Chat Sessions

Determine if Someone is Listening to or Recording Your Interactions

Disconnect

a Chat Session

Copy and Past Text During a Chat
Initiate a Chat Session

Mark a Chat Session as Private

Pick Up a Chat Request

Place a Chat Session on Hold

Print a Chat Session

Record a Chat Session

Request Assistance from Your Supervisor
Send a Chat Session Request to Voice Mail
Transfer a Chat Session

Using Response Management

Working with Chat Sessions
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Add Notes to an Interaction

Add Notes to an Interaction

Use the Notes section in the appropriate interaction window to add notes or comments about the interaction.

Tip: For information about adding notes to a Call, see View and Edit Interaction Properties.

To add notes to an interaction:

1. In the Callback window, Chat window, Email window for Incoming Messages, or E-mail Window for Outgoing
Messages, expand the Notes sidebar.

2. In the text box, type your observations or comments and click Add Note.

Result: Your notes appear in the Notes sidebar in the interaction window.

F Properties
* Motes

Userd - 1173072012 11:23 AM
Checked customer record.

Asked forlog | =
fila, Add Note

-

F Response Management

Related Topics

Respond to a Callback Request
Manage a Chat Session
Working with Chat Sessions

Assign Codes to an Interaction
Requirements: See Working with Account and Wrap-Up Codes.

You can assign an Account Code or Wrap-Up Code to an interaction. The Account Code and Wrap-Up Codes drop-
down lists contain the codes defined in Interaction Administrator.

To assign codes to an interaction, do one of the following:

For an incoming email message, select the appropriate codes in the Email Window for Incoming
Messages.
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For an outgoing email message, select the appropriate Account code in the E-mail Window for Outgoing
Messages.

When responding to a callback request, select the appropriate codes in the Callback Window.

During a chat session, select the appropriate codes in the Chat window.

Related Topics

Assign Codes to an Incoming Interaction
Assign Codes to an Outgoing Interaction
Email Editor

Email Preview

Email Window for Incoming Messages
Email Window for Outgoing Messages
Manage a Chat Session

Understanding Account Codes
Understanding Wrap-Up Codes

Conference Two or More Chat Sessions

You can create conference chats by bringing members from two or more separate chat sessions into a single chat
session. Before you begin, you should have two or more connected chat sessions in your My Interactions view.

To conference two or more chat sessions:

1. Initiate a chat session.
2. Initiate a second chat session with a different CIC client user.

3. Inyour My Interactions view, click and drag one connected chat session onto another connected chat
session.

Result: In your My Interactions view, the two chats are placed under a single Chat Conference call object that
is identified by the name "Conference."

4. Repeat steps 2 and 3 for any additional participants you want to add to the chat conference.

5. When the session is complete, click the Disconnect button in the Chat window, or on the My Interactions
view to end the chat conference.

Related Topics

Manage a Chat Session
Working with Chat Sessions

Copy and Paste Text During a Chat

You can use the Windows clipboard to copy all or part of a chat session to a text-based Windows application such as
Microsoft Word or Notepad. You can also copy text from files open in Windows applications to the chat session.

Use Windows Copy and Paste operations to copy the text from an open file to the composition area of the Chat
window. Then click Send, just as if you'd typed the response.
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Disconnect a Chat Session

Related Topics

Manage a Chat Session
Working with Chat Sessions

Disconnect a Chat Session
Requirements: See Disconnect.

To disconnect a chat session, do one of the following:
Close the Chat Window by clicking the Windows control in the upper right corner.
In the Chat Window, click the Disconnect button.
In My Interactions, select the chat interaction and click the Disconnect button.
Related Topics

Chat Window

Manage a Chat Session

My Interactions

Working with Chat Sessions

Initiate a Chat Session

Requirements: You need the Intercom Chat Security right to start or participate in intercom chats with other CIC
client users.

Intercom chats, or chat sessions between CIC client users, can include two or more users. To start intercom chats with
two or more other users, you can conference two or more chat Sessions

To start a chat session with another CIC client user:

1. Inthe Company Directory, select the name of the person with whom you wish to chat.
2. Click the Chat button in the Company Directory.

Result: The chat appears in the Chat window.

Result: The chat appears in the Current Interaction view.

Related Topics

Conference Two or More Chat Sessions
Manage Chat Session
Working with Chat Sessions
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Mark a Chat Session as Private

You can mark a chat session as private. This option prevents other CIC client users from recording this chat session,

Warning: Use of the Private feature may be subject to your company’s policies and should only be used in
accordance with those policies. CIC handler customization can be used to track the use of the Private feature to
ensure compliance with such policies.

To mark a chat session as private, do one of the following:
Select a chat and then in the queue control toolbar, click the Private button.
In the Chat window, click the Private button.

Related Topics

Chat Window

Manage a Chat Session
Private Button

Working with Chat Sessions

Pick Up a Chat Request
Requirements: See Pickup.

When someone sends a chat request to you, the CIC client sends a message to your email account and the chat
request appears in your My Interactions queue. To join the chat session, select the chat request and click the Pickup
button.

Related Topics

Manage a Chat Session
Working with Chat Sessions

Place a Chat Session on Hold

You can place a chat on hold to free yourself up for other interactions. When you place a chat session on hold, the
CIC client may send you another phone call, email message, or chat session. While a chat session is on hold, you are
free to accept or start another interactions. Other chat participants can continue to type and send text while you have
your part of the Chat Session on hold.

To place a chat session on hold, do one of the following:
In the Chat Window, click the Hold button.
In My Interactions, select the chat and click the Hold button.

Result: In the queue view, the chat’s state changes to "Held." To return to the chat session, click the Pickup
button.
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Record a Chat Session

Related Topics

Manage a Chat Session
Working with Chat Sessions

Record a Chat Session

Requirements: This feature may or may not be available to you, depending on the rights assigned to you in
Interaction Administrator. See Record.

You can record a chat session between other CIC client users (intercom chat) or between you and remote chat
participants (web chat). Recording a chat session creates a transcript of the chat that is e-mailed to you after the chat
session ends.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Recording a Chat Session

To record a chat session, do one of the following:
In the Chat Window, click the Record button.
In My Interactions, select the chat and click the Record button.
In the Interaction Properties Dialog Box, click the Record button.

Result: The recording starts. A recording interaction appears in the queue view.

After you start a recording:

Click the Record button again to stop the recording session for a chat.

You can press the Record button more than once to stop or continue recording your chat.
Pausing a recording

While recording a chat, click the Pause button to temporarily stop the recording.

When a recording is paused, click the Pause button again to resume the recording session.

After the chat session ends

The Record feature saves only the text entered in a chat session while you have the Record button pressed. The CIC
administrator can arrange for you to receive these recordings as email message attachments.

121



Interaction Client Web Edition Printable Help 2016 R4

s

Dia H9 3«9 - Chat Recording - Message (HTRL) - = x
Message | [Dewveloper Add-Ins Adobe PDF @

; 'a ; _Q : '2 D~ @_Mwe ta Folder -| £ Block Sender HH Cateqorize - 44 g”#

| @ Create Rule ﬂ.— Safe Lists = ¥ Follow Up -

Reply  Reply Forward - Delete | Fird Send to

; to Al =l ] Cther Actions - [ Mot Junk L':j hark as Unread - Orekote

{ Respond Actions Junk E-mail ™ Qptions g | || OneMote

From: Admin, IndvDey Sent: Thu 104132011 9:41 A

To & D, Moreen

e

Subject: Chat Recording

] Message | || ChatRecording 06671567 4.5 (713 B)

Chat Recording
From: ¢ ¥, Lea
To:" ¢ =, Mareen

Chat Transcript

IC: Welcome to IC!

IC: Interaction transferred to . Lea.
IC: Alerting: , Lea.
IC: ; Lea has joined the conversation.

Sesdew , Horeen: I think we need to set up a meeting
abhout the project. When would vou be freez

Pesteg . Lea: Afternoons are best for ne.

fesdes , Horeen: Do we need to invite eweryone on the

tean?
phie , Lea: Just Jarah and Pete for the plannineg
mesting.
fasdew , Horeen: 0E. I711 set it up
IC: ; Noreen has left the conwverzation.
IC: ; Lea haz left the conversation.#
Chat Log

09:40:28: Proceeding

09:40:28: Sent to user Moreen. Tasker
09:40:31; Connected

09:41:21: Dizconnected (Local Disconnect)
09:41:21: Interaction disconnected locally,

[k

Related Topics

Determine if Someone is Listening to or Recording Your Interactions
Manage a Chat Session
Working with Chat Sessions

Request Assistance from Your Supervisor
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Request Assistance from Your Supervisor

Requirements: For more information about the rights required to use the Assistance button, see Assistance. The
Assistance button is enabled only for ACD-routed interactions. Also, if the interaction is not in a state in which this
action can be performed, the Assistance button is dimmed.

Sometimes you encounter an interaction for which you need assistance. For example, a caller could ask a question
that you cannot answer. Or you are in the middle of a web chat when you need help from your supervisor. Or you
want to ask a question before you respond to an ACD-routed email.

You can request assistance only for ACD-routed interactions.
You can have one active assistance request for each interaction.

You can request assistance multiple times for the same interaction as long as any previous assistance
requests are completed before you make a new request.

Workgroup Supervisors

Workgroup supervisors are configured in Interaction Administrator. Also, supervisors receive assistance requests only
if they are running Interaction Supervisor or IC Business Manager. If supervisors are running only the CIC client,
they do not receive assistance requests.

Requesting Assistance

To request assistance:

1. In My Interactions, select the ACD-routed interaction for which you need help.

2. On the Queue Control toolbar, click the Assistance button.

Result: The Assistance Request dialog box appears.

Type o message to begin the assistonce request...

3. Inthe "Type a message to begin the assistance request..." text box, type a brief explanation of why you
need assistance from your supervisor.

4. Do one of the following:
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To cancel the request, close the Assistance Request dialog box.

To send the help request to your supervisor, click the Send button.

Result: The workgroup supervisor receives an assistance request in Interaction Supervisor. Also, all
supervisors on the same IC server see a pop-up toast assistance request. You can chat with your
supervisor in the Request Assistance dialog box.

Stanley Cole 404 P -
v One of Ben's okd customers wants a discount.

Gairy Smith 404 P
+ Does the customer have 3 valid discount code?
Stanley Cole 404 PM

+ From what | zee in the history, they do.

5. When you no longer need assistance and have finished your conversation with your supervisor, click
Complete.

Result: This action ends and closes the assistance request.

Related Topics

Assistance Button
Assistance Process

Send a Chat Session Request to Voicemail

Rather than answer an incoming (alerting) chat session request, you can send that request to your voice mail. You can
also send a chat participant with whom you are connected to your voice mail.

To send an alerting or connected chat to voice mail, do one of the following:

From the appropriate queue view, select the chat session, if it is not already selected, and in the Queue
Control toolbar, click the Voicemail button.

In the Chat window, click the Voicemail button.

Result: The chat session requester or participant is prompted to type a message. When the requester or
participant has finished leaving a message and exits or disconnects the chat session, you receive the message

by e-mail.

Related Topics
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Transfer a Chat Session

Manage a Chat Session
Working with Chat Sessions

Transfer a Chat Session

You can transfer a chat session to another CIC client user or to a workgroup. Use this option, for example, if you want
a more experienced agent to handle the chat request.

To transfer a chat session:

1
2.

Pick up the chat request,
On the Queue Control toolbar, click the Transfer button.
In the Transfer dialog box, in the Transfer To: text box, type all of part of the recipient’s name or number.

Result: A drop-down list of choices appears.

Tip: If the drop-down list does not contain the recipient you expected, check the search criteria selected in the
Options drop-down list and adjust them if necessary.
From the drop-down list, select the appropriate name and associated extension number.

Result: If the intended recipient is a CIC user, status information for the selected CIC user appears. It shows
whether the transfer recipient is logged onto the CIC client and is able to accept the transferred email
message.

Click the Transfer button.

Result: The transferred chat request disappears from My Interactions and is routed to the selected recipient.

Related Topics

Manage a Chat Session

Transfer Button

Transfer Dialog Box

Using the Queue Control Toolbar
Working with Chat Sessions

Transfer a File During a Web Chat

You can send a file to a visitor who starts a chat session from your company’s website (web chat). This function is not
available when you are chatting with other CIC users (intercom chat). However, you can send text containing the file
path to other CIC users.

To transfer a file during a web chat, do one of the following:

Use Response Management to send a file. For more information, see Use Response Management During a
Chat Session.

n the Chat window, click the Send file icon (paperclip) and then, in the Open dialog box, locate the
appropriate file and click Open.

Result: The visitor is notified of the file name. The visitor’s system is sent a link to the file which has been
copied to a temporary directory on the IC server. The visitor can use this link to open a compatible file in a
browser window on the visitor’s system. The visitor can also save the file to a location on the visitor’s system.

125



Interaction Client Web Edition Printable Help 2016 R4

Related Topics

Manage a Chat Session
Working with Chat Sessions

Use Response Management During a Chat Session
Requirements: You need the Response Management Security right to use Response Management.

You use stored responses to avoid typing the same information over and over again. You can select a response and
include it in a chat.

There are some limits to the use of stored responses in chats. Chat interactions are conducted in plain text. Stored
responses that contain formatted text are converted to plain text when used in a chat. Hyperlinks and images in a
stored response are not sent as part of a chat reply. However, you can use responses containing macros in a chat. You
cannot transfer a file during an internal chat with other CIC client users. However, you can send text containing the file
path to other CIC client users. You can send a file to a visitor who starts a chat session from your company’s website.
For more information, see Transfer a File During a Web Chat.

To use a stored response when participating in a chat:
1. Do one of the following:

In the Chat window, expand the Responses section, search for and then select an appropriate
response. Click Insert.

Tip: You can use full-text searching by entering terms in the Search text box in the Responses
section. A context-based search occurs automatically, based on the last five words you typed in the
chat. For more information, see Search for a Response.

In the Composition area of the Chat window, type the response Shortcut and press Ctrl+Space.
Result: The response appears in the Composition area of the selected Chat. You can edit the response before
it is included the Chat.

2. Make any necessary changes to the response and then click Send.

Result: The response appears in the Conversation area of the Chat window The other chat participants see
your response. When a hyperlink is included in a Response Management item and then added to a Chat
session, the hyperlink appears as a clickable link. If the response is a file, external Chat participants see a link
to the file which has been copied to a temporary directory on the IC server.

Related Topics

Manage a Chat Session
Working with Chat Sessions

Working with Directories
Working with Directories

Requirements: The View General Directories Access Control right determines which General Directories you can
display. The Directory Administrator Security right enables you to edit all public directories. You need the View
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Working with Directories

Directory Status Columns Access Control right to all or selected Status columns to enable you to add Status columns
to a directory view.

CIC client directories contain contact information such as names, telephone numbers and extension, email address.
They can also display CIC client user status information. You can use the information in these directories to make and
manage interactions. You can configure which available directory views appear in the CIC client. For more information,
see Working with the Company Directory and Working with Other Directories.

Each directory contains a list of names. You can:
Call the default number associated with a contact by double-clicking a name.
Click a phone number hyperlink to dial a directory contact.
Send an email message.
Initiate a Chat Session.
Transfer a connected call.
View the contact’s properties such as addresses and additional phone numbers.
Edit a directory entry if you have the appropriate permission as assigned to you in Interaction Administrator.
View another user’s status or change another user’s status.
Camp on another user’s extension.
Search for a contact.
View a status summary for all users.
You control the appearance of your directories. You can:
Add or remove directory views

Add or remove columns from a directory view.

Reorder or resize columns.

Sort a directory.

This diagram shows multiple directory views. Each directory view appears on a separate tab.
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1 Directory tabs The three tabs represent three different directories. Each is labeled with the
name of the directory.

2 New Tab Click the New Tab button to display a list of available directories. Select a

button directory to display it in the CIC client. For more information, see Add or Close
Views.

3 Close button Select a directory tab and click the Close button to stop displaying the
directory view. It is not removed and can be added back to the CIC client
interface.

4 Search fields Use the search fields to locate a specific directory entry or group of entries. For
more information, see Search a Directory.

5 Column You can drag and drop a column heading to move a column to a different

heading position. For more information, see Customize Columns.

6 Sort Direction Triangles indicate whether the contents of a column are sorted in ascending or
and Sort Order | descending order. If the contents of a directory are sorted by more than one
indicators column, a number indicates the sort order. For more information, see Sort a

Directory.

7 Status Use the default Status or the Status Summary column to determine if a
contact is available to take a call. Several other status columns are available,
including Status Notes and Time in Status. For more information, see
Customize Columns.

8 Content Some columns enable you to display a content tooltip for more information

tooltip than can appear in a narrow column. A tooltip can also provide additional
information.
Logged On tooltip: In this example, the tooltip for the Logged On column
explains the icon. When a user is logged on the name of the station where the
user is logged on. The station name appears if that user is logged on to the
same IC server as you. If the selected user is logged on to a different IC server,
the tooltip shows the name of the IC server.

9 Horizontal and | A horizontal scroll bar appears if the total width of the columns exceeds the
Vertical scroll space available in the browser window.
bars A vertical scroll bar appears if all the entries in a single view cannot be

displayed in the space available.

10 | View This section describes the contents of the current view and lists the total

128



Search a Directory

description number of entries in the directory or search results. In this example, entries 1
through 15 appear in the current view and there are a total of 27 entries in
these search results.

11 | Choose Use the Choose Columns control to add or remove view columns from the
Columns current directory.
control

12 | Paging A large directory or set of entries is displayed in a paged format. The First,
controls Previous, Next, and Last Page controls enable you to navigate from one page

to another in the directory.

13 | Directory Use the Directory toolbar to manage your contacts and interactions with those
toolbar contacts. For more information, see Using the Directory Toolbar.

Related Topics

Add or Remove View Columns

Click to Dial a Directory Contact
Customize Columns

Display a Speed Dial View

Directory Properties Dialog Box
Search a Directory

Transfer a Call to a Directory Entry
Working with Other Directories
Working with the Company Directory

Search a Directory

The CIC client uses a paged format to display large directories. Paging controls enable you to navigate from one page
to another in the directory and locate a specific directory entry.

To search for a directory entry:

Enter the first few letters of the column entry (if it's alphabetical), or enter the first few numbers (if it's
numerical) in a search field. Columns that you cannot use for searches are indicated by "grayed out" search
fields.

Search for all combinations of specific letters by using * for a wildcard match. For example, use *ob to find all
entries containing, but not necessarily beginning with, ob.

Use the question mark (?) to represent one unknown character. For example, use ?ng to locate all entries
beginning with any character where the second character is n and the third character is g.

Press Esc to clear all entries from the search fields.
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Search Fields Context Menu

The context menu enables you to use the Windows clipboard to copy and paste text in the search fields. You can also
send directory contact information to Microsoft One Note. Or you can create a Google toolbar button for the CIC
client.

Company Directory

Sam x | |
Log First Name Lndo E
o Samuel Cut i
®  Samuel C £ (
M Sami =oPY I
® am Paste P
® Sam Delete P
o Sam C
® sam Send to OneMote =
Select all
+ Generate Custom Search...

Related Topics

View and Edit Directory Entries
Working with Directories

Sort a Directory

You can sort a directory by clicking on almost any column heading. An ascending sort is indicated by an upward-
pointing triangle in the column heading. A descending sort is indicated by a downward-pointing triangle in the
column heading. Sort order is indicated by a number next to the triangle in the column heading. For more
information, see Sort Direction and Sort Order indicators.

Click a column heading once to sort the directory in ascending order.
Click again to sort the directory in descending order.

To sort by multiple columns, press and hold SHIFT and then click selected column headings to add them to
the sort.

Related Topics

Add or Remove View Columns
Search a Directory
Working with Directories

Insert and Delete Directory Entries

Requirements: The Directory Administrator Security right enables you to edit public directories belonging to other
users.

When you have the appropriate rights, as in the IC Private Contacts directory, you can insert and delete directory
entries.
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View and Edit Directory Entries

The several tabs of the Properties dialog box can contain:

Name, title, department and company

Home, business, cell phone, pager and fax numbers

Home and business street addresses

Home and business email addresses

Business website address

Assistant’s name and phone number

Notes

View and Edit Directory Entries

In some cases, where you have sufficient rights, as in the IC Private Contacts directory, you can edit directory entries.

To view or edit directory entries:

1. Select a directory entry.

2. On the Directory toolbar, click the Properties button.

Result: The Properties dialog box appears.

Properties For Joe Jones X

Genera | Business || bdore Business || Haome || Mates |

First Mame |.|-DE' |
Last Mame |Jones |
Dizplay Mame | |
Company | |
Home Phone \(317) 355-2134 | Ext| | | iat |

Auto Dial Extension
Business Phone \(317) 555-9090 | Ext| | | piai

Auto Dial Extension
Mobile | | Ext| | [ Dia

Auto Dial Extension

Delete Save ] [ Cancel

3. Make any necessary changes and click Save.

Phone Numbers

131



Interaction Client Web Edition Printable Help 2016 R4

You can precede a phone number with a comma to create a 2-second pause before the number is
dialed when you click the phone number hyperlink. Also, the 2-second pause occurs when you
"blind transfer" a call by dragging and dropping a call on a name in a directory.

If you select Auto Dial Extension, when you click to dial this phone number in a directory view, it
automatically dials the extension too. For more information, see Click to Dial a Directory Contact.

If you want to auto dial both the phone number and extension in this Properties dialog box, click
the Ext. hyperlink.

Related Topics

Insert and Delete Directory Entries
Properties Button on the Directory Toolbar
View and Edit Interaction Properties

Working with Other Directories

Requirements: The View General Directories Access Control right determines which General Directories you can
display. The View Workgroups Access Control right determines which Workgroup Directories you can display.

Directories other than the Company Directory also can be viewed in the CIC client. These directories include general
(public and private contacts in address books) and workgroup directories. To display additional directories, see Add or
Close Views.

Related Topics

Camp on an internal extension

Change User’s Status button

Make a Call Using a Dial Button

Search a Directory

Transfer a Call to a Directory Entry
Transfer a Call Using the Directory Toolbar
View and Edit Directory Entries

Working with the Company Directory

The Company Directory contains contact information for every person in your company. For more information about
using directory entries to make managing your interactions easier, see Working with Directories.

Related Topics

Add or Close Views

Camp on an Internal Extension
Customize Columns

Set Another User’s Status

Transfer a Call to a Directory Entry
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Working with Email Messages

View and Edit Directory Entries
Working with Directories

Working with Email Messages
Working with Email Messages

Requirements: To work with email messages, you or the workstation you select when you log on need an ACD
Access License associated with the Email interaction type. To pick-up and read ACD-routed email messages, you
must belong to a workgroup configured in Interaction Administrator to receive email messages. To create an
outbound email interaction, you also need the View User Queues or Modify User Queues right to your own user
queue. To create an outbound email interaction, you also must be a member of a workgroup configured with an
outbound email mailbox. If you have any questions about licensing and workgroup configuration, see your CIC
administrator.

You can use the CIC client to read and respond to ACD-routed email messages or to send email messages on behalf
of a workgroup. You can also use a directory entry to address an email message and then send it using your own
email program. There are several different types of email messages associated with the CIC client:

ACD-routed email message

An ACD-routed email message is sent to a mailbox associated with a workgroup. This message is then routed
to the workgroup members as an interaction. Like any other interaction, an ACD-routed email message can
be included in Customer Interaction Center reports and statistics. You can pick up an ACD-routed email
message from My Interactions.

Reply to an ACD-routed email message

A reply to an ACD-routed email message is an interaction that is processed and sent from the CIC client. Like
any other interaction, these email message replies can be included in Customer Interaction Center reports and
statistics.

Email message sent on behalf of a workgroup

You can create and send an email message on behalf of a workgroup to which you belong. This interaction
can be included in Customer Interaction Center reports and statistics.

Sending an email interaction is not the same as replying to an ACD-routed email message, in that you begin
the interaction. Nor is it the same as using a CIC directory entry to address an email message that you send
using your default email program.

Email message addressed by using a CIC directory entry

You can use a directory entry to address an email message, but send the message using your default email
program. This feature makes it convenient to send email messages to people and businesses represented by
directory entries. It requires that you have a correctly configured email program installed on your system. This
email message is not an interaction and is not counted or tracked in Customer Interaction Center reports and
statistics.

Related Topics

Email Configuration
Email Interactions
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Email Interactions

An email icon identifies an email interaction in My Interactions. The reply to an ACD-routed interaction appears
below the original interaction. The information includes the:

Email message subject
Name of the sender
How long the interaction has been in the queue

Name of the Workgroup queue to which it is assigned

Interaction ID

—% — Interaction Client web edition Mewv | Vieww Optionsy Helpy
My Interactions i3l ) a “ ‘ | ‘l'l | Make Call |
problem logging in to my account From Jehn Smith Support
18:54:14 - ACD - Assigned: Jasoniv 1001583700
¢ RE: problem logging in to my account Replying to lohn Smith Support
k 0:47:56 - Connected 1001924702

When you pick up an email interaction, its state changes to ACD Assigned: (Agent name), and other agents
are not able to respond to the message. However, if the email interaction is transferred to you, or if you pick
it up even though you are a not a member of the workgroup to which the email interaction was routed, its
state changes to Connected.

As with all interactions, an email interaction remains in the workgroup queue unless a non-member of the
workgroup picks it up. If a non-member of the workgroup picks it up, it disappears from the workgroup
gueue.

Related Topics

Working with Email Messages

Email Window for Incoming Messages

When you view an ACD-routed email interaction, this Email window provides the necessary tools for managing the
interaction.
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= preblem logging in to my account - Interaction Client - Windows Internet Explorer EI
| A Reply :} Reply All | | .:l Forward | | ~ Pickup | ,; Hold | | X Disconnect @ Record Pause :ﬁ Private |ﬂ Assistance
From Snith, John Received: 12/3/2012 12:15 PMY¥| . Properties
To Helpdesk
Account Code
Cec
_ . | [=]
Subject problem logging in to my account
- Wrap-Up Code
I'm having trouble logging into my account. | posted a screen shot of the error below. | — | E“
Any suggestions?
Log
| Frefox © |

&= =

Interaction Client - Logon 12

12:16:33: Created email interaction.
:33: Offering

: Entered Workgroup Support

12:16:33: Acd email transferred to

m

& pegasus/WebClient/clientlogin.aspx Workgroup Queua:Support.

12:16:33: Acd email assigned to

Jason.iobley.
@--’ ¥ 12:1g:33: ACD - Alerting: Jason.Mobley
12:16:33: Alerting
12:16:33: Sent to user Jason.Mobley
12:16:41: Connected
L | 12:16:41: ACD - Assigned: JasonMobley
12:16:41: Acd email connected to
Jason.Mabley.

The authentication process failed. Your username and/or password i

UserID |flavia_user
Password |eeess

Host | flavia

&
®

8
©)
0

= | | » Notes.
< | I | 3 * Response Management

@—’ Iq,NZD-;&ssigned:lason.l’«ﬂoblr.--g,.I 1:09:30 | Support | 2001021009 Q}OgionSv{—

1 Toolbar The toolbar contains buttons for most of the functions for managing an
incoming email message.

2 From This area contains information from the incoming email message address fields.
To An Attached list appears here if any files are attached to the original ACD-
Subject routed email message. Click the attachment file name to download or view the
Attached file.

3 Email Text The text of the incoming email message.

4 Status bar The Status bar displays the ID number, duration and state of the incoming

email interaction.

5 Sidebar area The appearance of the sidebar area can vary based on your user rights. It
contains controls and information that are related to managing the incoming
email message.

6 Properties The Properties section contains the interaction log. Optionally, the Account
Code and Wrap-Up Code drop down lists also appear in this section.

Some companies categorize interactions by customer. If you have the
appropriate rights, you can assign an Account code to an incoming email
message. If you are a member of a workgroup for which Wrap-Up codes are
configured, you can use this drop-down list to assign the code.

7 Splitter Bar If you prefer not to see the sidebar area, click the splitter to hide that part of
the Email window. Click the splitter again to restore the sidebar area.
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) Notes Use the Notes section to add notes or comments about the incoming email
message.
9 Response Use the Responses section to search for and view both system-wide responses
Management and personal responses.

10 | Options Click this link to configure the default behavior of the Email window for
incoming messages. This includes options for automatically closing the window
and displaying the Cc and Bcc fields. See Email Configuration.

Related Topics

Add Notes to an Interaction

Assign Codes to an Interaction

Email Configuration

Email Window for Outgoing Messages
Understanding Account Codes
Understanding Wrap-Up Codes
Working with Email Messages

Email Window for Outgoing Messages

You use this Email window to either respond to an ACD-routed email message or start an email interaction on behalf
of a workgroup.



Email Window for Outgoing Messages

on C| do = Explo

E Save | ’j"’ Disconnect || @ Record | ]E Pause l@ Private ||E Assistance | @
From Helpdesk Add Cc Add BCC¢I } Properties I
To | Smnith, John X ¥ Notes

Subject |RE: problem logging in to my account ~ Response Management

s |

./ Pickup || 2 Hela |

t? Attach a file Search Docurr

BZU[rom [f[see[]A &=

You need to use your Interaction Administrator account name and password, not your
Windows user name and password.

m

————— Original Message-—--

From: Flavia_User

Sent: Monday, December 03, 2012 1:26:53 FM
To: Flavia_User

Subject: problem logging in to my account

@ 090 9

-

I'm having trouble logging into my account. | posted a screen shao

Any suggestions‘? Close original message window when replying or forwarding

Close compose window after message is sent

oo Show Cc field when composing a new message

: = = .
Interaction Client - Logen + Show Boe field when compesing a new message
r‘ B | B narare Ak Cliont lientinin aeny | Warmn when disconnecting an unsent email message
4 1

I=d] Connected | 0:00:45 | Support | 2001021010 | %% options - (—@

1 Toolbar The toolbar contains buttons for most of the functions for managing an email
reply.
2 Add Cc Click these links to add Cc (Carbon copy) and Bcc (Blind carbon copy) address
Add Bcc text boxes to your email reply.
3 From This area contains the standard email message address fields.
To - Inareply, the To field defaults to the sender of the original email
Subject message. Click the x at the end of the defaulted name to remove this

name and then type in a new name.

Tip: You can type in a partial name and then search for matching entries.

Subject defaults to the subject of the original email message.

4 Attach a file Click the Attach a file link to find and attach a file to your email reply. These
documents, images or other files can be located on your workstation or
network.
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Formatting
toolbar

The text formatting toolbar appears in the E-mail Reply window under certain
conditions:

If the original ACD-routed email message is formatted using HTML,
you have the option of using text formatting tools in your email reply.
For a description of the available tools, see Reply to an HTML Email
Message.

If you are creating an email message to send on behalf of a
workgroup, the text formatting tools are always available to you.

If the original email message was sent in plain text (no formatting),
the Email Reply window does not include a text formatting bar. Your
email reply is sent in plain text.

Reply

Compose your reply to the email message here.
You can:
Type a response.
Copy and paste text to or from a Windows application.

Locate and insert a Favorite Response or a system-wide response in
your reply. For more information, see Use Response Management in
an Email Message.

Original Email

The original ACD-routed email message appears here.

Status bar

The Status bar displays the ID number, duration and state of the interaction.

Sidebar area

The appearance of the sidebar area can vary based on your user rights. It
contains controls and information that are related to the email reply.

10

Properties

The Properties section contains the interaction log. Optionally, the Account
Code drop down list also appeatrs in this section.

Some companies categorize interactions by customer. If you have the
appropriate rights, you can assign an Account code to an incoming email
message. If you are a member of a workgroup for which Wrap-Up codes are
configured, you can use this drop-down list to assign the code.

11

Notes

Use the Notes section to add notes or comments about your email reply. The
recipients of the email reply message do not see these notes.

12

Response
Management

Locate and use a pre-defined system-wide or personal response. For more
information, see Use Response Management in an Email Message.

13

Splitter Bar

If you prefer not to see the sidebar area, click the splitter to hide that part of
the email reply window. Click the splitter again to restore the sidebar area.

14

Options

Click this link to configure the default behavior of the Email window for
incoming messages. This includes options for automatically closing the window
and displaying the Cc and Bcc fields. See Email Configuration.

Related Topics
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Email Window for Incoming Messages
Start an Email Interaction

Understanding Account Codes
Understanding Wrap-Up Codes
Working with Email Messages

Manage Email Messages

Add Notes to an Interaction

Add Notes to an Interaction

Use the Notes section in the appropriate interaction window to add notes or comments about the interaction.

Tip: For information about adding notes to a Call, see View and Edit Interaction Properties.

To add notes to an interaction:

1. In the Callback window, Chat window, Email window for Incoming Messages, or E-mail Window for Outgoing

Messages, expand the Notes sidebar.
2. Inthe text box, type your observations or comments and click Add Note.

Result: Your notes appear in the Notes sidebar in the interaction window.

F Properties

- Notes

Userd - 11/33/2012 11:23 AM
Checked customer record.

Asked forlog |~
file.

w

Add Mote

* Response Management

Related Topics

Respond to a Callback Request

Manage a Chat Session

Working with Chat Sessions

Assign Codes to an Interaction

Requirements: See Working with Account and Wrap-Up Codes.
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You can assign an Account Code or Wrap-Up Code to an interaction. The Account Code and Wrap-Up Codes drop-
down lists contain the codes defined in Interaction Administrator.

To assign codes to an interaction, do one of the following:

For an incoming email message, select the appropriate codes in the Email Window for Incoming
Messages.

For an outgoing email message, select the appropriate Account code in the E-mail Window for Outgoing
Messages.

When responding to a callback request, select the appropriate codes in the Callback Window.

During a chat session, select the appropriate codes in the Chat window.

Related Topics

Assign Codes to an Incoming Interaction
Assign Codes to an Outgoing Interaction
Email Editor

Email Preview

Email Window for Incoming Messages
Email Window for Outgoing Messages
Manage a Chat Session

Understanding Account Codes
Understanding Wrap-Up Codes

Forward an Email Message

ACD-routed email messages appear in My Interactions. You can forward these ACD-routed email messages to
another CIC user or workgroup. If the designated transfer recipient does not pick it up, the CIC server returns the
email message to your user queue and places it on hold.

Tip: You cannot forward an incoming email interaction until you send or disconnect all the email reply interactions
that are associated with the original email interaction in an E-mail conversation.

To forward an email message:
1. Pick up or reopen an email message.
2. In the E-mail Window for Incoming Messages, click the Forward button.

Result: The Email Window for Outgoing Messages appears. Also, this new email interaction is associated with
the original message and appears in My Interactions.

3. Address the email message by doing one of the following:

Tip: Click Add Cc or Add Bcc to add carbon copy or blind carbon copy address text boxes to the email
message.
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Forward an Email Message

In an address text box, type the addresses of the email message recipients, separating each address
with a semi-colon (;).

In an address text box, type all of part of the recipient’s name. Click the "Search for" prompt. Select
a name from the list of matching names.

To | rnarl
Subject [ Andrew Marshall o
Andrew Martin
) Andrew Martinez
B I U poparshal
Bob Martin
Bob Martinez
Catherine Marshall
_____ Origin: Catherine Martin ]
From: Fla® Catherineg Martinez
Sent: Tue Danarshall d 1
To:

4. Optionally, do one of the following:

If you do not want to forward files attached to the original email message, in Attached, click the x
next to any file name.

Click the Attach a file link to attach a file to the forwarded email message.

5. In the reply area, type any text you want to add to this forwarded email message.

Tip: Use Response Management to insert a stored response. For more information, see Use Response
Management in an Email Message. You can also use any of the available tools to format your message. For a
description of these tools, see Reply to an HTML Email Message.

6. Optionally, expand the Properties section and assign an Account code.
Tip: For more information, see Assign Codes to an Interaction.

7. Optionally, expand the Notes section and add notes or comments about this interaction.
8. Do one of the following:

To send this email to the addressed recipients, click Send.

To save this email message as a connected interaction, click Save.

Result: The email message is not sent. You can pick up this interaction later, make any necessary
changes or additions and then send it.

9. If necessary, close the Email windows for the forwarded email message and the original email message and
then disconnect the original email message.
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Related Topics

Working with E-mail Messages

Park an Email Message on Another Person’s Queue

You can park an ACD-routed email message directly on another CIC client user’s extension. This places the email
message on hold on the recipient’s My Interactions queue.

To park an email message using the Park on Queue button:

Select the email message. Select a directory entry and then, on the Directory toolbar, click the Park on Queue
button.

Result: The interaction is immediately removed from My Interactions or any other queue you are monitoring
and appears in the selected user’s queue.

To park an email message using the Transfer dialog box:
1. Select the email message and, on the Queue Control toolbar, click the Transfer button.
Result: The Transfer dialog box appears.
2. Inthe Transfer To: field, type all or part of the recipient’s name or number.

Result: A drop-down list of choices appears.

Tip: If the drop-down list does not contain the contact you expected, check the search criteria selected in the
Options drop-down list and adjust them if necessary.

3. From the drop-down list, select the appropriate contact name and associated extension or phone number.

Result: If the designated transfer recipient is a CIC user, status information appears. It shows whether the
transfer recipient is logged onto the CIC client and is able to accept the transferred email message.

4. Click the Park button.

Result: The call disappears from My Interactions and is placed on hold in the recipient’s My Interactions
queue so the recipient can select it later.

Related Topics

Park a Call on Another Person’s Extension
Park on Queue Button

Pick Up or Reopen an Email Message
Requirements: See Pickup.
You pick up or reopen an ACD-routed email message from My Interactions. Also, an ACD-routed email message may

open automatically, if your user information in Interaction Administrator is configured to Auto-Answer ACD
Interactions.

To pick up or reopen an ACD-routed email message, do one of the following:
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Reply to an Email Message

Double-click the email message.

Select the email message and click the Pickup button in the Queue Control toolbar.
Related Topics

Assign Codes to an Interaction
Forward an Email Message
Reply to an E-mail Message
Transfer an E-mail Message
Working with E-mail Messages

Reply to an Email Message

The tools available to you when replying to an ACD-routed email message depend on the format of the original
email. The instructions in this topic apply to all email message replies. If the original ACD-routed email message is
formatted using HTML, additional tools are available to you when composing your reply. For more information, see
Reply to an HTML E-Mail Message.

An email reply interaction can be associated with the original incoming email interaction in an Email Conversation.
These associated interactions appear indented below the original interaction.

Some important things about this relationship include:

More than one email interaction can be associated with the original incoming email interaction.

—%— Interaction Client web edition Logoff | Newv Viewv | Optionsv  Helpv
My Interactions g @ a l!‘ ‘ | ‘l'| | Make Call |
problem logging in to my account From John Smith Support
"3 16:54:14 - ACD - Assigned: Jasonbd 1001993700

< RE: problem logging in to my account Replying to lohn Smith Support
k (e47:36 - Connected 1001954702
< FW: problem | ing in to my account Forwarding to MaryJones@:xyz.com Suppart
e Y ST o 1001994383

You must disconnect the original incoming email interaction manually.

Tip: All of the associated outgoing email interactions must be disconnected, transferred or forwarded before
you can disconnect the original incoming email interaction.

To reply to an email message:
1. Pick up or reopen an email message.

2. In the E-mail Window for Incoming Messages, click the Reply or Reply All button.

Result: The Email Window for Outgoing Messages appears. Also, this new email interaction is associated with
the original message and appears in My Interactions.

3. Optionally, add addresses to the email reply by doing one of the following:

Tip: Click Add Cc or Add Bcc to add carbon copy or blind carbon copy address text boxes to the email
message.
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In an address text box, type the addresses of the email message recipients, separating each address
with a semi-colon (;).

In an address text box, type all of part of the recipient’s name. Click the "Search for" prompt. Select
a name from the list of matching names.

To | rnarl

Subject [ Andrew Marshall i
Andrew Martin

Andrew Martinez

Bob Marshall

Bob Martin

Bob Martinez

Catherine Marshall

| Catherine Wartin

From: Fla® Catherineg Martinez

Sent: Tue| Dan Marshall -k
To:

m
P
c

4. Optionally, click the Attach a file link to attach a file to your reply.

5. Inthe reply area, type your reply message.
Tip: Use Response Management to insert a stored response. For more information, see Use Response
Management in an Email Message. If the original email interaction was formatted in HTML, you can also use

any of the available tools to format your reply. For a description of these tools, see Reply to an HTML Email
Message.

6. Optionally, expand the Properties section and assign an Account code.

Tip: For more information, see Assign Codes to an Interaction.

7. Optionally, expand the Notes section and add notes or comments about this interaction.

8. Optionally, do one of the following to save the email message without sending it:
Click Save to save this email message as a connected interaction.
Close the email window to save this email message as a held interaction.

Result: The email message is not sent. You can pick up this interaction later, make any necessary changes or
additions and then send it.

9. To send this email message, click Send.

10. If necessary, close the Email windows for this reply email message and the original email message and then
disconnect the original email message.
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Reply to an HTML Email Message

Related Topics

Reply to an HTML E-Mail Message
Working with E-mail Messages

Reply to an HTML Email Message

If the ACD-routed email message you received was formatted using HTML, you have the option of using text
formatting tools in your email reply. You can also embed an image or include a hyperlink in your reply. In every other
way, replying to an HTML email message is the same as replying to a plain text email message.

Format Text

The HTML version of the Email Window for Outgoing Messages includes a text formatting toolbar.

1 ® @O 9
\ an

B I !|F-:unt |*||5i21E|'|-"":-v = |§

Tip: Point to any button to display a tooltip containing the name of the button.

Il
e
|
]

[

1 Font Use the font controls to bold, underline or italicize selected text. You can also select
text color, font and size.

2 | Text Use text indent controls to increase or decrease the space between the selected text
Indent and the left margin.

3 | Paragraph Use the paragraph controls to set left, right and center text alignment. You can also
create bulleted or numbered lists.

4 | Hyperlink Use the hyperlink control to create a working hyperlink in your email reply.

5 | Image Use the Image control to insert a picture in your email reply.

Create a Hyperlink

You can include a working hyperlink to a webpage in your email reply. Or you can create a link that automatically
generates an addressed email message in the recipient’s default email program.

To create a link to a webpage:
1. Do one of the following:
Select the text you want to display as the hyperlink and click the Link toolbar button.
Click the Link toolbar button.
2. Inthe Link dialog box, in Link Type, select URL.

3. In Protocol, select http or https, as appropriate.
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4. Type the address in the URL text box.

Link Type
URL |=|
Protocol URL
hitpsasS :I }‘ny.'nl’n.c-::mfs.Jpp-nrt,fpmductsfl'crmj[}ocumer'tation.-"iri
oK | | cance |
y
5. Click OK.

Result: This creates a clickable link in your email message that automatically opens a web browser to the
selected address.

To create a link that generates an email message:
1. Select the text you want to use as a link and then click the Link toolbar button.
2. Inthe Link dialog box, in Link Type, select Email.

In E-Mail Address, type the address where you want the email message to be sent.

> w

In Message Subject, type a subject that identifies the content or purpose of the email message.

5. In Message Body, type any text needed to further explain the content or purpose of this message.
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Reply to an HTML Email Message

Link Type

[E-mail ||

E-Mail Address
|,Iohr1.5rr'|'tr' @inin.com |
Message Subject

Support incident 21100 |
Message Body

Attached is the log file you requested,

ok || canca |

6. Click OK.

Result: This creates a clickable link that generates an addressed email message in the default email program
on the recipient’s system.

Insert an Image

To insert an image:
1. Place your cursor in the email reply at the point where you want the image to appear.
2. Click the Select an image to insert toolbar button.

Result: The Select Image dialog box appears.

Select Image *
Upload || URL |

Select a file from your computer to
insert into the message.

ﬁ Attach an image...

3. Do one of the following:

Select the Upload tab and click Attach an image. Locate an image on your workstation and click
Open.

Select the URL tab. In the text box, type the URL for the image and click Insert.
Result: The selected image appears in the email reply message.
Related Topics

Assign Codes to an Interaction

Email Window for Outgoing Messages
Pick Up or Reopen an Email Message
Reply to an Email Message
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Use Response Management in an Email Message
Working with Email Messages

Send an Email Message

There are two ways you can send email messages to addresses associated with your directory entries.

To send an email message:
Click any available email address hyperlink in a directory entry
Select a directory entry and click the Send email button on the Directory toolbar.

Result: An email address for the selected directory entry appears in the "To" line of a new email window in
your default email program.

Related Topics

Start an E-mail Interaction
Using the Directory Toolbar
View and Edit Directory Entries

Start an Email Interaction

Requirements: You need an ACD Access License associated with the E-mail interaction type in order to work with
email messages. Also, in order to send an email interaction, you must be a member of a workgroup configured with
an outbound email mailbox. You also need the View User Queues or Modify User Queues right to your own user
queue. For more information about licensing and workgroup configuration, see your CIC administrator.

An outbound email interaction is an email message you send on behalf of a workgroup. It can be included in
Customer Interaction Center reports and statistics. Additionally, as an interaction, it could be processed by any
custom email handlers that are added to your Customer Interaction Center installation.

Important points to consider:

Sending an outbound email interaction is not the same as replying to an ACD-routed email message sent to
a workgroup mailbox. You are initiating the interaction, not responding. For more information about
responding to an ACD-routed email, see Reply to an E-mail Message.

A reply to an outbound email interaction is addressed to the appropriate workgroup mailbox and is routed
as an ACD interaction. A reply would first appear in the appropriate workgroup queue and then be ACD-
routed to My Interactions.

You can use a CIC client directory entry to address an email message, but send the message using your
default email program. This is not an email interaction and is not counted in Interaction Center reports and
statistics. For more information, see Send an E-mail Message.

To start an email interaction:

1. From the New menu, select Email Message.
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Start an Email Interaction

2. If you belong to more than one workgroup or a workgroup configured with one or more outbound
mailboxes, select the appropriate workgroup and mailbox in the New Email Message dialog box. Click
Create Email Message.

New Email Message b4

Choose a workgroup and mailbox to start a mew
email interaction on behalf of that workgroup.

On Behalf OF

[proteus user Marketingg &

[ﬁmte&n.ﬂﬂessage][ Cancel ]

3. In the Email Window for Outgoing Messages, address the email message by doing one of the following.

Tip: Click Add Cc or Add Bcc to add carbon copy or blind carbon copy address text boxes to the email
message.

In an address text box, type the addresses of the email message recipients, separating each address
with a semi-colon (;).

In an address text box, type all of part of the recipient’s name. Click the "Search for" prompt. Select
a name from the list of matching names.

To | marl
Subject [ Andrew Marshall -
Andrew Martin
B Andrew Martinez
B I u Bob Marshall
Bob Martin
Bob Martinez
Catherine Marshall
_____ Origing Catherine Martin 3
From: Fla' Catherine Martinez
Sent: Tue| DanMarshall L
To:

4. Optionally, type a message description in the Subject text box.

5. Optionally, click the Attach a file link to locate and attach a file to this email message.

6. Inthe reply area, type your message.
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Tip: Use Response Management to insert a stored response. For more information, see Use Response
Management in an Email Message. You can also use any of the available tools to format your message. For a
description of these tools, see Reply to an HTML Email Message.

7. Optionally, expand the Properties section and assign an Account code.

Tip: For more information, see Assign Codes to an Interaction.

8. Optionally, expand the Notes section and add notes or comments about this interaction.

9. Optionally, do one of the following to save the email message without sending it:
Click Save to save this email message as a connected interaction.
Close the email window to save this email message as a held interaction.

Result: The email message is not sent. You can pick up this interaction later, make any necessary changes or
additions and then send it.

10. To send this email message, click Send.

11. If necessary, close the Email window for this interaction.

Related Topics

Reply to an E-mail Message

Transfer an Email Message

ACD-routed email messages appear in My Interactions. You can transfer these ACD-routed email messages to
another user or workgroup. If the designated transfer recipient does not pick it up, the CIC client returns the email
message to the workgroup queue.

Tip: You cannot transfer an incoming email interaction until you send or disconnect all the email reply interactions
that are associated with the original email interaction in an E-mail conversation.

To transfer an email message:
1. Pick up or reopen an email message.
2. On the Queue Control toolbar, click the Transfer button.
Result: The Transfer dialog box appears.
3. Inthe Transfer To: text box, type all of part of the recipient’s name or number.

Result: A drop-down list of choices appears.

Tip: If the drop-down list does not contain the intended recipient, check the search criteria selected in the
Options drop-down list and adjust them if necessary.
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Use Response Management in an Email Message

4. From the drop-down list, select the appropriate name and associated extension number.

Result: If the intended recipient is a CIC user, status information for the selected CIC user appears. It shows
whether the transfer recipient is logged onto the CIC client and is able to accept the transferred email

message.
5. Click the Transfer button.
Result: The transferred email message disappears from My Interactions and is routed to the selected recipient.
Related Topics

Working with E-mail Messages

Use Response Management in an Email Message
Requirements: See Working with Response Management for information about required rights.

You use stored responses to avoid typing the same information over and over again. You can search for a stored
response and insert it in an email reply or a forwarded email message.
To use a stored response when replying to or forwarding an email message:

1. In the E-mail Window for Outgoing Messages, do one of the following:

Expand the Response Management section, search for and then double-click an appropriate
response.

Tip: You can use full-text searching by entering terms in the Search Documents text box in the
Response Management section. For more information, see Search for a Response. Also, you can single-
click the response to preview it in the reply area.

In the reply area, type the response shortcut and press Ctrl+Space.

Result: The response is inserted in the email message.

If the response is a file, an Attached box appears and displays the name of the attached file. A
progress bar appears while a large file is being attached.

If the response is a message, the text appears in the email response section. When you use a stored
response created with the Inherited font, it adopts the font and font characteristics (size, color, and
so on) of the text immediately preceding it in your email message. However, when you insert a
response that has a selected font and other font characteristics, then the stored response appears
as originally formatted. For more information, see Create Personal Responses.

2. Make any necessary changes or additions and then click Send.

Related Topics

Search for a Response
Use Response Management for an Incoming Interaction
Working with E-mail Messages

Use Response Management for an Incoming Interaction
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Requirements: See Using Response Management for information about required rights.

When you respond to a callback request, you can use Response Management to look up information and then relay it
verbally. When you evaluate a callback request or read an ACD-routed email message, you can incorporate stored
text in the Notes section.

To use Response Management in an incoming interaction:
1. Do one of the following:
In the E-mail Window for Incoming Messages, expand the Responses section and search for an

appropriate system-wide response.

In the My Responses Window, use the Navigation Pane or other navigation aids to locate a
personal response or system-wide response.

Tip: For more information, see Search for a Response.

2. Do one of the following:

View the information in the response and use it indirectly when researching your reply to an email
message.

Copy and paste the information from the response to the Notes section of the E-mail window for
Incoming Messages.

Related Topics

Search for a Response
Use Response Management in an Email Message

Working with Faxes
Working with Faxes

Requirements: You need the TIFF Faxes Security right to receive faxes as TIF files attached to email messages. The
Web Client fax format option on your user account determines if you can select a fax from the Fax Viewer and view
it in a browser window.

With the CIC client, you receive faxes in the same place you receive email messages. Any time a caller sends a fax to
you, the fax is attached to an email message and sent to your email account.

Faxes are managed in one of these ways in the CIC client:

If Interaction Fax is installed on your workstation, you use the Interaction Fax viewer to view, edit, print,
compose and send fax documents. You receive faxes as I3F files.

If Interaction Fax is not installed on your workstation, you can receive faxes as TIF files and use the default
application set up in Windows for TIF files to view and print faxes.

If you display the Fax Viewer, you can view or download faxes and save them as files.

Related Topics
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Download a Fax

Fax Viewer

Open a Fax From Your Inbox
Send a fax

Use the Fax Viewer

View a Fax

Download a Fax

Requirements: The TIFF Faxes Security right and the Web Client fax format option on your user account
determine which file formats are available when you download a fax.

The Fax Viewer displays a list of your current faxes. You can use the Fax Viewer to save a fax to a file.

To download a fax:
1. Do one of the following:

From the My Interactions toolbar, click the Faxes button.
From the View menu, select Faxes.
Result: The Fax Viewer appears and displays the Faxes List.

2. Select a fax.

3. Click the Download button in the Fax Viewer.

4. If more than one file format is available, select one.
Result: The File Download dialog box appears.

5. Click Save.

Result: The Save As dialog box appears.

6. Inthe Save As dialog box, browse to a selected directory, accept or change the fax File name, then click
Save.

Result: The Save As dialog box closes and the file is saved in the selected directory.
7. Do one of the following:
Return to step 2 and select another fax.
Click the Fax Viewer Close button.

Click the Delete button in the Fax Viewer to delete the fax from both the Fax Viewer list and from
your email Inbox.

Related Topics

Fax Viewer
Use the Fax Viewer
View a Fax
Working with Faxes
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Open a Fax From Your Inbox

You can open a fax from your email program Inbox. You can forward the fax to another person, just as you would any
other email message. You can also set alerts for new fax messages.

Faxes can be managed in one of two ways depending on whether Interaction Fax is installed on your workstation. For
more information, see Working with Faxes.

To open a fax from your Inbox:

1. Open your email Inbox.
2. Open the email message containing the fax message.
3. Double-click the attached fax.

Result: If Interaction Fax is installed on your workstation, it opens and displays the fax.

Related Topics

Working with Faxes

Send a Fax

If Interaction Fax is installed on your workstation, you can send a fax from any Windows application that allows
printing.

To send a fax:
1. Open the Windows application and create the fax.
2. From the Windows application, print the fax.

3. Select Interaction Fax as the printer and click OK to print the fax.
Tip: If you are printing a PDF to Interaction Fax, be sure the option, Print to File, is not selected.

Result: The document is converted to a fax and appears in Interaction Fax.
4. Do one of the following:
In the Interaction Fax toolbar, click the Send Fax icon.

From the File menu, click Send Fax.

5. Inthe Send Fax dialog box, fill in the appropriate Recipients fields and click Send.
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6. After sending the fax, from the File menu, click Exit.
Related Topics

Open a Fax From Your Inbox
Working with Faxes

Fax Viewer
The Fax Viewer displays a list of your current faxes. It enables you to view or download faxes and save them as files.
To display the Fax Viewer:
1. Do one of the following:
Click the Faxes button.
From the View menu, select Faxes.
Result: The Fax Viewer appears and displays the Faxes List.

2. Click Refresh to display any new faxes received since you started the CIC client and also to update the
viewed/not viewed status of your faxes.

Related Topics

Download a Fax
Use the Fax Viewer
View a Fax
Working with Faxes

Use the Fax Viewer

Requirements: You need the TIFF Faxes Security right to receive faxes as TIF files attached to email messages. The
Web Client fax format option on your user account determines if you can select a fax from the Fax Viewer and view
it in a browser window.

Use the Fax Viewer to view a list of your received faxes and view or download the fax document.
Fax Formats
Your CIC administrator determines the format in which you receive or view faxes.

Faxes appear as email attachments in your email Inbox. These attachments can be in either the proprietary
I3F format or in the TIF image format.

Regardless of the format in which a fax arrives, your CIC administrator can enable you to view faxes in a
browser window in either PDF or PNG format.

Fax Viewer Features

This diagram illustrates the main features of the Fax Viewer.
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1 | Click the Faxes button to display the Fax Viewer.

2 | You can also select Faxes from the View menu to display the Fax Viewer.

3 | The Fax Viewer contains the Faxes List. It contains the faxes you have not yet deleted, including
both previously viewed and unviewed faxes.

4 | The currently selected fax.
Tip: In this example, the bright symbol on the opened envelope icon indicates a fax you have not yet
viewed.

5 | Select a fax and click View to display the fax in a browser window without having to switch to your
email application to find and view the fax.

6 | Select a fax and click Download to open or save the fax.

7 | Click Delete

8 | Click Refresh to display any new faxes in the Faxes List and also to update the viewed/not viewed
status of your faxes.
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Related Topics

Download a Fax
Fax Viewer

View a Fax
Working with Faxes

View a Fax

Requirements: The Web Client fax format option on your user account determines if you can select a fax from the
Fax Viewer and view it in a browser window. Contact your CIC administrator.

The Fax Viewer displays a list of your current faxes. If your user account is appropriately configured, you can view
faxes from inside the CIC client.

To view a fax using the Fax Viewer:
1. Do one of the following:

In the My Interactions toolbar, click the Faxes button.
From the View menu, select Faxes.
Result: The Fax Viewer appears and displays the Faxes List.
2. Select a fax.
3. Click the View button in the Fax Viewer.

Result: The fax appears in a new browser window.

Tip: If the View button is not available, then the Web Client fax format option is not enabled on your user
account or it was not enabled at the time you received the fax.
4. Close the browser window containing the fax.
5. Do one of the following:
Return to step 2 and select another fax.
Click the Fax Viewer Close button.

Click the Delete button in the Fax Viewer to delete the fax from both the Fax Viewer list and from
your email Inbox.

Related Topics

Download a Fax
Fax Viewer

Use the Fax Viewer
Working with Faxes
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Working with Generic Objects

Understanding Generic Object Routing

Some companies may incorporate tasks specific to their organization into the CIC client, and may implement the
ability to route these ACD queue objects to agents or users within a workgroup. While most interactions (phone calls,
emails, chat sessions, and so on) generally involve communication between two or more people, generic objects are
more task-based, unlike interactions that require some type of contact with another person.

For example, a generic object may include a request to author a knowledge base entry, a loan application for
processing, a CRM ticket, and more. Just as with any other interaction, you can pick up, transfer, disconnect, request
assistance with, or place on hold generic objects. Supervisors may view the status of individual tasks and team
members through Interaction Supervisor.

Working with Screen Pops

Site-Specific Screen Pops

Screen pops can open your browser to a specific URL when a specific event occurs. Let’s assume your CIC
administrator wants Internet Explorer to automatically launch one of your company’s web pages when you receive an
interaction in your ACD queue. If your administrator has configured the proper settings, including assigning the
website popup to various states of the interaction, such as ‘alerting’ in Interaction Administrator, then the appropriate
web page opens in a new browser window when the defined interaction enters your queue.

Working with Response Management
Working with Response Management

Requirements: To create and manage personal responses or to search for and use personal and system-wide
responses, you need the Response Management Security right. To use all or selected libraries of the system-wide
responses, you need the appropriate Response Management View Access Control Right. To use an interaction
attribute in a Response Macro, you need the Substitute Queue Columns Access Control Right.

In systems that were upgraded from previous releases, you can also see an older system-wide response library
named "Interactions" in the CIC client. Using responses from this older library requires specific Access Control
Rights; see View Interaction Files, View Interaction Messages, and View Interaction URLs.

Response Management enables you to use pre-defined items such as messages and stored files to handle
interactions more quickly. Your CIC administrator can create system-wide response items and organize them into
categories. Your CIC administrator can then grant the necessary rights for all or selected users to use a particular
library of response items. You can also create your own personal responses for information you type over and over
again in interactions with customers or for files you often send to customers.

You can:
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View, select, and use a stored response during a chat session or in a reply to an ACD-routed email message.
For more information, see Using Response Management.

Create your own stored responses for the information that you need most often. For more information, see
Create Personal Responses.

Response Organization

The organization of responses has three levels:

Library: A library (also called a server document) is the top-level collection of related response items. A
library contains individual response items (such as a standard greeting or statement of your typical business
hours) which can be organized into categories. There are two types of response libraries:

System-wide: The CIC administrator can create response libraries that are available to CIC client
users with the appropriate Response Management View Access Control Right. For example, your
CIC administrator could create a system-wide response library for Support representatives and a
general-purpose response library for all users. If you have the appropriate rights, these libraries
appear in the My Responses window.

Personal: You can also create a library of your own responses for the information that you use most
often in your job. These responses appear under the My Responses folder in the My Responses
window. For more information, see Create Personal Responses.

Category: A category is a folder in a response library. Categories are a way to organize individual response
items in a library. Categories are optional.

Item: An item is a single response. There are two types of response items:
Messages: Message items are stored text messages which can contain greetings, closings, and
standard responses to common questions.

Files: File items are computer files that you can attach to an email message or send to external chat
participants.

Related Topics

Creating Personal Responses
My Responses Window
Organize Personal Responses
Using Response Management

Using Response Management
Requirements: See Working with Response Management.

You use stored responses to avoid typing the same information over and over again. You can insert a response from a
system-wide or personal library of response items into certain types of interactions or view the information in a
response item during other interactions.

For more information about using Response Management in particular situations, see:

Use Response Management During a Chat Session
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Use Response Management for an Incoming Interaction
Use Response Management in an Email Message
Related Topics

Create Personal Responses

Organize Personal Responses

Search for a Response

Working with Response Management

Create Personal Responses
Requirements: See Working with Response Management.

You can create personal response items that contain information you often need when handling interactions. These
personal responses appear in the My Responses folder in the My Responses Window. You can arrange personal
responses in subfolders (categories). For more information, see Organize Personal Responses.

Note: Personal responses are private and are not available to other CIC clientusers.
You can create two kinds of personal responses:

Message

File
Personal Messages

Use messages to save standard text responses that you often use when interacting with customers. For example, you
can save a message that contains your typical office hours, phone number, and email address. You can then use this
response in a Chat or Email message and never have to type this information again.

Note: A stored message can contain a working URL hyperlink or an email message address.
To create a response message:
1.  From the View menu, select Response Management Editor.
Result: The My Responses window appears.
2. Click the My Responses folder or any of the folders under My Responses.
3. Click the Create new item toolbar button.
Result: The My Responses Editor appears.
4. In the composition area, do one of the following:
Type the text of the message.

Import an existing HTML file by clicking the Select HTML To Insert toolbar button. In the HTML
Import dialog box, locate an HTML file and click Open.

Tip: By default, the Open dialog box lists all the files in a directory. You can import only files with an
HTM or HTML extension.

5. Optionally, do any of the following in the My Responses Editor:
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Format the text: Use any of the text formatting tools.

Tip: The Font Name drop-down list defaults to Inherited. When you use a stored response created
with the Inherited font, it adopts the font and font characteristics (size, color, and so on) of the text
immediately preceding it in your email message. However, when you insert a response that has a
selected font and other font characteristics, then the stored response appears as originally formatted.

Add a link: You can create a clickable link to a URL or an email message address: Select some text
in your message and click the Link tool. In the Link dialog box, from the Link Type drop down list,
select URL or E-mail. Supply the necessary address and other information, as prompted.

Tip: If a URL is the only text in the message, it converts automatically to a hyperlink. The icon for this
stored response becomes the logo for the browser you are currently using.

Add an image: Select a place in your message and click the Image tool. Supply a URL ending in the
image file name. This URL must be accessible to your browser. Click OK.
Example: https://xyzcorp.com/Support/help/setup.gif

Add a Response Macro: Response macros automatically insert a constant like today’s date, an
interaction attribute such as the customer’s name, or another response item into your response at
the time you use it. See Create Response Macros for more details.

6. In the Name text box, type a name for this stored message.

Tip: Name identifies the response item, but does not have to be unique. If you do not provide a name, it
defaults to New Item.

7. In the Shortcut text box, type a short name, abbreviation, or code.

Tip: To insert a response item where needed, type the shortcut and then press Ctrl+Space. The shortcut does
not have to be unique. For example, you could use the shortcut "Hi" for all the variations of your standard

greeting.

8. In the Labels text box, type a space-separated list of words that identify or classify this response item.

9. Click Save.

Result: The new response item appears in the selected folder in the My Responses Window.

Personal Files

Personal files are pointers to files in a shared directory that is accessible to your web server.

To create a file response item:
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1. From the View menu, select Response Management Editor.

Result: The My Responses window appears.

N

Click the My Responses folder or any of the folders (categories) under this folder.
3. Click the Create new item toolbar button.

Result: The My Responses Editor appears.

e

Click Change to File.

5. In the Path text box, type the complete directory path and file name.

Result: The directory path and file name appear in the text box next to the Verify button.

o

Click Verify.
Result: This action verifies that web server can locate and access the file. One of two things happens:
If verification is successful, a green check mark appears next to the Verify button.

If it fails, the yellow warning triangle remains next to the Verify button. Confirm that the path is
correctly typed. Check with your CIC administrator that the file is in place in an appropriate
directory accessible to the web server.

7. In the Name text box, type a name for this file.

Tip: Name identifies the response item, but does not have to be unique. If you do not provide a name, it
defaults to New Item.

8. In the Shortcut text box, type a short name, abbreviation, or code for this response.
Tip: To insert a response item where needed, type the shortcut and then press Ctrl+Space. The shortcut does
not have to be unique. For example, you could use the shortcut "TS" for all your files containing
troubleshooting tips.

9. Inthe Labels text box, type a space-separated list of words that identify or classify this response item.

10. Click Save.

Result: The new response item appears in the selected folder in the My Responses Window.
Related Topics

Organize Personal Responses
Using Response Management
Working with Response Management

Create Response Macros
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Requirements: See Working with Response Management.

You can insert placeholder fields in a response item that are replaced when the response is used. Placeholder fields
can be replaced with a constant, interaction attribute or another stored response.

Macros take this form [field:data]. Field identifies the response macro type. Data is optional. There are three types of
macros: constant, attribute, and response.

Constant

Constant macros do not depend on the dynamic context of the interaction into which you are inserting it. Here are
the currently supported constants:

Example
Macro: My name is [UserName]. Today is [Date], how can | help you?
Result: My name is Mary Jones. Today is 9/15/2015, how can | help you?

Attribute

Attribute macros substitute a value of an attribute based on your current interaction. In the response item, Attribute
macros must have a field name of Attribute; data is the attribute name.

Example
Macro: Hello, [Attribute:Eic_ RemoteName]. How can | help you?
Result: Hello, John Smith. How can | help you?

Response

Response macros insert another response item into your response. If the substituted response contains macros, the
substituted response contains the appropriate values. Response macros must have a field name of Response. The
data is the Shortcut name for the specified response item.

Example
Shortcut for the inserted response item: signoff
Inserted response item: Again, my name is [UserName]. Thanks for chatting!
Macro: Glad to help. [Response:signoff]

Result: Glad to help. Again, my name is Mary Jones. Thanks for chatting!
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To create a response macro:
1. From the View menu, select Response Management Editor.
Result: The My Responses window appears.
2. Click the folder labeled with your name or any of the folders (categories) under this folder.
3. Click the Create new item toolbar button.
Result: The My Responses Editor appears.
4. With your cursor In the composition area, click the Select Macro To Insert toolbar button.

Result: The Macro Selection dialog box appears.

Select a macro to insert

System Macro

User Mame -
Date
Time

Attribute Macro

Account Code -
ACD Wait Reason @
Associated Process

Interaction Id &

Fesponse Macro

Carmrri My Fr
SEARCH LNWCLIMERTS |

5. Do one of the following:
To insert a constant, from the System Macro list, select a macro.

To insert an interaction attribute, from the Attributes list, select a macro.

To insert a stored response, in the Response Macro text box, type the name of a stored response

and press Enter.
6. Click Insert.
Result: The macro appears in the composition area of the My Responses Editor.
7. Optionally, insert more macros in the response item.

8.  When finished, in the Macro Selection dialog box, click the Close icon.

Related Topics

Create Personal Responses
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My Responses Editor

My Responses Editor

Requirements: See Working with Response Management.

To create and edit response items, use the Response Management Editor. It is a full-featured HTML editor with text
formatting tools for messages. You can import HTML files, insert Response Macros, create hyperlinks, and add images.
To access the Response Management Editor, in the My Responses window, select the My Responses folder and
do one of the following:

Click the Create new item (plus sign) toolbar button.

Navigate to an existing item and then click the Edit item (notepad) toolbar button.

- Interaction Client - Google Chrome
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For more information about creating or editing personal responses, see Create Personal Responses.

1 | Text The editor includes a full range of text formatting tools. Tooltips identify each of
formatting the tools.
tools
2 | Link Turn a selected word or phrase into a clickable hyperlink. You can create two
types of links:

URL: a link to an Internet address.

E-mail: A link that creates an addressed email message in the default
email program on the customer’s system. Optionally, you can supply
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the subject and standard text for this message.

3 | Image Insert images in any of the standard Windows formats, including JPEG, GIF, and
PNG. You control the image alignment within the message.

4 | Select Macro Insert placeholder fields that are replaced when the response is used with a
To Insert constant, interaction attribute or another stored response. For more
information, see Create Response Macros.

5 | Select HTML to Import an HTML formatted file into your response. You can import files with

Insert either an HTM or HTML extension.
6 | Editing pane Type, format, and edit your message here.
7 | Name Name identifies the response item, but does not have to be unique. If you do

not provide a hame, it defaults to New Item.

8 | Shortcut You can type the shortcut and press Ctrl+Space to insert the response item in a
chat or email reply.

9 | Labels Labels provide more search terms.

Related Topics

Create Response Macros

Create Personal Responses

My Responses Window

Search for a Response

Using Response Management
Working with Response Management

My Responses Window
Requirements: See Working with Response Management.

To create, edit, organize, and view response items and categories, use the My Responses window. It contains a
navigation pane and a preview pane.

To access the My Responses window:

From the View menu, select Response Management Editor.
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My Responses Window

(2 hittp://pegasus/20 - Interaction Client - W =rnet Explore
Home » My Responses
|Se"""""1 Cocuments Our IC Documentation Library is located here:

i) Quick Tips
SermETET L hitps://mv.1nin com/support/products/ic4(/Documentation/index htm

5] 13 Website

@ | ®

EEEE @

1 | Breadcrumb Navigate the hierarchy of response categories and locate a response or view the
Bar items in a category.

2 | Search To locate a specific response, use this full-text search box. For more information,
Documents see Search for a Response.

3 | Navigation To locate a particular response, click anywhere in this hierarchical view,
Pane expanding folders as needed. Both your personal and system-wide response

categories appear as folders in this tree view. Individual responses appear as
items in the folders.

Home

|Sea."-:.'1 Documents | I % I

) My Responsas
) Support

Requirement: You need the appropriate Response Management View Access
Control Right to use any of the system-wide response items.

4 | Toolbar Create and manage your stored responses. For more information, see Create
Personal Responses, and Organize Personal Responses.
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5 | Preview Pane The preview pane displays an HTML preview of a selected text message or the

directory path and file name of a selected file.

Related Topics

Working with Response Management

Responses Sidebar

The Response Management drop-down section appears in the sidebar area of the Chat window and the Email
Window for Outgoing Messages. For more information, see Use Response Management During a Chat Session or Use
Response Management in an Message.

To expand or collapse the Responses section, click the arrow on the section control. This section provides full-text
search capabilities for your personal responses and the system-wide responses to which you have the appropriate
Response Management View Access Control Right. Responses which match your search criteria appear here. For more
information, see Search for a Response.
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Related Topics
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Organize Personal Responses

Use Response Management During a Chat Session
Use Response Management in an Email Message

Organize Personal Responses
Requirements: See Working with Response Management.

You can make your personal responses easier to locate by storing them in folders. You can nest these folders inside
each other to whatever level suits your purpose.

To create a personal folder:
1. From the View menu, select Response Management Editor.
Result: The My Responses window appears.
2. Click the My Responses folder.
3. Navigate to the level where you want to create the folder (category).
4. Click the Create new category toolbar button.
Result: A new folder appears at the level you selected in the navigation pane.
5. Type a name for the folder in the New Category text box.

Working with Response Folders

You can perform any of the following actions when working with your personal folders in the Response Management
window.

§ Rename a folder by selecting the folder in the navigation pane and then clicking the Edit item toolbar
button. Type a new name for the folder.

§ Delete a folder along with any personal responses it contains by selecting the folder and then clicking the
Delete item toolbar button. Click OK in the "Are you sure you want to delete "folder name"? dialog box.

§  View the contents of a personal response by clicking the response item. Check the contents in the Preview
pane of the My Responses window.

Related Topics

Create Personal Responses

My Responses Window

Using Response Management
Working with Response Management

Search for a Response
Requirements: See Working with Response Management.

You can locate and use any personal response item or any system-wide response item to which you have rights in an
interaction.
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Full-Text Search

You can use full-text searching to locate a needed response item. Full-text searching looks for matching text in the
Name, Label, Shortcut, and text content of a response item. Full-text searching is available in:

The Responses sidebar in the Chat window and Email Window for Outgoing Messages.
The My Responses window.
To search for a response item:

1. Inthe Search Documents text box, type all or the first part of the word or words that identify the response
item and then click the Search button.

Tip: See Search Language for tips on constructing a multi-term search.

Result: Matching response items appear.
2. Do one of the following:
In the Responses sidebar in the Chat window, double-click a response item from the search results.

Result: The response item appears in the composition area. You can preview this content before
clicking Send.

In the My Responses window, select an item from the Search Results.
Result: The response item appears in the Preview pane.

Search Language

The Response Management search language is similar to that used in most common Internet search engines. Use this
search language in any Response Management Search text box.

Boolean Operators

You can use AND, OR, and NOT Boolean operators.
Foot OR Hand searches for items containing either of these words.
Foot AND Hand searches for items containing both words.
Foot NOT Hand searches for items containing foot, but not hand.

Exact Phrase

Enclose an exact phrase searches in quotation marks.
"Foot and Hand" searches for items containing that exact phrase.

Grouping
Enclose a grouped search in parentheses.
(Jack AND Jill) hill fell searches for items containing both Jack and Jill or the word hill or the word fell.

Fields

You can confine your search to the Name, Shortcut, or Labels fields on a response item.

Shortcut:update searches only for items with a shortcut field containing the word update or beginning with
update.
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Related Topics

Using Response Management

Use a Response Shortcut
Requirements: See Working with Response Management.

You can use a response shortcut to insert a stored response when you are participating in a Chat Session or
composing an Email Reply. Response shortcuts are available in the composition areas of the Email Window for
Outgoing Messages or Chat Window. Both system-wide and personal responses can have shortcuts.

Tip: You can assign a shortcut when you create or edit a personal response. For more information, see Create
Personal Responses.

To use a shortcut:
1. Type all or part of the shortcut and press Ctrl+Space.

Result: If there is only one matching response item, it is automatically inserted in the composition area of the
Chat window or the reply area of the Email Window for Outgoing Messages.

2. If there are multiple matching response items, do one of the following:
Select the appropriate response from the drop-down list that appears automatically.
Continue typing to narrow the search further and then select the appropriate response.

Press Esc to close the selection drop-down list.

Hella

Formal greeting

Related Topics

Using Response Management

Working with Speed Dial

Dial a Number Using Speed Dial

You can use the CIC client speed dial features to dial frequently used numbers. You can watch the status of your call
in My Interactions.

To dial a number using speed dial:
1. Display a Speed Dial View.
2. Do one of the following:
To call the default number associated with the speed dial entry, click the phone number.

To dial a number other than the default number for a speed dial entry, click the down arrow next to
the displayed phone number. Select and click a number in the list of other available numbers for
this speed dial entry.
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Tip: If you have more speed dial entries than can appear at one time on your speed dial view, use the scroll bar to
find the entry.

Related Topics

Create a Speed Dial View
Create a New Directory Entry in Speed Dials
Display a Speed Dial View

Working with Speed Dial Views
Working with Speed Dial Views

Requirements: You need the Can Create Speed Dials Security right to enable you to Create a Speed Dial View.

Speed dial views provide a quick way to dial frequently called contacts. The entries within a speed dial view show the
name, user status, and the default number for each contact.

Click the down arrow next to the default phone number for a contact. The list contains all the phone numbers
available for the selected contact. Click any of these numbers to dial.

Speed Dial x

Company Contacts Speed Dial List
Andrew Baylor " Dan Lee x| *
B} Avsiiabie B Avsiabie
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g]' Business Phone | Dafault ‘A-,m

5555 - § 9% ~
-
Manage Speed Dial List

When you create a speed dial view, you determine whether the view is private or public. Private speed dial views are
visible only to the person who creates the view. Public speed dial views are visible to everyone who uses a CIC client.

Related Topics

Create a Speed Dial View
Delete a Speed Dial View
Rename a Speed Dial View
Working with Speed Dial Entries
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Close a Speed Dial View

You can close a Speed Dial view at any time. Or you can keep it open and move it out of the way while you work in
the CIC client.

To close a speed dial view:

Click the X in the upper right corner of the Speed Dial view.

Result: The Speed Dial view no longer appears in your CIC client, but remains available for future use. Other
people who are displaying this Speed Dial view are unaffected.

Related Topics

Display a Speed Dial View
Working with Speed Dial Views

Create a Speed Dial View

Requirements: Your CIC administrator must create the appropriate Contact List Source before you can create a
Speed Dial view. Also you need the Can Create Speed Dials Security right to create a Speed Dial view.

A Speed dial view provides a quick way to dial frequently called contacts.
Warning: Once a Speed Dial view is created, its settings cannot be changed.

To create a Speed Dial view:
1.  From the View menu, select Speed Dial.

Result: One of the following occurs, depending on whether you last displayed a list of all your Speed Dial
views or a selected Speed Dial view.

The Speed Dial List appears. It contains the names of your currently selected Speed Dial views.

Speed Dial x

Speed Dial List
IE Users X
Vendors x
Writers ®
Department Heads X
Company Contacts E
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A Speed Dial view appears.
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Speed Dial X
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Manage Speed Dial List

2. Click Manage Speed Dial List.

Result: The Manage Speed Dial List dialog box appears. The names of all the current Speed Dial views
appear in this dialog box.

Manage Speed Dial List x

Available Items Selected Items ir ¥
Misc - Personal Speed Dial
My Speed Dial Home

My Speed Dials

P50 - App Dev KL

PSO - App Dev US

PS5O - App Dev US Remote
P50 - ICs

P50 - PMs @
PSO Pacific

P50 Systems Engineers
Phill

Phonelntl

Product Management
ReidF

SE
()] %)

ajo

3. Click the Create button.

Result: The New Speed Dial dialog box appears.
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Create a Speed Dial View

New Speed Dial x

Speed Dizl Name
| Department Heads |

Public
Select how other users may modify this speed disl
[@] Add Entries
[¥#] Change Entries
[[] Delete Entries

Renzme the Speed Dizl

—

4. In the Name: field, enter a unique name for your new speed dial directory.
5. If you want other users to be able to add your Speed Dial view to their CIC client interface, select Public.

6. If you decide to make the new Speed Dial view public, select the options you want to grant other users for
this Speed Dial view:

To enable other users to add additional entries to the Speed Dial view, select Add Entries.

To enable other users to edit the default number assigned to entries on this Speed Dial view, select
Change Entries.

To enable other users to remove entries from this Speed Dial view, select Delete Entries.

Tip: Use caution when granting others the ability to delete speed dial entries. Once someone removes
the last speed dial entry from a Speed Dial view, the system permanently deletes the Speed Dial view
and it cannot be recovered.

To enable other users to change the name of this Speed Dial view, check Rename the Speed Dial.

7. To create the Speed Dial view, click OK.
Result: The new view is added to the Selected Items list in the Manage Speed Dial List dialog box.
8. In the Manage Speed Dial List dialog box, click OK.
9. Do one of the following:
If an existing Speed Dial view appears, click Speed Dial List.
If the Speed Dial List appears, go to the next step.
10. In the Speed Dial List, select the name of the new Speed Dial view.

Result: The new Speed Dial view appears. It is empty.
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Tip: For more information about adding Speed Dial entries to this new view, see Add a Directory Contact to a
Speed Dial View.
Related Topics

Create a New Entry in a Speed Dial View
Display a Speed Dial View

Delete a Speed Dial View

Requirements: You can delete your own Speed Dial views. If the owner granted other users the "Delete Entries"
right, you can also delete a "Public" Speed Dial view. If you have Directory Administrator rights, you can delete any
Speed Dial view. For more information, see Create a Speed Dial View.

To delete a Speed Dial view:
1. Do one of the following:

In the My Interactions toolbar, click the Speed Dial button.

From the View menu, select Speed Dial.

Result: One of the following occurs, depending on whether you last displayed a list of all your Speed Dial
views or a selected Speed Dial view.

The Speed Dial List appears. It contains the names of your currently selected Speed Dial views.

Speed Dial x

Speed Dial List
IE Users ®
Vendors x
Writers ®
Department Heads X
Company Contacts E

Manage Speed Dial List

A Speed Dial view appears.
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2. Click Manage Speed Dial List.

Delete a Speed Dial View

Result: The Manage Speed Dial List dialog box appears. The names of all the current Speed Dial views
appear in this dialog box.

Manage Speed Dial List

Available Items

IE pub:

Firefox Pub

Chrome Pub

3.

Safan Pub
Firefox Users

IE Change
[ERenamel
Chirome Add
Chirome Change
Chrome Rename
Eafan Add
Safarni Change
Safarni Rename?
Firefox Chamge
Firefox Rename2

Selected Items

s

IE Uzers
‘Wendors
‘Writers

(7] 2¢)

(-]

Department Heads
Company Contacts

Select the name of a Speed Dial view from either the Available Items list or Selected Items list and click the

Delete button.

4. To confirm that you want to delete the selected view, click OK.

Result: The Speed Dial view is no longer available for any CIC client user.

Related Topics
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Working with Speed Dial Views

Display a Speed Dial View

Requirements: You can display any Speed Dial view you create. You can also display any “"Public" Speed Dial view.
For example, your CIC administrator or other co-worker could create a speed dial view for emergency numbers and
make it available for all CIC client users. For more information, see Create a Speed Dial View.

To display a Speed Dial view:
1. Do one of the following:
From the View menu, select Speed Dial.
Click the Speed Dial button.

Result: One of the following occurs, depending on whether you last displayed a list of all your Speed Dial
views or a selected Speed Dial view.

The correct Speed Dial view appears. You are finished.
The wrong Speed Dial view appears. Click Manage Speed Dial List and go to the next step.

The Speed Dial List appears. It contains the names of your currently selected Speed Dial views. Do
one of the following:

Click the name of the view you want to display. The view appears and you are finished.

If the name of the view you want to display does not appear here, click Manage Speed
Dial List. Go to the next step.

2. In the Manage Speed Dial List dialog box, do one of the following:

If the name of the view you want to display appears in the Selected Items list, select it and click
OK.

Select the name of the view from the Available Items list, click > to add it to the list of Selected
Items, and then click OK.

3. Inthe Speed Dial List dialog box, click the name of the view you want to display.

Result: The selected Speed Dial view appears.
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Speed Dial X
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Related Topics

Create a Speed Dial View
Close a Speed Dial View

Rename a Speed Dial View

Requirements: You can rename your own Speed Dial views. If the owner granted other users the "Rename the
Speed Dial" right, you can also rename a "Public" Speed Dial view. If you have Directory Administrator rights, you
can rename any Speed Dial view. For more information, see Create a Speed Dial View.

To rename a Speed Dial view:

1. Do one of the following:

In the My Interactions toolbar, click the Speed Dial button.

From the View menu, select Speed Dial.

Result: One of the following occurs, depending on whether you last displayed a list of all your Speed Dial
views or a selected Speed Dial view.

The Speed Dial List appears. It contains the names of your currently selected Speed Dial views.
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Speed Dial x

Speed Dial List
IE Users ®
Vendors x
Writers ®
Department Heads X
Company Contacts »

| Manage Speed Disi List

A Speed Dial view appears.
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2. Click Manage Speed Dial List.

Result: The Manage Speed Dial List dialog box appears. The names of all the current Speed Dial views
appear in this dialog box.
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Working with Speed Dial Entries

Manage Speed Dial List 4

Available Items

Firefox Pub
IE pub:
Chrome Pub
Eafan Pub
Firefox Users
IE Change
[ERenamel

Selected Items

s

IE Uszers
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‘Writers
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Company Contacts

Chirome Add
Chirome Change
Chrome Rename
Eafan Add

Safarni Change
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3. Select the name of a Speed Dial view from either the Available Items list or Selected Items list and click the
Rename button.

Result: The Rename Speed Dial dialog box appears.
4. In the Speed Dial Name text box, type the new view name and click Rename.
Result: The name of the Speed Dial view is changed in the Manage Speed Dial list for all CIC client users.
Related Topics

Working with Speed Dial Views

Working with Speed Dial Entries

Working with Speed Dial Entries

After you have established your speed dial view or views, you can add or delete entries. You can also change the
default number for an entry.

Related Topics

Add a Directory Contact to a Speed Dial View
Change a Speed Dial Entry Default Number
Delete a Speed Dial Entry

Add a Directory Contact to a Speed Dial View
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Requirements: You can add contacts to your own Speed Dial views. If the owner granted other users the "Add
Entries" right, you can also add contacts to any "Public" Speed Dial view. If you have Directory Administrator rights,
you can add entries to any Speed Dial view. For more information, see Create a Speed Dial View.

To add a contact to a Speed Dial view, select the contact on a directory view, then drag and drop it onto the Speed
Dial view.

Related Topics

Display a Speed Dial View
Working with Speed Dial Views

Change a Speed Dial Entry’s Default Number

Requirements: You change a contact’s default number in your own Speed Dial views. If the owner granted other
users the "Change Entries" right, you can change default numbers for contacts in any "Public" Speed Dial view. If you
have Directory Administrator rights, you can change a contact’s default number in any Speed Dial view. For more
information, see Create a Speed Dial View.

To change a speed dial contact’s default number:

1. Display a Speed Dial View.

2. Inaselected Speed Dial Entry, click the down arrow next to the displayed phone number.

Speed Dial x

Company Contacts Speed Dial List
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3. Click Default next to one of the available phone numbers.

Result: The selected phone number becomes the new default Speed Dial number and appears on the Speed
Dial entry. The icon on the speed dial entry changes to reflect the newly selected default number.
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Delete a Speed Dial Entry

Related Topics

Working with Speed Dial Views

Delete a Speed Dial Entry

Requirements: You can delete entries from your own Speed Dial views. If the owner granted other users the "Delete
Entries" right, you can also delete contacts from any "Public" Speed Dial view. If you have Directory Administrator
rights, you can delete entries from any Speed Dial view. For more information, see Create a Speed Dial View.

To remove a speed dial entry from a speed dial view:
Click the X in the upper right corner of the Speed Dial entry.
Related Topics

Working with Speed Dial Views

Speed Dial Features
Speed Dial entries for the CIC client users display these additional features:

Status Icon and label: A CIC client user’s status appears as an icon on the Speed Dial entry. The
accompanying label and a tooltip explain the user’s status.

e —
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Default number icon and link: Click this link to dial the default number for a contact. The icon identifies the
type of phone number. For more information, see Dial Buttons.

Other available numbers: Click the down arrow next to the default phone number for a contact to display
all the phone numbers available for the selected contact. Click the number icon or label for any of these
other numbers to call it.

Related Topics

Working with Speed Dial Entries
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Working with Speed Dial Views

Working with Status Settings

Setting Status

In the CIC client, you can set your status, set another user’s status, set status details and view another user’s status.
Set Your Status
Set Another User’s status

Set Status Details

View Another User’s Status

Related Topics

Possible Status Values
Set DND Status with Your Phone

My Status

The CIC client has a My Status section that enables you to set your current status and view or specify status details:

My Status |_a Available, Mo ACD ¥ | 0:45:00 Set status details
My Status drop-down The My Status drop-down list displays your current status and enables you to
list change your status. For more information, see Set Your Status.
Time in current status The time (hh:mm:ss) indicates how long you have spent in your currently

selected status. This can help you monitor how long you have been in a not-
available status such as "At Lunch," "Away from Desk," or "In a Meeting."

Set status details This displays any additional information you entered in Status Notes when you
set your current status. These status details can be viewed by other users in the
Company Directory or other directories that are set to display the Status column.
Or, if you did not specify any status details, a Set status details link appears.

Related Topics

Set Your Status
Set Status Details
Workgroup Statistics View

Possible Status Values
Requirements: The View Status Message right controls which statuses can be employed by users in specific

workgroups, users assigned certain roles, or even individual users. These status filters determine the status settings
available when you Set Your Status or Set Another User’s Status.
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Possible Status Values

The icons that appear for each status are configured in Interaction Administrator and may have been changed by your
CIC administrator.

The default status values are:

ACD - Agent Not Answering

At a Training Session

At Lunch

Available

Available, Follow-Me

This person is available at one of the numbers on a follow-me list. The caller can leave
a message or use follow-me routing to find the person and transfer the call.

Available, Forward

This person is available at a designated remote number.

Available, No ACD

This person is available for all non-ACD interactions.

Away From Desk

Do Not Disturb

Follow Up

Gone Home

In a Meeting

On Vacation

Out of the Office

Out of Town

Working at Home

S ERB2EPT © b HSRP

Related Topics
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Set DND Status with Your Phone
Set Your Status

Set Another User’s status

Set Status Details

Setting Status

View Another User’s Status

Set Another User’s Status

Requirements: You need the Change Status Users Access Control right for a specific user to be able to change that
user’s status.

You can set another user’s status in the Company Directory or other directory view.
To set another user’s status:
1. Select a user in the Company Directory and click the Change User’s Status button in the Directory toolbar.
Result: The Set Status dialog box appears.
2. Select a status from the drop-down list and enter other status information that is applicable.
3. Click OK.
Note: If you have questions about setting another user's status, contact your CIC administrator.
Related Topics

Possible Status Values

Set Status Details

Set Your Status

Setting Status

View Another User’s Status

Set DND Status with Your Phone

If you have a Managed IP Phone, you may be able to use the DND button on the phone to set your CIC user status to
"Do Not Disturb" or another selected status. Your CIC administrator must first enable DND Synchronization for you in
Interaction Administrator.

Depending on the type of IP phone you are using, the DND button can be either a named function key or a soft key
accessed through the phone’s menu. Check your phone’s user guide or see the Polycom Quick Reference Cards
available in the Quick Reference Materials section of the CIC Documentation Library.

In general, you press the DND button or soft key to activate Do Not Disturb status. Later, you can press the DND
button or soft key again to reset your CIC client status to your last available status or some other pre-configured CIC
status.

Related Topics

Managed IP Phone

Set Status Details
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Set Status Details

Depending on the status you select, you can set status details including status notes, forward number, and date and
time you will become available. The date and time information you enter is played for all your incoming calls while in

this status.

You can view other user’s Status Notes by adding this column to your Company Directory. For more information, see

Customize Columns.

To set status details:

1. Click the Set status details link next to the My Status drop-down list.

Result: The Set Status dialog box appears.

Complete the fields as described below:

Status

Select a status, if necessary, in the Status drop-down list.

Tip: For more information, see Possible Status Values.

Status Notes

Enter any additional information on your current status.

As a convenience, the notes from the last time you selected this status
appear in Status Notes. You can make any necessary changes to these
notes.

Requirements: You need the Status Notes right in order to create or
modify Status Notes.

Forward Number

This is enabled only for selected statuses such as Available, Forward.
Enter a telephone number to which calls can be forwarded.

Until Date
Until Time

Do any of the following:

Depending on the selected status, you may select the Until Date or
Until Time check box to use the default date and time.

Result: The current date appears in the Until Date field. The CIC
client automatically rounds the current time to the next whole hour,
and sets that time in the Until Time field.

To change the Until Date, select the check box and click in the text
box. Select a date from the displayed calendar.

To change the Until Time, select the check box, and click the drop-
down list arrow to select a different time.
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3. Click the OK button

Related Topics

Possible Status Values

Set Your Status

Setting Status

View Another User’s Status

Set Your Status

Status controls the announcement of your availability to people who call you. When your status is one of the "do not
disturb" statuses, callers hear your status, such as "Bob Jones is out of town." Then they are directed to your voice
mail to leave a message. Other CIC client users can view your status in Status column of the Company Directory.

To set your status:
1. Click the My Status drop-down list.

2. Select a status from the Status list.

3. Optionally, enter status details by clicking Set status details.
Related Topics

My Status

Possible Status Values

Set Another User’s status

Set DND Status with Your Phone
Set Status Details

Setting Status

View Another User’s Status

Status Notes
Requirements: You need the Status Notes Security right to create status notes.

Status notes provide additional information on a user’s status. You can create status notes when you set status details.
Also, you can add a column to display Status Notes in the Company Directory.

Related Topics

Customize Columns
Possible Status Values

Set Another User’s Status
Set Status Details

Set Your Status

Setting Status

View Another User’s Status
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Status Summary

Status Summary

Requirements: You need the View Directory Status Columns Access Control right to all or selected Status columns
to enable you to add Status columns to a directory view. View Directory Status Columns

You can add a Status Summary column to your Company Directory view. The Status Summary column displays icons
that enable you to tell at a glance if someone is available, logged onto the CIC client, and if they are on the phone.
For more information about adding a column to a directory, see Customize Columns.

The Status Summary column uses these icons:
The first icon corresponds to the user’s current status. For more information, see Possible Status Values.

The second icon indicates whether the user is logged onto the CIC client. A check mark means the user is
logged on; an X means that the user is not logged on.

A phone receiver icon appears in the third position if the user is currently on the telephone. If the user is not
on the phone, the third position is blank.

Related Topics

Possible Status Values

View Another User’s Status

Requirements: You need the View Directory Status Columns Access Control right to all or selected Status columns
to enable you to add Status columns to a directory view. View Directory Status Columns

You can determine if a person is available to take a call by checking that user’s status. Status information appears in
the Status column of the Company Directory or workgroup directory.

Tip: You can add the Status or Status Summary columns to your Company Directory view.

Related Topics

Add or Remove View Columns
Camp on an Internal Extension
Possible Status Values

Set Another User’s Status

Set Status Details

Set Your Status

Setting Status

Working with Voicemail
Working with Voice Mail

Requirements: If you are assigned the Receive Voicemail Security right, callers are sent to voice mail when you are
in a DND status (Gone Home, Out of the Office, or some other "not available" status) or when you do not answer
your phone.

With the CIC client, you receive voice mail in the same place you receive email messages. Any time a caller leaves a
voice mail message for you, the voice mail message is attached to an email message and sent to you. You can open
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your voice mail messages as email message attachments or you can listen to voice mail from the Voicemail Viewer in
the CIC client.

Voice mail is managed in one of these ways in the CIC client:

If Interaction Voicemail Player is installed on your workstation, when you open an email message that has a
voice mail attachment, the CIC voice mail form opens and begins playing your voice mail message.

If Interaction Voicemail Player is not installed on your workstation, you open the email message and double-
click the voice mail attachment, then your designated audio player (for example, Microsoft Media Player)
opens and begins playing your voice mail message.

You can use the Voicemail Viewer to display and listen to voice mail messages.

You can listen to and manage your voicemail messages by using the voice mail features on your telephone.

Related Topics

Interaction Voicemail Player Controls

Listen to Someone Leave a Voice Mail Message
Open a Voice Mail Message From Your Inbox
Overview of Interaction Voicemail Player

Pick Up a Call From Voice Mail

Transfer a Call to Another Person’s Voice Mail
Transfer a Call to Your Voice Mail

Voicemail Viewer

Overview of Interaction Voicemail Player

When a caller leaves a voice mail, it is stored as a .wav file. You can access this voice mail message:
From the Voicemail Viewer
From the telephone user interface (TUI)
By playing the.wav file with Interaction Voicemail Player

Installing Interaction Voicemail Player

The Interaction Voicemail Player is an optional feature. You install Interaction Voicemail Player as part of the
Interaction Center User Applications Setup. For more information, see the IC Installation and Configuration Guide.

Configuring Interaction Voicemail Player

You determine if Interaction Voicemail Player is your preferred application for playing back voice mail messages. You
can also configure several options that control what this form does.

To configure voice mail playback, in Interaction Voicemail Player, from the Tools menu, select Options.
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Interaction Voicemail Player Controls

Tip: For more information about other configuration options, see the Interaction Voicemail Player Help.

Using Interaction Voicemail Player

When someone leaves a voice mail for you, CIC sends an email message to you with the voice mail.wav file attached
to it. This message appears in your email client (e.g., Microsoft Outlook, Microsoft Outlook Express, Lotus Notes, etc.)
with an attached.wav file. When you play this attached file, by double-clicking it or downloading it and then opening
it, the voice mail message plays in the Interaction Voicemail Player. If you are using the Interaction Message Store, just
double-click the voice mail.wav and the Interaction Voicemail Player plays the message.

The Interaction Voicemail Player not only plays voice mail messages but also allows you to control the playback of the
message and your indicator light. It also allows you to play voice mail messages back to devices such as PC speakers,
a station phone on your desk or to a remote telephone number.

Interaction Voicemail Player and .wav files

Each voice mail .wav file has information embedded in it signifying it is a voice mail message. When you open a voice
malil file, Interaction Voicemail Player reads this information, determines it is a voice mail message and plays the file.
When you open any other .wav files on your computer, the file does not have the voice mail designation. It opens in
your default .wav player (e.g., Microsoft Media Player).

Interaction Voicemail Player allows you to:
Play voice mail messages directly from electronic mail.
Control the playback of voice mail messages.

Clear a message waiting indicator light
Tip: For more information, see the Interaction Voicemail Player Help.

Related Topics

Interaction Voicemail Player Controls
Open a Voice Mail Message From Your Inbox

Interaction Voicemail Player Controls

nteraction Waoicerail Player
File Tools Help
Play To: ’F'C Speakers T]
|
D O «bdhp @ —== AN
0:00:00 / 0:01:14 i& Connected

The Voicemail Player controls function like MP3 or tape player controls for voice mail playback.

Control Definition

Play To: |PC Speakers w Select the device to play your voice mail.
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PC Speakers

Selecting a playback other than PC Speakers may result in slower startup
times.

Remote Telephone

Selecting this device causes CIC to dial the specified number and play the
voice mail.

Tip: If the remote telephone is a DID phone number enabled for fax
detection, CIC plays the voice mail immediately after calling the number
and does not wait until you pick up and answer. If you miss the
beginning of voice mail playback, you can use the Voicemail Player
controls to stop and restart the voice mail playback from the beginning.
Or you can ask your IA administrator to disable fax capability on your
User record.

A\

Click to play the voice mail.

[—===]
=

Click to pause playback.

Click to stop playing the voice mail.

Click to rewind 5 seconds.

Click to fast forward 5 seconds.

Click to mute playback.

Set the slider to the desired volume.

E’Dl0¥ﬁﬁ

Set the slider to the desired playback speed. The speeds available are half
speed (0.5), normal speed (1.0), one and half times speed (1.5), and double
speed (2.0).

Related Topics

Use the Telephone Dial Pad to Control Playback

Listen to Someone Leave a Voice Mail Message

Requirements: See Listen.
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Open a Voice Mail Message From Your Inbox

You can listen to someone leaving a message before deciding if you want to pick up a call. The person leaving the
message does not know that you can hear them.

To listen to someone leave a voice mail message:

1. Select a call from My Interactions that is in a state of ‘Voice Mail'.
2. On the toolbar, click the Listen button.

Result: Through your telephone handset you can now hear the person leaving a voice mail message. If you
want to talk with the caller, click the Pickup button.

Warning: Interactive Intelligence, Inc. disclaims any responsibility for end-user or licensee to comply with federal or
state law restrictions regarding Record, Snip, or Listen capabilities of CIC software. The licensee hereby warrants and
represents that the end-user or licensee will use the product in compliance with any federal or state law.

Related Topics

Listen Button

Listen to Your Voice Mail

Pick Up a Call From Voice Mail

Transfer a Call to Someone Else’s Voice Mail
Transfer a Call to Your Voice Mail

Open a Voice Mail Message From Your Inbox

You can play, replay, rewind, fast forward, save, and change the volume of the message by opening your voice mail
message in your email program Inbox. You can forward the message to another person, just as you would any other
email message.

Tips

By default, voice mail messages begin to play automatically through the device you selected for your last
voice mail. If you want the voice mail messages to play only when you click the Play button, in the Interaction
Voicemail Player application, from the Tools menu, select Options and clear the Play voice mail
automatically on open check box.

DirectX is required to play voice mail messages through your PC speakers.

You can configure the alerts you receive for new voice mail messages. For more information, see Voice Mail /
Fax Paging.

You can listen to and manage your voice mail messages by using the voice mail features on your telephone
in addition to features in the Interaction Voicemail Player.

Your Customer Interaction Center system may be integrated with the Yap=® voice mail preview service. In this
configuration, a voice mail-to-text version of the message appears in the email to which it is attached. This
provides a convenient approximation of the voice mail message content, but is not a replacement for
listening to the message.

To listen to your voice mail through your Inbox:

1.  Open your email program Inbox.

2. Open the email message containing the voice mail message.
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3. Double-click the voice mail message.

Result: You use either the Interaction Voicemail Player or your selected media player to play back your

message.
File Tools Help
Play Ta ’F‘C Speakers v]
|
D O <«bp @ —= AN
0:00:00 / 0:01:14 i Connected

Related Topics

Interaction Voicemail Player Controls

Pick Up a Call from Voice Mail
Requirements: See Pickup.

You can pick up a call when the caller is in the middle of leaving a voice mail message. When a call is transferred to
voice mail, its state changes to "Voice Mail."

To pick up a call from voice mail:
1. If the telephone call is not selected, select the call you want to pick up.
2. Click the Pickup button.
Result: The call’s state changes from "Voice Mail" to "Connected" and you can begin speaking with the caller.
Related Topics

Listen to someone leave a voice mail message
Listen to your voice mail
Pickup Button

Transfer a Call to Another Person’s Voice Mail

You can transfer a call directly to another CIC client user’s voice mail. You might want to use this feature if the caller
wants to communicate with another person who is unavailable to take the call.

To transfer a call to another person’s voice mail using a directory:

1.  While the call is selected in My Interactions, inform the caller that he or she is going to be transferred to
another person’s voice mail.
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2.
3.

Transfer a Call to Your Voice Mail

Locate and select the directory entry to which you want to transfer the call.
On the Directory toolbar, click the Voicemail button.

Result: The call is transferred to the recipient’s voice mail and its status changes to Disconnected in My
Interactions.

To transfer a call to another person’s voice mail using the Transfer dialog box:

1
2.

Select the call and inform the caller that he or she is going to be transferred to another person’s voice mail.
On the Queue Control toolbar, click the Transfer button.

Result: The Transfer dialog box appears.
In the Transfer To: field, type all or part of the recipient’s name or number.

Result: A >drop-down list of choices appears.

Tip: If the drop-down list does not contain the contact you expected, check the search criteria selected in the
Options drop-down list and adjust them if necessary.
From the drop-down list, do one of the following:
Select "Dial [your entry] as Digits" to convert a text entry into numbers.
Select the appropriate contact name and associated extension or phone number.

Result: If the designated transfer recipient is a CIC user, status information appears. It shows whether the
transfer recipient is logged onto a CIC client and is able to accept the transferred call. This can help you decide
what kind of call transfer to use.

Click the Voice Mail button.

Result: The call is transferred to the recipient’s voice mail and its status changes to Disconnected in My
Interactions.

Related Topics

Transfer a Call After Consulting the Recipient
Transfer a Call Using a Transfer Button

Transfer a Call Without Consulting the Recipient
Transfer Button

Voicemail Button

Transfer a Call to Your Voice Mail

Rather than answer an incoming (alerting) call, you can transfer it to your voice mail. You can also send a call to which
you are connected to your voice mail.

To transfer a call to your voice mail:

Select the call, if it is not already selected, then on the Queue Control toolbar, click the Voicemail button.

Result: The call is transferred to your voice mail. When a caller has finished leaving a message, the voice mail
is saved as a file, attached to an email message and sent to you. You can also listen in on the call as the caller
leaves a message, and then decide whether or not to pick up that call from voice mail.

Related Topics

Transfer a Call to Another Person’s Voice Mail
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Voicemail Button

Voicemail Viewer

The Voicemail Viewer displays a list of your current voice mail messages. It includes a playback interface that enables
you to listen to your voice mail messages on your phone. For more information, see Use the Voicemail Viewer.

To display the Voicemail Viewer:
1. Do one of the following:
Click the Voice mail button.
From the View menu, select Voicemails.
Result: The Voicemail Viewer appears and displays the Voicemails List.
2. Click Refresh to display any new voice mail messages received since you started the CIC client.
Related Topics

Use the Voicemail Viewer
Working with Voicemail

Use the Telephone Dial Pad to Control Playback

You can use the telephone dial pad to control voice mail playback if you are playing a voice mail to your telephone
handset or to a remote number. You can use these keys in place of the controls available in the Interaction Voice Mail
Player or the Voicemail Viewer.

To

Slow down playback.

Speed up playback.

Rewind message 6 seconds.

Fast forward message 6 seconds.

Decrease volume.

SEEIEIESE

Increase volume.

Related Topics

Interaction Voicemail Player Controls
Use the Voicemail Viewer

Use the Voicemail Viewer
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Use the Voicemail Viewer

Use the Voicemail Viewer to display a list of your current voice mail messages. You can use the integrated voice mail
player to play back voice mail messages to your phone or delete old voice mail messages.

Voicemail Viewer Features

This diagram illustrates the main features of the Voicemail Viewer.

Newv Viewy Oplionsv Helpv

[ 145
Admin, IndyHQIC Today, 2252 PM  *
@_) @ IC Voicemail: from Joe Smith (317) 999 -D'EI'EID@ - 41 seconds
|>_ Smith, Lea Today, 2:34 PM
—= IC Voicemail: from Lea Smith 5757 - 12 seconds
-yg Admin, IndyHQIC Today, 227 PM | _
(:3) r}__ IC Voicemail: from Sonya Smith 1 (575) 555-4-3'29[@ - & seconds ST e
Admin, IndyHQIC Today, 2:21 PM
P& IC Voicemail: from Indianapolis IM (317) 555-E551@ - 4 seconds
@_) gg Admin, IndyHGQIC Today, 2211 PM | )
= IC Voicemail: from loe Smith (317) 9949 -&99-3@ -12 seconds o E
©_)[b- Play| | Stoo | | 3 Delete | & Refresn |«{ 8)
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1 | Select the Voicemail button to display the Voicemail Viewer.

2 | You can also select Voicemails from the View menu to display the Voicemail Viewer.

3 | The Voicemail Viewer contains the Voicemails List. It contains the voice mail messages you have
not yet deleted, including both previously played and unheard voice mail messages.

4 | The currently selected voice mail message appears shaded. You can use the Voicemail Player
controls to Play or Delete the currently selected voice mail message.

Tip: In this example, the bright symbol on the opened envelope icon indicates an unheard voice mail
message.

5 | A plain opened envelope icon indicates that you have already listened to this voice mail message.

6 | Use the Voicemail controls to start voice mail message playback, stop playback or delete the
selected voice mail message or voice mail notification.
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7 | A vertical scroll bar appears if you have more voice mail messages than can be displayed at one
time.

8 | Click the Refresh button to display any new voice mail messages in the Voicemails List and also to
update the status of your voice mail messages.

To play back voice mail messages using the Voicemail Viewer:
1. Do one of the following:

From the My Interactions toolbar, click the Voicemail button.
From the View menu, select Voicemails.

2. Select a voice mail message.

3. Click the Play button in the integrated voice mail player.

Result: The voice mail message plays back through your telephone.
Tip: You can click the Stop button at any time to stop playback.

4. Optional: Click the Delete button in the integrated voice mail player to delete the currently selected voice
mail message.

5. Do one of the following:
Return to step 2 and select another voice mail message.
Click the Viewer Close button.
Related Topics

Open a Voicemail Message From Your Inbox
Use the Telephone Dial Pad to Control Playback
Voicemail Viewer

Working with Workgroups
Change Your Workgroup Activation Status

Requirements: You need the Activate self Access Control right for the selected workgroup to change your
workgroup activation status. You also need to be a member of that workgroup. Finally, the workgroup must be
configured as Active and also have an ACD queue.

In order to receive an ACD workgroup call, you must be logged onto the CIC client, have your workgroup activation
status set to Active, and set your status to an "Available" type.

To change your workgroup status:

From the View menu, select Workgroup Activation. Select the appropriate check box to activate your
workgroup status or clear the check box to deactivate it.
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Display the Workgroup and Profiles View

Workgroup Activation

I

Workgroups

karketing
support

In the Workgroup Statistics View, click Activate or Deactivate link to change your status for the currently
selected workgroup.

Display the Workgroup and Profiles View
Requirements: The Workgroup / Profiles Tab Security right enables you to display the Workgroup and Profiles view.

The Workgroup and Profiles view lists workgroups and Attendant Profiles by name. Some special conditions control
what you see in the Workgroup and Profiles view.

It does not list individual members of a workgroup, as in a Workgroup directory. It lists only Workgroups.

It lists only inbound call profiles that are configured in Interaction Attendant to allow calls to be
transferred to them. It does not list operator profiles or outbound call profiles.

To display the Workgroup and Profiles view:
1. Click the New Tab button.
Result: A drop-down list of types of directories appears.
2. Click the Group and Profile directory type.
Result: The drop-down list expands to show the names of each directory in this type.
3. Click Workgroups and Profiles.

Result: The Workgroup and Profiles view appears in the CIC client.

Tip: You can move this view to another part of the CIC client interface. For more information, see Customizing
the Interface.

Related Topics

Transfer a Call to a Workgroup
Transfer a Call to an Attendant Profile

Display and Configure the Workgroup Statistics View

Requirements: You need the Customize Client Security right to add views. In addition, the Workgroup Statistics
Security right enables you to display the Workgroup Statistics view. The Statistics Workgroups Access Control right
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determines which workgroups can be included in the Workgroup Statistics view. Membership in a workgroup does
not confer the right to view statistics for that workgroup.

To display and configure the Workgroup Statistics view:
1. Select Workgroup Statistics from the View menu.
Result: The Workgroup Statistics dialog box appears.
2. Do one of the following:
To select the workgroups in this view, click Choose Workgroups or click New set of workgroups.
To display statistics for all workgroups, click All available workgroups.
3. To select workgroups, in the Choose Workgroups dialog box, do one of the following:

To add a workgroup to the view, select a workgroup name and click > to move it to the Selected
Workgroups list.

To remove a workgroup from the view, select a workgroup name and click < to move it to the
Available Workgroups list.

4.  When finished selecting workgroups, click OK.

Result: The Workgroup Statistics view of the selected workgroups appears in the CIC client.
Related Topics

Workgroup Statistics View

Transfer a Call to a Workgroup

Requirements: You need the Search Workgroup Queues Access Control right to a specific workgroup queue in
order to transfer an interaction to that workgroup queue.

You can transfer a call directly to a workgroup listed in the Workgroup and Profile directory. This type of call transfer
is similar to a blind transfer because you do not speak to the transfer recipient. My Interactionsqueue

The CIC administrator creates workgroups in Interaction Administrator. Workgroups are logical groups of users (e.g.,
departments) that can function as a group in the CIC system. Workgroups can have extensions and queues that
enable all members of a workgroup to receive calls notifying the workgroup. In addition, workgroups can receive
regular calls and ACD calls that are routed to specific workgroups and agents. Workgroups can also serve as
distribution lists (to the members) of voice mail, email messages, and faxes from within CIC.

To transfer a call to a workgroup:
1. Inform the caller that he or she is going to be transferred.
2. On the Queue Control toolbar, click the Transfer button.
Result: The Transfer dialog box appears.
3. Inthe Transfer To: text box, type all or part of the Workgroup’s name or number.

Result: A drop-down list of choices appears.

200



View Members of a Workgroup

Tip: If the drop-down list does not contain the workgroup you expected, check the search criteria selected in
the Options drop-down list and make sure Workgroups is selected.

4. From the Transfer To drop-down list, do one of the following:
Select the appropriate workgroup name and associated extension number.
Select "Dial [your entry] as Digits" to convert a text entry into numbers.

5. Click the Transfer button.

Result: The transferred call disappears from My Interactions or other queue and is routed to the selected CIC
Workgroup.

Using the Workgroups and Profiles Directory to Transfer a Call

To transfer a call to a Workgroup in the Workgroups and Profiles directory:
1. Tell the caller that he or she is going to be transferred.
2. Select a workgroup name in the Workgroups and Profiles directory view and then click the Transfer button.

Result: The call disappears from My Interactions and is transferred to the appropriate Workgroup queue.
Tip: For information about displaying the Workgroups and Profiles view, see Add or Close Views.

Related Topics

My Interactions
Transferring Calls

View Members of a Workgroup

You can view the members of a workgroup and their statuses.

To view the members of a workgroup:
Click a Workgroup directory tab.

Result: The members of the workgroup directory and their statuses are displayed.
To call a workgroup member:
Double-click the member’s name.
Click any phone number in the row for the member.
Related Topics

Add or Close Views
Working with Other Directories
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Workgroup Statistics View

Requirements: The Workgroup Statistics Security right enables you to display the Workgroup Statistics view. The
Statistics Workgroups Access Control right determines which workgroups can be included in the Workgroup
Statistics view. Membership in a workgroup does not confer the right to view statistics for that workgroup.

You can view basic statistics for selected workgroup queues. Shift/Period statistics can help you monitor your
performance and compare it to that of a selected workgroup.

Workgroup Statistics

1;
Workgroup Statistics x

Workgroup & Activation | Interactions Logged on On inbound Longest Longest talk | Agents On inbound On outbound
Status waiting agents in this | ACD interaction time available ACW ACW
workgroup interactions waiting
Administration o 0 1 0 MN/A MN/A 2 0 1]
CompanyOperator 0 1 0 A& A& 0 V] 0
iows-workgroup 0 1 0 MiA MiA 0 V] [i]
Marketing 0 1 0 MA MA 0 0 0
Support b 0 1 0 M/A M/A 0 ] a
@ o ! ® |
@—) ~ Shift/Period Statistics
Current Shift You Workgroup Current Period You Workgroup
Average talk time /A M/A Average talk time RPN M4
Longest talk time N/A N/A Longest talk time M/A Ny/A
6 Interactions received o o Interactions received 0 0
Interactions answered o o Interactions answered 0 0
Interactions completed L] L] Interactions completed V] V]

You are ¢ Activated in Administration. Deactivate (_®

Choose Workgroups

1 | Close Click this control to close the Workgroup Statistics view.
2 | Workgroup The name of the workgroup as defined in Interaction Administrator.
Name

3 | Workgroup
Activation Status

A green check mark indicates that your status is "Activated.” A red X indicates your

status is "Deactivated.” For more information, see Change Your Workgroup
Activation Status.

4 | Workgroup
Statistics

These statistics appear for each workgroup:

Interactions waiting: Number of interactions waiting on this workgroup

queue.

Logged on agents in this workgroup: Total number of agents in this

workgroup who are logged in, regardless of their status.
On inbound ACD interactions: Total number of agents working on inbound

ACD interactions in this workgroup queue.

Longest interaction waiting: The longest connection time of any of the
currently connected interactions. "N/A" indicates no interactions are currently

connected.
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Managed IP Phone

Longest talk time: The longest amount of time any currently connected call
has been connected.

Agents available: The number of agents in this workgroup who are logged in,
have an "Available" status, and are activated.

On inbound ACW: Total number of agents performing after call Wrap-Up
work to conclude an inbound ACD interaction on this workgroup queue.

On outbound ACW: Total number of agents performing after call Wrap-Up
work to conclude an outbound ACD interaction on this workgroup queue.

5 | Shift/Period Click this control to display or hide a statistical summary of the current shift and
Statistics control period for the currently selected workgroup.

6 | Shift/Period For more information, see Shift\Period Statistics.
Statistics

7 | Activate or Click this link to activate or deactivate your status for the currently selected
Deactivate workgroup. For more information, see Change Your Workgroup Activation Status.

8 | Choose Click the Choose Workgroups button to add or remove workgroups from this view.
Workgroups

Shift\Period Statistics

Shift/Period Statistics contain a statistical summary. Separate columns display statistics for the currently selected
workgroup and your personal statistics as a member of that workgroup.

Your CIC administrator defines start and end times for each shift and also defines the number of minutes in each
period (starting at midnight) for each workgroup. For more information about shift and period definitions, see the
Interaction Administrator Help.

Average Talk Time: Average connection time for all currently connected calls.

Longest Talk Time: The longest amount of time any currently connected call has been connected.
Interactions Received: Number of interactions that have alerted in the workgroup queue or My Interactions.
Interactions Answered: Number of interactions that have been picked up.

Interactions Completed: Number of interactions that have been picked up and disconnected, sent to voice
mail, parked on orbit, or transferred.

Related Topics

Display and Configure the Workgroup Statistics View

Interaction Client Systems and Subsystems

Managed IP Phone

An IP phone uses Voice over IP technologies that enable you to make telephone calls over an IP network such as the
Internet instead of the ordinary public switched telephone network (PSTN) system.

A Managed IP Phone is set up, configured, and managed in Interaction Administrator. Your CIC administrator can
manage the CIC features available on your IP phone, update firmware and reset your phone from Interaction
Administrator.
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Your CIC administrator can:
Enable you to use the Do Not Disturb button or soft key on your phone to set your CIC status to DND.
Configure distinctive ring tones for incoming Internal, External, and Direct Dialed calls.

Related Topics

Set DND Status with Your Phone

About Session Manager

A subsystem component called Session Manager acts as a “traffic cop” or “broker” between the web Server and the IC
server.

Session Manager can run on the IC server in smaller implementations or on a stand-alone server in larger
environments. Multiple Session Manager servers can even be clustered to run large systems.

Switchover

Customer Interaction Center (CIC) supports an automated switchover system. If an IC server ever fails, in less than 30
seconds the server can switch control to another mirror image IC server with minimal phone disruption. In addition,
administrators can manually switch the “active” IC server with no phone disruption. It takes from 90 to 150 seconds
for the CIC client to reconnect.

If a switchover occurs, you see a dialog box that informs you a switchover and reconnect is in progress. However you
do not need to log on again after a switchover occurs.

Related Topics

Auto Reconnect

General Information
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